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Installation Quick Guide

This document should guide you through the first steps to get VivoQuant running
on your system:
Downloading

Please point your favorite web browser to the VivoQuant Home Page for access to
the latest stable release.

VIVOQUﬂnt Home | Invicro | Manual | VivoScriptManual | Changelog | Register

by Invicro, A Konica Minolta Gompany

Home

\& vivoQuant™: Pre-clinical Image Post-processing
= Manual » HTML

= Manual » PDF
= VivoScript Manual » HTML VivoQuant™ is Invicro's multi-modality post-processing suite for SPECT, CT, PET, MR, Optical and and Autoradiography imaging
= Changelog data. DICOM, NifTl, and raw data can be imported as well as many proprietary formats from pre-clinical imaging equipment.
= Register ViveQuant combines fundamental viewing functionality with powerful tools for fine-tuning images, isolating and analyzing regions of
» Invicro interest, and more. Multiple display modes including orthogonal views, slice views, special co-registration multi-views as well as 3D
T MIP and volume renderings allow users to optimally view information of interest. Built-in tools allow the imaging scientist to extract
I Downloads I the information she or he needs with minimal effort

Please contact us at support@invicro.com for more details on how to trial VivoQuant.
Stable Releases

2020-08-06 » VivoQuant 2020 Release
= VivoQuant 4.0

4.0pateh3 Invicro is pleased to announce the official release of VivoQuant™ 2020 which includes many new functional enhancements to support

[Linux] [MacOS] [Win64] . .

40—( M— — multi-modality, multi-species image processing applications. As a vendor neutral software, VivoQuant 2020 streamlines image analysis
Opatcl

research studies across all phases of drug discovery and development.
[Linux] [MacOS] [Win64]

VivoQuant Home Page

Development releases are also available in the Downloads section:
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Downloads l Please contact us at support@invicro.com for more details on how to trial VivoQuant.

Stable Releases 2020-08-06 » VivoQuant 2020 Release

* VivoQuant 4.0 Invicro is pleased to announce the official release of VivoQuant™ 2020 which includes many new functional enhancements to support multi-modality, multi-

4'9”“:“3 species image processing applications. As a vendor neutral software, VivoQuant 2020 streamlines image analysis research studies across all phases of drug
[Linux] [MacOS] [Win64] .

discovery and development.
4.0patch1

Linux] [MacOS] [Win64|
= VivoQuant 3.5
3.5patch2

New Features & Benefits:

] The new features are:
Test Versions = DICOM Cache - Clear cache on exit
= Audit Trail - Add SessionID to each iPACS message

= VivoQuant 2020

2020patch1-build3 See the Release Notes for more details!

[Linux] [Win64]

2020patch1-build2 To upgrade your VivoQuant version, please download from vivoquant.com or go to Tools |Update Check within VivoQuant to download the best version for
[Linux] [MacQS] [Win64] The Invicro team brings you this third patch to the VivoQuant 4.0 release, VivoQuant 4.0patch3! This release includes two new features and addresses

2020patchi-build1 several known bugs

[Wing4]

2020-build®

[Linux] [MacOS] [Win64] The new features are:

2020-build8 = DICOM Cache - Clear cache on exit.

[Linux] [MacOS] [Win64. = Audit Trail - Add SessionID to each iPACS message

2020-build7

[MacOS] [Win64] See the Release Notes for more details!

2020-buildé

IMacOST [Win641 To upgrade your VivoQuant version, please download from vivoquant.com or go to Tools |Update Check within VivoQuant to download the best version for

Test Versions

Apart from the stable release, VivoQuant web page may also offer preview and test
versions. There are three classes of versions:

stablere-  These versions are the officially released and fully tested versions
lease of VivoQuant. They have undergone intensive testing by our soft-
ware developers, service engineers as well as selected expert
users.
Unless you require a special feature only available in a newer ver-
sion, or want to participate in the software testing process, we
recommend to only use these stable releases in productive envi-

ronments.
patchre- Subsequent changes to stable versions are released as patched
lease versions. Such releases only contain few and significant bug fixes

established after the release of the original stable version and no
other updates. Further stable releases will, unless noted other-
wise, also contain such patches.

release At the end of the development cycle, multiple release candidates
candidates (rc) are released, which allow users to sneak a peek on upcoming
versions. These versions have undergone testing by Invicro and
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are sent to our partnering expert users for evaluation.

Depending on the feedback of actual users, release candidates are
modified to fix last bugs and finally reissued as a stable release.
Consequently, rc versions are often already stable with only minor
problems to be fixed, thus allow you to use new features early.
However, rc versions are not officially supported.

Release candidates have a limited life time of 90 days.

beta ver- These test versions are mainly intended for software testers. They
sions have not undergone the testing cycle required for a release candi-
date.

You can use these versions are your own risk.
Beta versions have a limited life time of 30 days.

alphaver-  These versions are mainly used for testing within inviCRO and as-
sions sociated partners.
Alpha versions have a limited life time of 15 days.

A Important: For a production system, use a stable release.

Installing

A. Windows

Double-click the VivoQuant install icon to start the installer.

v

vivequant-winbd
-2021.exe

Windows Install

Follow the sequence of set-up steps carried out by the Installer. Please accept the
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default settings, or change the options according to your needs. A detailed
description of the install options can be found in Installation Details (page 12).
B.Mac OS X

1. Double-click and unzip the VivoQuant zip archive.

2. Locate the VivoQuant installer in the Applications folder.

W vivoguant-macos-2021-build18

LW
LA

Applications VivoQuant.app

Mac OS Install

Troubleshooting Mac OS Install

On some occasions, Mac OS will not recognize VivoQuant as a verified application:

"VivoQuant.app"” cannot be opened
because the developer cannot be verified.

macO5 cannot verify that this app is free
from malware.

vivequant.com

Move to Trash

Mac OS Warning

To make the Open option appear, simply the right-click on the warning message
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and select Open.

Open
Show Package Contents

Move to Trash

Get Info

Rename macOS cannot verify the developer of

Compress “VivoQuant.app” "VivoQuant.app". Are you sure you want to open it?
Duplicate By opening this app, you will be overriding system security

Make Alias which can expose your computer and personal information to
malware that may harm your Mac or compromise your privacy.

Quick Look “VivoQuant.app”
Share
Quick Actions vivoquant.com

Copy "VivoQuant.app” Move to Trash Cancel

Import from iPhone or iPad

Use Groups

Sort By

Show View Options
Show Preview Options

20000 OGS
Tags...

New Terminal Tab at Folder
New Terminal at Folder

Open VivoQuant

C. Linux
Double-click and unzip the VivoQuant zip archive, then move the VivoQuant folder

to the desired location. To run VQ, double-click the VivoQuant script contained in
this folder.

Licensing

I. Active Accounts
VivoQuant supports two licensing methods: a machine locked file-based license

and a floating license. Users should consult their latest purchase agreement for the
license to determine which type was purchased.
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Floating licenses

The floating license uses an alpha-numeric license key and an internet connection
to provide licensed access to VivoQuant. To add a floating license key:

Start VivoQuant

Go to Configuration > Licensing > Floating license tab
Enter the license key in the field provided.

Click Ok to close the Configuration dialog.

LA A

Restart VivoQuant, and the license will be activated in the next session.

Heartbeat pings

To prevent issues with license activations becoming stuck on a user’s machine,
VivoQuant requires a constant internet connection to send pings to the license
server in order to confirm that the activated VivoQuant instance is still in a working
state. If the process can no longer communicates with the license server,
VivoQuant will notify the user to resolve the connection issue before eventually
closing.

File-based Licenses

VivoQuant License Manager manages file-based licenses allocated to an account.
An on-site license manager login credential will be provided to each account to
access the VivoQuant License Manager. For detailed information on how to
manage your account’s VivoQuant licenses click Here. (page 0)

Installing a file-based license

If the end-user’s computer has internet access, VivoQuant will automatically
detect and install a pre-approved license file. If the end-user’s computer does not
have internet access, they will need to download the license provided in the link
and install manually. To install a license file manually, go to Help > Licensing within
VivoQuant and click on Install key. VivoQuant is now registered and fully
operational.

VivoQuant™ 2022 User Manual Page 9
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[l. Trial Accounts

Methods for Obtaining a Trial License

If you are a current end-user and have an active software account, contact your
account representative for a trial license of a plugin module. Your account
representative will pre-approve the trial license and you should follow section Il.b.
below. If you do not have an active account, please follow the below steps.

a. Requesting a Trial License

1. Download the latest stable version of VivoQuant. Once you have
successfully installed VivoQuant, you will be prompted to register your
computer. Click Yes.

\&t UNREGISTERED MODE X

0 ViveQuant has not found a valid license and thus
* started in a limited UNREGISTERED MODE.
We recommend you file a license requests with
your institution (you will need the INSTITUTION
CODE or use DEMO for a time-limited evaluation
license with all functions.
Would you like to proceed to the registration
process now?

1. Make sure the company code is DEMO. Enter a value to identify your
department (or company) in the Department field. The license file will be
sent to the email address specified in Contact address.

2. After clicking Register, your internet browser will load and navigate to the
license registration confirmation page.
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VivoQuant License Request

Customer: Demo Licenses - Imaging

Your Name* Email*

Department® Imaging HW Key* 18:75'a4:d0'e4'50,00:15:5d ca 45:96

(oo Joome |

b. Pre-approved Licenses

1. Anaccount manager can issue a license to an end-user. Upon issuing a
license, an email notification will be sent with instructions for downloading
the VivoQuant software and installing the license key. After the software
has been successfully installed, you will be prompted to register your
computer for a license. Click Yes.

2. Enter the company code provided in the email along with the email address
to which the registration email was sent.

3. After clicking Register, your Internet Browser will load and navigate to the
license registration confirmation page. You will need to enter the password
provided in your email to finalize the process.

4. After you click Submit, the system will validate the request. If successful,
the below page will appear.

License approved

Your license request has been pre-approved and your HWHey has been added

License : de7@d796 - cupelo, Imaging

Features: VivoQuant, segAtlasNMCT, segAtlasfMRI, segWholeBody
Expiry : 2828-12-31
HeKey D BdiddcdacSeide:l7,408:25:c2:59:5d4: 78
Please restart WVivoQuant for it to fetch and install the new license, or download the license here

If you experience any problems, please contact support@invicro.com.
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Installation Details

After accepting the VivoQuant license, you have the option to choose the install
location and components, which allows you to tailor the installation to your specific
needs.

Choose Install Location

For the destination folder, it is recommended to keep the default settings.
However, if you would like to install multiple versions of VivoQuant on your
system, you can choose a different install location here.

& VivoQuant Setup - X

Choose Install Location
Choose the folder in which to install VivoQuant.

Setup will install VivoQuant in the following folder. To install in a different folder, dick Browse
and select another folder. Click Next to continue,

Space required: 253.7MB
Space available: 342.4GB

< Back Mext > Cancel

Install Location
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Choose Components

& VivoQuant Setup — X

Choose Components
Choose which features of VivoQuant you want to install.

Check the components you want to install and uncheck the components you don't want to
install, Click Install to start the installation.

Select components to install: & T
) [ Extras ' :
@-[¥] vivoQuant
&- & Options

+

+

Space required: 253.7MB

< Back Install Cancel

Choose Components

Qt5.7 li- Unless you already have Qt installed on your system, it is highly
braries recommended that you use the version coming with VQ.

ImageMagick Itinstalls the IM programs mpeg2encode (required for genera-
binaries tion of MPEG movies) and convert (general tool to convert
image formats, not required by VQ).

Manual After installation, the manual is available by pressing <F1>on

VivoQuant™ 2022 User Manual Page 13
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the main VQ screen, or using the Help|Manual menu. Alterna-
tively, you can also find the manual online at www.vivo-

quant.com/files/manual/2022 .

Options
P Shortcut on Installs a VQ icon on Windows desktop.

desktop

DicomBrowser || Allows starting of VQ with opened Dicom-

shortcut on Browser quickly. Open DICOM data (page

desktop 46)
Add local DI- Adds an example DICOM folder to the list

COM folder of repositories.

Add DEMO Allows access to an online PACS system to
iPACS download example data and share your
data with other users.

Add Service Adds a write-only online PACS system
iPACS (reading requires password) to allow you
to send data to our service engineers.

Enable update || When enabled, VQ regularly checks for
check the availability of new versions and offers
you to download and install them.

See Update Check (page 339) for details.

Debugging These options allows for debugging issues in VQ.
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VivoQuant Configuration

The VivoQuant Configuration window has several panels that provide access to
customizable features as well as important licensing and set-up information.

Getting There

Windows and Linux

The Configuration window is accessible from the Tools menu under Configuration
or by using the keyboard shortcut Ct rl+Shift+C.

MacOS

On Mac, the Configuration window is accessible from the VivoQuant menu under
Preferences or by using the keyboard shortcut % + ,.

For more on keyboard shortcuts in VivoQuant, see Keyboard Shortcuts (page 315).

Configuration Panels

The Configuration window consists of six panels:

e Display (page 16

e Data (page 20)
DICOM Settings (page 28

Network (page 43)

e licensing (page 45

VivoScript (page 262)
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Display

Several appearance features may be customized in the Display panel, including
General display information, Maximum Intensity Projection attributes, and Color
Palette defaults.

\& Configuration ? X

Display =~ Data  DICOM  Network  VivoScript ‘il

General

Font | Arial v| 8 b
Crosshair  transp. ooen cc = |color coded ~
Pal path pal

Orientation ‘W% Neuroloaisi = |

. . Corner Info
Quality Fnhanced -

Volume Renderer

Frame time 40ms ! display

Frame delay [80.ms__ %! movies

Sync mode: | | enabled Requested Vol Renderer: (CPLI >

Color Palettes

Type :MIn [ Max =

Modality First Second Third

cr - aray ~| [nih_fire2  ~| [hotgreen  ~

Render Preset Palette - |Palette - |Palette r

OK [ Cancel

Display Panel

General

Font Style Controls the font style of the displayed text in the Main Window.
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Font Size Controls the size of the text displayed in the Main Window

Crosshair Sets the visual style of the crosshair to be used in the Main Win-
style dow.

Crosshair Sets the colors of the crosshair to be used in the Main Window.
color Crosshair color options include red, yellow, magenta, white,
green, and blue.

Pal Path Pal files hold the color map information for the different Color
Palettes available in VivoQuant.

Preview Displays a preview of the font and cross-hair selections.
Panel

Corner Info  Controls the information to be displayed on each corner of the
slice view. Default options are: None, Basic and Advanced. Addi-
tionally, you can customize the metadata to be displayed in each
corner by adding or removing the snippet for the corresponding
parameter. A list of parameter snippets is provided in the Corner
Info window.

Orientation Provides an option to view the data whether in Radiologist View
(face to face) or Neurologist View (mirror). Diagrams are used to
show the difference.

Quality Provides an option to view the data whether in Native or En-
hanced quality. With Native quality, voxels are always displayed
as they are defined in the image, with no smoothing applied. With
Enhanced quality, smoothing is applied to the image when a voxel
is displayed using multiple pixels on the screen. There is no effect
on quantification.
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Volume Renderer

Frame Sets the amount of time for which each MIP projection image is
Time - displayed in a saved movie.
Display

Frame De- Sets the delay time between MIP frames in a saved movie.

lay -

Movie

Sync If enabled, only completed MIP frames will be displayed. If dis-
mode abled, the MIP will freely rotate at all times but will display a mes-

sage in place of the MIP for uncompleted frames.

Requested Setsthe MIP image volume rendering unit. Options are: Smart,
Vol Ren- CPU and GPU.
dered

Color Palettes

Type Sets the method for determining the color palette range.

Palette The default Color Palettes for the first three loaded volumes of each
Modality are set. Inputs beyond the third loaded volume of a particu-
lar modality follow the palette of the third one.

VivoQuant™ 2022 User Manual Page 18
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Color Theme

Color Changes the general appearance of VivoQuant’s menus, buttons and
Mode  windows:
- Default (use the native appearance of the Operating System)
- Dark
- Light
*Note: On MacOS only, the Default option is replaced by the System option
which will follow the Dark/Light system’s configuration from System Pref-
erences -> General -> Appearance. It is not yet supported on other Operat-
ing Systems.
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Data

The Data panel contains options for data handling, including data loading,
guantification, management and processing.

\& Configuration ? X

Display  Data DICOM Network  VivoScript Y iP |

Data Loading

[ ] Disable MIP viewer  Grow reference to input vc no -
Ask Disable MIP Max voxsize ratio for vol  [2.50 ¥
MinVoxSize 0.00mm #* Anchor input data at center ~

Quantification Options
Unit of Activity MBqg ~ SV Separator Comma (,) -

Data Manager
Confirm moving [ ] show seconds in Browser
Apply default shift [ ] collapse Dynamic Data

Contio Datal ist Into
Processing

[ ]ITKMax Threads & = [ | VTKMax Threads & =

(] ITK Priority i F

OK Cancel

Data Panel

Data Loading

Use the Data Loading panel to set loading options.

Disable Check the box to disable the MIP viewer upon loading. For large
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MIP viewer datasets, this canimprove the loading speed.

Ask Disable If enabled, VivoQuant will ask for your permission to initialize the
MIP MIP viewer upon loading. For large datasets, this can improve the
loading speed.

Grow ref- Choose ‘yes’ to allow the addition of zero-padding to a reference
erence to image for it to match the volume of an input image, or ‘no’ to keep
input vol- the reference image size static (and potentially crop the input im-
ume ageifitis larger than the reference). Choose ‘ask’ to allow a win-

dow to appear upon loading, in an input, a data set that is larger
than the image in the reference position.

Max vox- Specify the maximum pixel ratio (largest pixel dimension / small-
size ratio est pixel dimension) by which a data set is interpolated as a vol-
for vol. ume image file.

MinVoxSize Specify the minimum allowed voxel width. Data will be resampled
upon loading if their voxel width is less than the specified mini-
mum. The voxel width will be doubled until it exceeds the mini-
mum.

Anchorin-  Specify where to anchor the input data. Data can be anchored at
put data the following options: center, head, or foot.
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—

X

r

Longest Dimension(LD)

Longest Dimension

In the above image, LD represents the out-of-plane resolution and the X and Y
represent the in-plane resolution. If the pixel ratio of the loaded image exceeds the
given threshold, i.e. MaxVoxSizeRatio < LD/X, the data set will be loaded as a planar
2D by n file. Below is an example MR image loaded as a planar 2D by n file.
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Planar

If the pixel ratio of the loaded image is less than the given threshold, i.e.
MaxVoxSizeRatio > LD/X, the data set will be loaded as an interpolated volume
image with isotropic voxels. Below is an example MR image loaded as an
interpolated volume file.
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Interpolated Volume Image

O Note: Other modalities besides MR can be loaded into VQ as planar or
interpolated volume files based on the Max voxsize ratio for volume setting
specified in the configuration window.

As described on the Open DICOM Data (page 46) help page:

e |fthe ‘Force Planar’ check box is checked in the Data Browser, then the
image will load in planar mode regardless of the value set for
MaxVoxSizeRatio.

e [fthe ‘Force Planar’ check box is unchecked in the Data Browser, then the
image will load in the appropriate mode according to the value set for
MaxVoxSizeRatio.
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Quantification Options

Use the ‘Quantification Options’ panel to set options used by the Projection++
Operator (page 152) and the 3D ROI Operator (page 78).

Units of Select the unit to be used for quantifying both PET and SPECT data.

Activity Options include MBq, kBg, mCi, and uCi. Note: Concentration units
(e.g. nCi/cc) will not be converted to the unit of activity specified.
The Multi-Atlas Segmentation and 3D Brain Atlas Tool plugin mod-
ules do support converting from concentration units to units of pCi.

CSV Sep- Choose the CSV file delimiter of their choice, applied when saving
arator Quantification data.

Quant. Available here on MacOS only. See the Projection++ Operator

Table (page 156) and 3D ROI Operator (page 119) sections for other Op-

Items erating Systems.

Grow Choose if the ROl object should be resampled when the dimensions
ROls to and or voxel sizes of the reference image are changed.
reference - Ask (a prompt will be displayed to ask for the desired behav-
ior)
- Yes (ROls will be resampled to match the reference’s dimen-
sion)

- No (ROlIs will be embedded into an object matching the refer-
ence’s dimension)

Data Manager

The “Data Manager” panel contains options for handling data, including a checkbox
to enable or disable a confirmation message when moving data.
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confirm  Check to enable a confirmation message when rearranging datain
moving  the Data Manager.

Show Check to display the seconds in the study date column in the DI-
seconds COM browser. VQ has to be restarted to configure this change.
in

Browser

Apply Check to apply a default reorientation to data being loaded into VQ.
default  The default shift can be defined in the Reorientation/Registration
shift operator. For more on this, please see the Reorientation/Registra-

tion (page 164) page.

Collapse If enabled, dynamic frames from the same series will be loaded into

Dynamic the data manager as a single input. If disabled, each dynamic frame

Data will be loaded into the data manager as a separate input. Regardless
of the setting, the data manager allows you to manually expand col-
lapsed dynamic data, or collapse a set of dynamic frames into a sin-
gleinput.

Processing

Use the Processing Panel to set resource limits on data processing.

ITK If enabled, you can customize the number of threads used by ITK at
Max runtime. If disabled, ITK thread number will be set to its default val-
Threads ue.

VTK If enabled, you can customize the number of threads used by VTK at
Max runtime. If disabled, VTK thread number will be set to its default val-
Threads ue.
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ITKPri- If enabled, you can customize ITK thread priority. If disabled, ITK
ority thread priority will be set to its default value.

@ Tip: Setting limits on image processing is particularly useful to prevent
performance issues in multi-user setups.
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DICOM Settings

The DICOM configuration allows the user to add/edit DICOM repositories. These
repositories can be local folders containing DICOM files, or DICOM network
servers located whether on a local or a remote computer. The DICOM Dump (page
304) uses the DICOM Dictionary to identify information in the DICOM header.
Check the How-To (page 39) guide for more information on configuring the
NanoSPECT’s DICOM Servers in VivoQuant.

Getting There

The DICOM Repository can be accessed in three different ways.

First, the repository index is accessible via the Repository panel in the Data

Browser (page 46). To open the Data Browser, click the icon.

Repository
W TempFolder v

Please refresh to populate the
Study Browser.

G AN
w & O

Repository Panel

The second method is by selecting the Configuration (page 15) option in the Tools
menu, and then click on the DICOM panel.
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\l Configuration ?

Display Data DICOM Network

DICOM Settings
D8 path:

VivoScript

D:\DicomD8\Dicom\ImageFiles
Repositories: Documentation

e S
Dictionary
Rov Port 23104 <[] load palette %

Folder Filter 3* 4* 5* 6* 8* 9* Override FOR? No

DICOM Cache Captures

) Quick Scripts -

DICOMDIR

L1O0®

X

H

] Enable Viewer

Default Repository

Current size | 69.9MB | | 6%

Maxsize (1000 MB 3| ee 97911.1 MB

Default Format

Life Time  |14d S Clear

The third method is by opening the Configuration panel using the “Ctrl+Shift+C”
shortcut. For more information on keyboard shortcuts in VQ, please see Keyboard

Shortcuts (page 315).

Configuration Dialog

The DICOM panel in the Configuration dialog box provides the most in-depth
DICOM information available in VivoQuant. The DICOM panel consists of three

sections: DICOM Settings (page 29), DICOM Cache (page 31), and Captures (page

32).

DICOM Settings

DICOM Settings

DB path: D:\DicomDB\Dicom\ImageFiles
Repositories: TempFolder -
7 + x N
Dictionary
Rev Port 23104 % [v] load palette % [ | DICOMDIR

Folder Filter 3* 4™ 5* 6* 8* 9*
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DICOM Settings

DB path Location of local DICOM database. Allows optimized internal ac-
cess to the Mediso DICOM database. See Optimized local access

(page 36), for details.

Repositories List of available repositories. The bank of buttons immediately
beneath the pulldown menu operate on the selected repository
in this field:

Checks connection to DICOM repository. Local folders are veri-
fied to exist and a C-ECHO is sent to DICOM servers.

Adds a new repository

@ Deletes selected repository
Opens the DICOM Editor DICOM Editor (page 33)
P

Dictionary Shows list of additional dictionaries used by the DICOM library.
Please set environment variable DCMDICTPATH to set this val-
ue. For more information on the DICOM dictionary, see DICOM
Dump (page 304

Rcv Port Port over which the DICOM peer sends data.

load palette  If enabled, the palette window will be loaded in accordance with
% the image data. If disabled, the palette window will be set to
whatever the window was set to last.

DICOMDIR  Checking this box enables support for DICOMDIR files.

Folder Filter  Allows users to specify the type of DICOM files loaded into
VivoQuant. Users can configure loading extensionless dicom da-
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ta by adding a space and * to the end of the default settings:

Folder Filter [* * dem *.de3 * dicom IM_*5 %

Override A Frame of Reference (FOR) is a coordinate system that ensures
FOR the spatial relationship of images within a series. It also allows
for images across multiple series to share the same FOR. Vivo-
Quant allows users to choose among different behaviors regard-
ing this setting.
Yes: the system will always overwrite the FOR settings and ap-
ply co-registration when loading a DICOM series of images.
No: the system will never overwrite the FOR settings of the DI-
COM image series and will always apply co-registration.
Ignore: the system will neither overwrite the FOR settings nor
apply co-registration.
Ask: the system will provide the user with the option of choosing
one of the previous options when loading a DICOM image series.

DICOM Cache

The DICOM cache allows for the storage of frequently used data sets locally, thus
improving load time into VivoQuant. Every time VivoQuant is started, it checks the
current size of the cache against the maximum cache size. If the current cache size
exceeds the maximum cache size, then older files (those opened least recently) are
removed.

DICOM Cache

Current size | 0.0MB | 0%

Maxsize  [1000 MB '=| [free 44135.3 MB|

Life Time [14d %] Clear

DICOM Cache
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Current Size in Mb of the data currently stored in the DICOM Cache. The per-

Size centage to the right of the field indicates how close the cache is to ca-
pacity.

Max Maximum amount of memory that can be made available for the DI-

size COM Cache (default = 1000.0 MB).

Life Length of time over which data will be stored in the DICOM Cache

Time (default = 14 days).

Clear Empties the DICOM Cache.

Captures

Captures
Enable Viewer

Default Repository

o

Default Format

Captures

Data Browser Repository Panel

The DICOM Repository panel, in the Data Browser, is the most convenient location
for adding and editing repositories, including DICOM Servers, local folders, and
PACS Servers.
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Repository
&) invicro =
[anghelad1 =
Project Filter |
v? * A\ Projects: 1741/
w & O

Repository Panel

Repositories List of available repositories. The bank of buttons immediately
beneath the pulldown menu operate on the selected repository
in this field. Please click here (page 48) to learn more about the
DICOM repository section of the DICOM browser:

Checks connection to DICOM repository. Local folders are veri-
fied to exist and a C-ECHO is sent to DICOM servers.

Adds a new repository.

[+ [

Edit: Opens the DICOM Editor (page 33).

[

Opens a Windows Browser that can be used to select a local
folder as a repository.

]

Fetches all DICOM meta data.

Removes repository from list.

G

DICOM Editor

The DICOM Editor is used to add repositories, including local folders, DICOM
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Servers, or iPACS Servers.

DICOM Server

Username: |test
Password:
Hostname: invicro.ipacs.invicro.com/ Port: 80

Use 'localhost’ (lower case) for optimized local access.

Test _ OK | Cancel
Local Folder
DICOM Server
Calling AET: |Test ]
Called AET: | |
Hostname: |In1.rit:rt.'-.[nlarr:s.tnm-I'Il:rc}.u:t::m;r | Port: 104
Use 'localhost’ (lower case) for optimized local access.
Test | 0K | Cancel
DICOM Server
iPACS
Username: | Test ]
Password: | l
Hostname: (invicro.ipacs.invicro.com/ | Port:
Use 'localhost’ (lower case) for optimized local access.
Test OK Cancel

iPACS Server

Displayed = Name as shown in the repository selection box. Can contain any
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Name alphanumeric character.

Repository Indicates the type of repository containing the study data to be
Type loaded into VivoQuant.

Local folders are directories available on the local computer (also
via a shared network). Directories containing many files might
take longer to scan. In this case, a DICOM server will perform bet-
ter.

DICOM servers are network services on the local or a remote
computer. They provide a database to efficiently browse study da-
ta.

AniPACS server is an online PACS servers, a regularly used
archiving and retrieval system for medical images.

Local DI- Allows for browsing and selecting a local directory. All sub-folders
COMfold-  will be displayed as projects in the second repository drop-down
er window.

DICOM AET is an Application Entity Title.

server
Calling AET: must be a valid AET configured on the server.
Called AET: name of the DICOM servers application entity.
iPACS Username and Password are specific to the user of the site’s
server iPACS system.

Hostname is the site of the server for the iPACS, and Port is the
communication channel.
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DICOM server

A DICOM server is specified by a calling AET, a Called AET, as well as a TCP address
consisting of a host name and a port (the default settings are localhost:104). The
AETs must be configured on the DICOM server. For VivoQuant, use port 23104 on
the remote server.

iPACS server

An iPACS server is specified by setting the appropriate Hostname and Port and by
entering user-specific Username and Password. A DEMO iPACS server may be
registered by using Hostname: demo.ipacs.invicro.com, Port 80, and leaving
Username and Password blank. iPACS servers also enable the use of Projects (page
36), a useful tool for organizing DICOM data.

Optimized local access

The optimized local access allows for a much faster access to DICOM data. To use
this option enter ‘localhost’ (all lower case) as the hostname, and define the ‘DB
path’.

iPACS Projects

The iPACS repositories allow for the use of projects. A project represents a
directory structure for DICOM repositories. Data may be stored and accessed via
different projects, aiding organization of DICOM data. In the example below, an
iPACS repository for “bioscan/demo” is being configured. The “bioscan/demo”
repository contains three projects.
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& DICOM Repository

General Information

Displayed Name: Testing

Local DICOM folder
Folder:

Recursive

iPACS

Repository Type: () W Local folder () & DICOM server (® () iPACS

Username: | Test

Password: |

Hostname: |in1u1cm,ipacs,invicm,mmf

| Port: |80 |

Test

Use 'localhost’ (lower case) for optimized local access.

OK

Cancel

iPACS Repository

If any projects are present within a configured iPACS repository, a second pulldown

menu will appear in the Repository panel of the DICOM browser. All projects
within that repository are available via the second pulldown menu. The three
projects associated with the “bioscan/demo” repository are shown in the

screenshot below.

|iPACS Documentation -
[bioscan/demo/subproject1 A

{bioscan/demo

Ibioscan/dema/subproject
\Ibioscan/demo/subproject2
| fhioscan/demao/subproject3

Repository Projects

Select a project to view data associated with that project only.

VivoQuant™ 2022 User Manual

Page 37


http://127.0.0.1:4012/vqmanual/images/config_dicomsettings_iPACSRepository.jpg
http://127.0.0.1:4012/vqmanual/images/config_dicomsettings_iPACSRepository.jpg
http://127.0.0.1:4012/vqmanual/images/config_dicomsettings_RepositoryPanelDemo.jpg
http://127.0.0.1:4012/vqmanual/images/config_dicomsettings_RepositoryPanelDemo.jpg

DICOM Settings Last updated: March 08, 2023

' () Testing
|IPACS Documentation M Scrvice*QCal Quantific... 2014-05-07 14:28
[bioscanjdemo/subpraject 1

Patients Name StudyDate

Ibioscan/demo

Ibioscan/demo/subproject1
Ibioscan/demo/subproject2
[bioscandemo)subproject3

Select Project

By default, data will only be displayed when the project to which it belongs is
selected from the second pulldown menu. For example, in this screenshot, no data
appears in the “bioscan/demo” repository because all data within the larger
repository belongs to individual projects.

Repository - SECURE

) Testing -
[invicrofservice/bidmc/pm_20 -
[i‘m}ed Filter ]

¥? + %\ Projects: 1749/,
- & O

Larger Repository

To simultaneously view all data belonging to a repository AND its projects, place an
asterisk (*) at the end of the hostname during repository configuration. The
asterisk will cause all data within the repository and its projects to be displayed
recursively. This behavior applies across all repository and project levels.
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& DICOM Repository 7 X
General Information
Displayed Name: [iPACS Documentation

Repository Type: () W Local folder () & DICOM server (® (&) iPACS

Local DICOM folder

Folder:
Recursive

iPACS

Username: |test

Password: (eeesssse

Hostname: |invicro.ipacs.invicro.com/biscan/demo® | Port: (80 |

Use 'localhost’ (lower case) for optimized local access.

Test OK Cancel

Repository Data Display

How to configure the NanoSPECT’s DICOM Servers

First, open the Data Browser (page 46). Find the Repository (page 32) panel and
either select the pre-existing repository from the pulldown menu or select “new” to
create a new repository.

For the standard access on the NS Workstation (WS), use:
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& DICOM Repository 7 X
General Information
Displayed Name: |NSxxWS_DCMSRV

Repository Type: () W Local folder (® & DIcoM server () ) IPACS
Local DICOM folder
Folder:

Recursive

DICOM Server
Calling AET: [INVIVOSCOPE
Called AET: NSxWS_DCMSRV

Hostname: [localhost Port: (104 |

Use 'localhost’ (lower case) for optimized local access.

Test OK Cancel

Workstation DICOM Server

Option Description

Displayed Name NSxxWS_DCMSRYV (or customer’s preference)

Type DICOM Server
AET INVIVOSCOPE
Called AET NSxxWS_DCMSRV
Hostname localhost

Port 104

where xX is replaced with the NanoSPECT number, typically no leading 0 for
numbers \< 10.

The local access VivoQuant is able to access the DICOM Server directly, so there is
no need to add the VQ as a client on the DICOM Server.
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The above table described configuring VivoQuant to access the Workstation
DICOM Server. VivoQuant may also be configured to access the Acquisition
computer’s DICOM Server. The procedure is similar, but there is no WS in the
naming convention.

& DICOM Repository 7 X
General Information
Displayed Name: |AcQ_NSxx_DCMSRV

Repository Type: () W Local folder (® & DIcoM server () ) IPACS

Local DICOM folder
Folder:
Recursive

DICOM Server
Calling AET: |INVIVOSCOPE
Called AET: |NSxx_DCMSRY

Hostname:  |nanospecbod Port: [104 |

Use 'localhost’ (lower case) for optimized local access.

Test OK Cancel

Acquisition computer's DICOM Server

Options Description

Displayed Name ACQ_NSxx_DCMSRYV (or customer’s preference)

Type DICOM Server
Calling AET INVIVOSCOPE
Called AET NSxx_DCMSRV
Hostname nanospectxx
Port 104

where xX is replaced with the NanoSPECT number, typically no leading 0 for
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numbers \< 10.

In place of hostname (i.e., nanospectxx), it is also possible to use IP addresses (i.e.,
192.168.1.1 for local WS-ACQ computer connections). Please verify that the
hostname resolves by using ping hostnamein a Command window. Also, in
order to access the ACQ computer from the WS computer, you must configure the
DICOM Server on the ACQ computer.
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Network

The Network panel consists of two sections: Network Settings and Auto Import.

\& Configuration ? X

Display Data DICOM Network VivoScript 4 i P |
Metwork settings

Proxy | | Port 3128

[v*] Enable online check

Please restart IVS after changes on this page.

Auto import
Directory Repository

| E] Documentation ~

QK Cancel

Network Panel

Network Settings

The Network Settings section includes an option for enabling a proxy server to be
used with VivoQuant. There are fields for entering a proxy and a port number
associated with that proxy. The “Enable Online Check” checkbox will automatically
detect any available proxy servers. If you believe a proxy server is needed, please
contact your local IT representative.
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Auto Import

The Auto Import allows you to designate a folder through which files can be
automatically transferred into a Repository. According to the setup in the above
screenshot, DICOM files placed in the VQ-Autolmport directory will be
automatically imported into the NSOOWS_DCMSRYV repository upon the next
restart of VivoQuant.
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Licensing

Getting There

The Licensing panel is available in the Configuration Window (page 15).

Alternatively, it may be reached directly via the Help menu.

Contents

The Licensing panel contains information about the current active license type
(either machine-locked file-based or a floating license) as well as selected
information about the user who owns the license.

Licensing is required to unlock most of VivoQuant features. Please see the

Licensing Quick Guide (page 8) for more details.
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Opening DICOM Data

The Data Browser provides convenient access to files in a DICOM server or any
other specified iPACS Browser. From the Data Browser, reconstructions can be
started and files can be exported.

Getting There

There are three different methods to access the Data Browser.

The first method is by clicking the icon in the Main Window (page 209).

The second method is to go to File > Data Browser.

File View Tools Advanced Modules Help

Data Browser Ctrl+D :'ED g o
B Open Local Data y o
:.:j Connect to iPACS
e S l
B sa Jata
@ Session r
&) VivoScript Ctrl +Shift+V

Exit

Data Browser

The third method is to use the keyboard shortcut Ctr1+D. For more on keyboard
shortcuts in VivoQuant, see Keyboard Shortcuts (page 315).
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Function

The Data Browser’s main window is split into five sections: Repository (page 48),
Filter (page 49), Data (page 53), Study Browser (page 55), and Transfer.

& Data Browser ? Pt
Repository - SECURE Study Browser
‘_@T&sﬂn_g | | Patients Name StudyDate StudyDescription Patie
[invicro/service/biogen/pm201 ~ | Service*QC_03_Quantif... 2017-08-29 16:47 3.C <
|D|'0jed Filter | SPECT Nea... 2017-08-28 11:23 QC SPECT Near-...
=l e E QC SPECT Nea... 2017-08-28 16:06 QC SPECT Near-... QCS
V72 o+ | ects: 1751/:
..\ g / QC SPECT Nea... 2017-08-29 11:46  QC SPECT Near-... QC
- & O AQC SPECT Jasz... 2017-08-30 11:53  QC SPECT Jaszc...
Filter Service”Linearity Calibr... 2017-08-28 13:35 Linearity Calibrat...

2017-08-28 13:48
2017-08-28 14:.08

ServiceLinearity Calibr...

Linearity Calibrat...

patents Name ||
paenti: ||
e

Service”Linearity Calibr...

Service”Linearity Calibr...

Linearity Calibrat...
Linearity Calibrat...
2017-08-2

Service M Intrinsic Resolu... Intrinsic Resoluti...

Apply default shift
Auto-Start reconstructit
[] Force pl [_] stack 3D

» | EEORERE

Transfer

| @ Close | | @ Stop |

ollimated Be

WOW W WV W WV WV WYV WV VYV WY VYV OV OV YV OV VY VYV OV YV Y WV

Service4-Point Calibra...

.. 2017-08-2¢

2017-08

.. 2017-08-29

A4-Point Calibra...
4-Point Calibra...
M4 -Point Calibra...

2017-08-. :

2017-08-29 14:52
2017-08-29 15:59
2017-08-29 16:16

Study Date: !A]l =l .. 2017-08-29 12:12 Intrinsic Resoluti...
o S O . 2017-08-29 12:31 Intrinsic Res

A Alntrinsic Resolu... : Intrinsic Resoluti...

Mntegrated CT ... 2 17:16 Integrated CT C...

ice®Integrated CT ... 2 8-30 09:50 Integrated CT C...

Data Energy and Un... 2 8 Energy and Unif...

Show data type: eAEnergy and Un... 2017-08-29 Energy and Unif...

All data tvnes = CT Geometric ... 2017-08- CT Geometric Cal

@ @ @ a... 2017-08-29 Collimated Bea...

Collimated Bea...
Collimated Bea...
Collimated Bea...

4-Point Calibrati...
4-Point Calibrati...
A-Point Calibrati...

4-Point Calibrati... £

Data Browser Main Window
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Repository

The Repository section displays the Data Browser or local folder from which data
files are currently being displayed in the Study Browser. See DICOM Configuration

(page 28) for more information on configuring your Data Browser, including the
use of projects (page 36) in an iPACS repository.

This section contains a filter that allows users to reduce the project list to more
easily search for a desired project. There are three ways to filter the project list, as
described in the following table:

Description

word Reduces Type exampledata in the projects filter to reduce
projectlist  the projects list to all projects with the word exam-
to all pro- pledatain their path.
jects that
contain the
given word
in their
path.

'word Reduces Type !exampledata in the projects filter to reduce
project list  the projects list to all projects that do not contain ex -
to all pro- amp ledatain their path.
jects that
do not con-
tain the giv-
enword in
their path.

&regexp Reduces An example of acommonly used regular expression is
projectlist  the choice operator “|”, which matches either the ex-
to all pro- pression before or the expression after the operator.
jects that For example, if the user types &exampledataltest
match the in the projects filter, the project list will reduce to all
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Filter Description

Option

givenregu-  projects that have the word exampledata and all
lar expres- projects with the word test in their path.
sion.

Press enter on the keyboard to apply the filter. The filtered number of projects
over the total number of projects is displayed. For example, the image below
displays 7 out of 1743 projects with the word demo in their path.

Repository - SECURE
() Testing -
Joustomersfabbott/2011/ab11) =

lproject |
v? + A\ Projects: 39/17!
w $ O

Repository Filter

™ Tip: For more examples of regular expressions supported by the projects filter,
click here.

Filter

As the database grows, the Filter tool becomes useful for sifting through studies to
find just the right one. Options for filtering include Patient’s Name, Patient ID,
Study Description, and Study Date. After entering values in these available fields,

simply hit the refresh filter settings button @ to refresh the Study Browser. To

view all the data again, hit the clear filter button==to empty the fields, and hit

again to refresh the Study Browser.

O Note: filtering uses a Unix-like naming structure. For example, to find all studies
that begin with Mouse, enter Mouse* in the filter for Patient’s Name. To find any
study containing 1123, enter *1123* in the filter for Patient’s Name.

[+]

Also available in the filter options is the — function, used to expand or collapse the
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entries currently displayed in the Data Browser. The first click will expand all data
at the patient/study level; the second click will then expand at the series level; the
third click will collapse the series level; the fourth click will collapse patients/

studies.

Filter
Patients Name

Patient ID:

Description:

Study Date:  All =

8 » O

Plus Function

The image below shows the project list on the Study Browser before expansion:
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& Data Browser

? X

__I_t_eposltory-SEUJRE ] Study Browser
|_@Tastlng *| | Patients Name StudyDate StudyDescription Patient 1D
/anghela01 LMY Paticnt 0101 Name 1970-01-01 12:12  Study 0101 Des... Patient 0101 ID
|pi-0}ed Filter ] kgl Patient 0011 Name 970-01-01 12:12 Patient 0011 ID
T e B bl Patient 0004 Name 1970-01-01 12:12 Patient 0004 ID
i< B ..\ Projects: 1751/: | , [ SNRGSATEVI, 1970-01-01 12:12 atient 0003
'_' '_ 0 bl Patient 0001 Name 1940-06-06 12:12 Study 01 Descri... Patient 0001 ID
Filter
PatientsName | |
patientio: | |
Description: | |
Study Date: Al ¥

8% 0
Data
Show data type:
Al data tvoes =

@ & &

Apply default shift

Auto-Start reconstructic
[] Force pl [] Stack 3D
# Aopend | » Open |

Transfer

[[® Close | ["@'Ston

Before Expansion

After one click of the @ button, the project list will be displayed as follows:
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& Data Browser

Repository - SECURE Study Browser
O esting Bl |l potierts Nome.
/anghela01 - :
[Project Filter |
v? [+ % Projects: 1751/
- O
Filter 1970-01-C RG]
Patients Name | | l s 1970-01-0 4 Patient O
patientio: | | ' : '
Descripion: | |
Sty Date:
o

StudyDate StudyDescription Patient ID
01-01 12:12 Study 0101 Des... Patient 0101 ID

Patient 0003 ID

. Patient 0001 ID

Data

Show data type:

|All data tvoes ¥
LI

Apply default shift

Auto-Start reconstructic

[] Force pl [ ] Stack 3D

# Aobeni | * Open |

First Expansion

After the second click of the = button, the series level will be displayed in the
Study Browser:
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& Data Browser

[Project Filter

7 X
Repository - SECURE Study Browser
@Tﬁtlng Bl Patients Name StudyDate StudyDescription Patient 1D
/anghela01 MR Patient 0101 Name 1970-01-0112:12  Study 0101 Des... Patient 0101 ID

- %O
Filter

Patients Name | |
patient1D: [ |
Description: ||
Study Date: (Al

a
2
(<]

Data

Show data type:

[All data tvoes =
@ 8

Apply default shift

Auto-Start reconstructic

[] Force pl [] stack 30

Transfer

7 [+ A\ Projects: 1751/;

v
Image Type Image Date Dimensions InstanceNo
CT CT Reconstr... 1970-01-01 12:12 128x128 0001
CT CT Reconstr... 1970-01-01 12:12 128x128 0002
CT CT Reconstr... 1970-01-01 12:12 128x128 0003
CT CT Reconstr... 1970-01-01 12:12 128x128 0004
CT CT Reconstr... 1970-01-01 12:12 128x128 0005

Patient 0011 Name 1970-01-01 12:12 Patient 0011 ID

Image Type Image Date Dimensions InstanceNo
CT CT Reconstr... 1970-01-01 12:12 128x128 0001
Al Patient 0004 Name 1970-01-01 12:12 Patient 0004 ID

Image Type Image Date

Dimensions InstanceMo
CT CT Reconstr... 1970-01-01 12:12 128x128 0001

Al Patient 0003 me 1970-01-01 12:12 Patient 0003 ID

Image Type Image Date Dimensions InstanceNo
CT CT Reconstr... 1970-01-01 12:12 128x128 0001
bl Patient 0001 Name 1940-06-06 12:12 Study 01 Descri... Patient 0001 ID

Image Date

Image Type Dimensions InstanceNo
|CT_CT Reconstr...| 1940-06-06 12:12 128x128 0001

Second Expansion

O Note: Expanding large numbers of datasets can take several minutes.

Data

The Data section provides several functions for manipulating data, including
sorting, finding, and opening.

Show Data
Type

Open

This pull-down menu is used to limit the data displayed in the
Study Browser to a single modality (i.e., CT) or data type
(i.e.,reconstructions).

Opens the data highlighted in the Study Browser. If a single
data file is highlighted, it will be opened as the Reference im-
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age. If an entire Study is highlighted, the Open button recog-
nizes which data file is the CT and sets it as the Reference. The
Open button unloads data currently in VivoQuant and re-
places it with the highlighted data. More information on the
relationship between the Study Browser and the Open button

can be found in the Study Browser (page 55) documentation.

* Open

Append Appends the data highlighted in the Study Browser to the da-
ta sets already loaded into VivoQuant. For example, if two da-
ta sets are selected in the Data Browser and three data sets
are already loaded into VivoQuant, then appending the two
highlighted data sets will cause them to appear as data sets 4
and 5 in the Data Manager (page 282). Use the Open button to
unload data currently loaded in VivoQuant and replace it with
the highlighted data.

» Append

Enables a search of the Study Browser by looking for user-de-
Find fined text in one of the available columns (Patient’s Name,
Study Date, Study Description, or Patient ID).

Allows data from a local folder to be imported into another lo-
Import cal folder, database, or iPACS repository.

Allows data to be copied to a local folder.
Export

Apply default  If checked, a pre-defined shift will be applied to reconstructed
shift SPECT datawhen it is opened. See Reorientation (page 164)
for more details on setting default shift values.

Auto-startre-  If checked, CT and NM reconstructions will begin automatical-
construction ly when the Open button is applied to projection datain the
Study Browser.

Force planar If checked, it prevents interpolation from being performed on
data with non-isotropic voxels. By default, data with voxel
widths greater in the z dimension than in the x and y dimen-
sions will be interpolated to have isotropic voxels when the
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Open button is applied.

Stack 3D If checked, each 3D volume is loaded one on top of the other in
a single series of images. If unchecked, each 3D volume is
loaded in the same space, as a separate series.

Data Formats

By default, the Data Browser supports data with *.dcm, *.dc3 or *.dicom
extensions. To edit this setting and configure loading in extension-less data from
the Data Browser, navigate to the DICOM Settings page (page 29).

Study Browser

The Study Browser displays the data found in the selected Repository. The Filter
(page 49), Show Data Type (page 53), and Find (page 54) options can be used to
limit the data displayed in the Study Browser. In all cases, the data is opened with
either the Open (page 53) button or the Append (page 54) button. The Open
button will unload data currently open in VivoQuant and load the highlighted data
asReference, Input 1, Input 2,etc. The Append button will leave the
currently loaded data unchanged and append the highlighted data. This appended
data may be accessed via the Data Manager (page 282).

At the top level, multiple files may be opened into the Main Window
simultaneously. The Data Browser recognizes the files in the study and opens them
accordingly, setting the CT image as the Reference. If extra data is found, the Data
Browser provides the message: Ignoring extra data sets.

& Data Browser ? X
Repository - SECURE Study Browser
) Testing *| | patients Name StudyDate StudyDescription Patient ID
[anghela01 MBI Patient 0101 Name 1970-01-01 12:12  Study 0101 Des... Patient 0101 ID
|_n..J;._.._1 Filter bl Patient 0011 Name 1970-01-01 12:12 Patient 0011 ID
bl Patient 0004 Name 1970-01-01 12:12 Patient 0004 ID

v? |+ Projects: 1751/

£} Proj / bl Patient 0003 Name 1970-01-01 12:12 Patient 0003 ID
w % O bl Patient 0001 Name 1940-06-06 12:12 Study 01 Descri... Patient 0001 ID

Filter

Patients Name
Top Level

At the next level, single data sets from a study may be selected for viewing.
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& Data Browser

? X
Repository - SECURE Study Browser
|_@T&ﬂ‘lng ™| | patients Name StudyDate StudyDescription Patient ID
|/anghelad1 MR Patient 0101 Name 1970-01-01 12112 Study 0101 Des... Patient 0101 ID
[Project Filter | e iptior t a .
7 [+ A Projects: 1751/: - ' s
g ) / bl Pati 0011 Name 1970-01-01 12:12 Patient 0011 ID
i_ __*_. L0 El Patient 0004 Name 1970-01-01 12:12 Patient 0004 1D

Filter bl Patient 0003 Name 1970-01-01 12:12 Patient 0003 ID
Patients Name l:l bl Patient 0001 Name 1940-06-06 12:12 Study 01 Descri... Patient 0001 ID

Second Level

This nested structure continues, depending on the format in which the data is

saved. For example, for CT data saved in Single Frame format, single slices may be
selected for viewing.

& Data Browser

? X
Repository - SECURE Study Browser
|—@Test'"9 7| | patients Name StudyDate StudyDescription Patient 1D
fanghela01 MBIRA Patient 0101 Name 1970-01-01 12:12  Study 0101 Des... Patient 0101 ID

[Project Filter |

v Series 1 Description  1970-01-01 12:1;
Image Type Image Date Dimensions InstanceNo
CT CT Reconstr... [1970-01-01 12:12  [128x128 0001
Filter (T CTReconstr... 1970-01-01 1212 128x128 0002
patients Name [ | CT CT Reconstr... 1970-01-01 12112 128x128 0003
e |:| €T CT Reconstr... 1970-01-01 12:12 128x128 0004
L 4 €T CT Reconstr... 1970-01-01 12:12 128x128 0005
Description: [ b8 Patient 0011 Name 1970-01-01 12:12 Patient 0011 ID
Study Date: Al 7 bl Patient 0004 Name 1970-01-01 12:12 Patient 0004 ID
r st O Ll Patient 0003 Name 9 p Patient 0003 ID
- | b| 'O| bl Patient 0001 Name 940 5 12:12 Study 01 Descri... Patient 0001 ID
Third Level

Ctrl-clickandShift-clickoptions are alsoimplemented to simplify data

selection. This feature is useful for selecting multiple subsets of studies for both
loading them into the Main Window and exporting them.

VivoQuant™ 2022 User Manual Page 56


http://127.0.0.1:4012/vqmanual/images/filemanage_opendicom_DBsecondlevel.jpg
http://127.0.0.1:4012/vqmanual/images/filemanage_opendicom_DBsecondlevel.jpg
http://127.0.0.1:4012/vqmanual/images/filemanage_opendicom_DBthirdlevel.jpg
http://127.0.0.1:4012/vqmanual/images/filemanage_opendicom_DBthirdlevel.jpg

Opening DICOM Data Last updated: March 08, 2023

& Data Browser

? X
Repository - SECURE Study Browser
1 o
|GT“'SU“9 7| | patients Name StudyDate StudyDescription Patient ID
|/anghelad1 MR Patient 0101 Name 1970-01-01 12:12

Study 0101 Des... Patient 0101 ID

|Proied Filter |

= tie 97 - Patient 0011 1D
LI AN) tion Se .
Hlter > Series 8lile 7 U’ ¢ : € . .
Patients Name l:l Al Patient 0004 Name 970-01-0 HP Patient 0004 1D
patient1D: [ | 5 S -
Description: [: A Patient 0003 Name

Patient 0003 1D

Study Date: | All - :
O o > Sariee cerin
!] S| © bl Patient 0001 Name 940-06- Study 01 Patient 0001 ID
Multiple Selection

Right-Click function

The right-click function of the Data Browser is used as a shortcut for opening/
exporting CT or NM data and sending it to a batch job (HISPECT or BatchCT for
SPECT and CT data, respectively), reconstruction or DICOM dump. When working
in a local repository, the right-click option may be used to delete data.

To use this function, highlight either the CT or NM data and right-click. A box with a

number of functions is then displayed. The options vary depending on the type of
projection data selected.

Within Database or iPACS Server

Right-click on the Helical CT or Helical SPECT scan of interest.
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Study Browser

Patients Nam; StudyDate StudyDescription

bl Patient 0101 Name 1970-01-01 12:12 Study 0101 Des...
hll Patient 0011 Name 1970-01-01 12:12

S Patient 0004 Name IR

Ll Patient 0002 Name
Ll Patient 0001 Name

Ik Copy Data IDs for Worklist

B Export to... >
®  Open in..
Dump header

Right-Click

The Right-Click function provides various options, depending on the data type
available.

Open Opens the selected data set in VivoQuant and loads it as the refer-
data ence (see Open Reference (page 60)).

Export  Allows datato be copied to alocal folder or to another Data Browser
to... or iPACS repository.

Open Allows the data to be opened in an external Application.
in...

Dump Sends the file to the DICOM dump (page 304) tool, which displays the
Header information contained in the DICOM headers.

Within a Local Repository

When working in a local repository, the right-click button may also be used to
delete data.
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Study Browser
v
Patients Name StudyDate StudyDescription
bl Patient 0101 Name 1970-01-01 12:12 Study 0101 Des...

bl Patient 0011 Name 1970-01-01 12:12

Image Type Image Date Dimensions
CT CT Reconstr L1070 A1 N1 19099 170,190
bl Patient 0004 Name ® Open data

bl Patient 0003 Name . Copy Data IDs for Worklist
b Patient 0001 Name
& Export to... v
® Open in..
Dump header
FileType: dem
Delete Local Data
Transfer

The Transfer section of the Data Browser features a progress bar that shows the
percentage of completion of the current process.

Transfer Transfer

- I

. Ocose | ©stop ® Cose || @stop
Transfer Bar

I D Close

Click the M button to cancel the current process. Click the
button to exit the Data Browser.
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Open Reference Data

The first data set loaded into VivoQuant is called the Reference because it is often
a CT image used for anatomical reference. When loading multiple data sets from
the Data browser (page 46), VivoQuant recognizes CT data and automatically sets
it as the Reference. VQ is capable of handling several file formats (page 61).

Getting There

There are three different methods for opening data. The first method is to use the
Open Data or the Append Data @ thumbnails in the Main Window (page 209).

File View Tools Advanced Modules Help
CROROR NNl 80 00 o8

Main Window

The second method is to go to Open Data under the File menu.

File View Tools Advanced Modules Help

® Data Browser Ctrl+D gg nnn HQI I gl ﬁﬁ Q
Open Local Data . Open Data Ctrl+0 ||

C’p Connect to IPACS & Append Data [:i‘ Ctrl+T
Save Image Ctrl+ DICOM

B«  Save Movie Ctrl+M Bruker MR

B SaveData Multiple Images

B3 Session ’ Raw Data

&  VivoScript Ctrl+Shift+V

Exit

Open Local Data
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The third method is to use the keyboard shortcut Ctr1+0. For more on keyboard
shortcuts in VivoQuant, please see Keyboard Shortcuts (page 315).

Function

Selection of the Open Data option opens a navigation window from which the

Reference data set may be selected.

\& Open Reference

T™ « VivoQuant » Test Data » ct_spect
Organize ~ New folder
£ Name
s Quick access

\&l BrainAtlas-data0.dem
\&l BrainAtlas-datal.dem
\& raw_ct_subj10 - 01.dem
\& raw _ct_subj10.dem

I Desktop
¥ Downloads

o+
+
‘| Documents A
*

Date modified

10/22/2021 1:05 PM
10/22/2021 1:05 PM
/2019 1:08 PM

019 1:08 PM

6/11/2019 3:00 PM

6/11/2019 3:00 PM

&= Pictures \& raw_exampleSPECT - 01.dcm
ct_spect \&l raw_exampleSPECT.dem
images o v

File name:

Search ct_spect

=L W@

Type

VivoQuant DICOM file
VivoQuant DICOM file
VivoQuant DICOM file
VivoQuant DICOM file
VivoQuant DICOM file

VivoQuant DICOM file

v | |Data files (*.ras *.raw *.zraw *bi v

ca nce'

Navigation Window

File Formats

VivoQuant can handle a variety of file formats. The default options include:

DICOM: *dcm, *dicom, 1*
TRaster: *ras, *res., *bin

Raw: *raw

A

Image Files: *.png, *tif, “tiff, *jpg, *jpeg, *bmp
Other: *img, *nii, *mhd, *mha, *fdf, *.dc3, *vol

The navigation window also provides an option for displaying All Files, without

specifying any of the above formats.
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The second data set loaded into VivoQuant is called the Input data and refers to
the SPECT data. When loading multiple data sets from the Data browser,
VivoQuant recognizes SPECT/PET data and automatically sets it as the input file.
For dual isotope imaging, two input data sets can be added simultaneously.
VivoQuant is capable of handling several file formats (page 63).

Getting There

There are different methods for appending data. The first method is to use the

“Append Data” @ thumbnails in the Main Window (page 209).

File View Tools Advanced Modules Help
- oo 00
=S W R gl

Append Data

The second method is to go to File > Append Data.

File View Tools Advanced Modules Help

o wmg E0LFZ D

Data Browser
Open Local Data
Connect to IPACS

Save Image
Save Movie

Save Data

Session

VivoScript

Exit

Main Window

VivoQuant™ 2022 User Manual
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* | W Replace Data Ctrl+0

Append Data Ctrl+N
Ctrl+1 DICOM
Ctrl+M Bruker MR

’ Multiple Images

Raw Data

.3

Ctrl+5Shift+V
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The third method is to use the keyboard shortcut Ctr1+N to load input 1, and
Ctrl+Shift+N to load additional inputs. For more on keyboard shortcuts in

VivoQuant, please see Keyboard Shortcuts (page 315).

O Note: An initial data set must be loaded into the Data Manager prior to
appending data.

Function

Selection of the Append Data option opens a navigation window from which the
input data set may be selected.

v D O Search ct_spect

== L i | e
Date modified Type

VivoQuant DICOM file

VivoQuant DICOM file

VivoQuant DICOM file
1:08 PM VivoQuant DICOM file

3:00 PM VivoQuant DICOM file

-~

VivoQuant DICOM file

\& Open Input 1
T « 00_STX > VivoQuant > Test Data » ct_spect
Organize ~ New folder
2 Name
s Quick access
I Desktop e \H BrainAtlas-data0.dem
B @ \&l BrainAtlas-datal.dcm
ownloads  # ;
\& raw_ct_subj10 - 01.dem
o= + .
| Documents  # \& raw_ct_subj10.dem
&= Pictures of \& raw_exampleSPECT - 01.dem
ct_spect \& raw_exampleSPECT.dem
images e
File name: ||

~ | Data files (*.ras *.raw *.zraw *.bi ¥

Ca nce'

Navigation Window

File Formats

VivoQuant can handle a variety of file formats. The default options include:

oA e

DICOM: *dcm, *dicom, 1*
TRaster: *ras, *res., *bin

Raw: *raw

Image Files: *.png, *tif, “tiff, *jpg, *jpeg, *bmp
Other: *img, *nii, *mhd, *mha, *fdf, *.dc3, *vol

The navigation window also provides an option for displaying All Files, without
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specifying any of the above formats.
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This option is used to load the raw data from studies.

Getting There

To load raw data, go to File > Open Local Data > Raw Data.

File | View Tools

Q)
&)

Data Browser
Open Local Data
Connect to IPACS

Save Image
Save Movie

Save Data

Session

ViveScript

Exit

Open Raw Data

Function

Advanced Modules Help

Ctrl+D
»

Ctri+|
Ctrl+M

[ 3

»

Ctrl+Shift+V

8B am ®

Il Replace Data Ctrl+ O [
€& Append Data Ctrl+N
DICOM
Bruker MR

Multiple Images
Raw Data

Selection of the Open Raw Data option opens a navigation window from which the
raw data may be selected.
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\& Open Input 1 data from raw
- v 1T « Test Data > Autoradiography Calibration
Organize ~ New folder
& Name
s Quick access
I Desktop ? & Anon-8bits.decm
¥ Downloads E test-inp.raw
t Documents o
= Pictures »
ct_spect
images o[z
File name:

X
v ($] A Search Autoradiography Cali...
= i | e
Date modified Type
8/18/2021 11:39 AM VivoQuant DICOM file

~ | Data files (*.ras *.raw *.zraw *bi v

Navigation Window

Once the raw data has been selected, a Raw Data Importer window appears which
contains information about the data, such as dimensions, voxel size, data type and
file information. Most data is automatically populated from the file. Other data
fields have to be filled in by the user in order to provide VivoQuant with
information on how to interpret the file. Once all the data fields have been
completed, click Load to import the raw data is imported.
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Voxel sizes

0l

X |1,0000 mm

¥ 11,0000 mm

@I|@|

z 1,000 mm

Fie info

File size 21811330 | bytes
Datasze | 25958400 | bytes
Difference | 4147070 | bytes
Modality |CT v
Type  |Volume Data -
Data Unit |

Add. Info |

"] Import raw data: C;/Documents/VQData/ct_spect/raw_exampleSPECT.dcm

Dimensions Data type Patient Info

X 130 (3] O signedbyte O unsigned byte Patientsame | |
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- YR (O signed integer () unsigned integer ) | l
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Session

Sessions allow the user to save the current working environment. The exact
location in the software is saved along with the image data that is currently loaded
in the Data Manager. The operator or tool and parameters being used are saved as
well. A session can be saved to the local cache or exported as a compressed

zipacs folder structure that can be used to share with colleagues.

File View Tools Advanced Modules Operator Help
=sSCSME OB ceegJeex® ” =B

Operator & x Display

| - updgie dsabled
A e o N = '
@ vk N O X & D
= B * B \& Export Session
101 H
RC Name:
B background |Customer Session
OK
Sessions
Getting There

A session can be saved, loaded, or exported by selecting the appropriate option
under File > Session in the main menu.
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File View Tools Advanced Modules Help

oo 0
Data Browser Ctrl+D 83 1 o8 El
Open Local Data »

Connect to IPACS

Save Image Ctrl+1
Save Movie Ctrl+M
Save Data k

EEQ O

Session * B Load
VivoScript Ctrl+Shift+V Save

&

Exit {4 Export

©

Save Session

Session Manager

The Session Manager allows users to load previously saved sessions, save new
sessions and export sessions to save them locally and/or on any iPACS available.

When saving a session, users can specify the desired repository and session name
for easy sorting later.

& Save Session ! X
Sessions af
Name Date
Repository: & Local 5
epository i 1 RequestdHelp  2021-09-28T11:10:51
New Name:
|Loca| p—— 2 test.dicom 2021-09-23718:09:28

Store Public Link

Cancel OK
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Session Manager

In addition to saving sessions locally or to a desired repository, users may also
associate the saved session with a specific project from within their desired iPACS
repository. This allows for a more efficient access and organization of various
sessions across multiple projects.

& Save Session ? X

0 Name Date

Repository: O Testing e

Project: [home/ldsantos -

Filter: | |

New Name:

|iPAC5 Repository Session |
[ ] Store Public Link

Cancel OK

iPACS Repository Session

When exporting a session, specify a location on the local where the compressed
zipacs folder will be saved.
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\& Export to

& v 1 « 00_STX » VivoQuant » DEMO

Organize ~ New folder

e
Name

3 Quick access
B Desktop
¥ Downloads

Customer Sessions

& Documents

&= Pictures
ct_spect
images

v £

Folder: | DEMO

Search DEMO

Date Type

10/26/2021 5:21 PM File folde

Cancel

Select Folder

Export Session

To load a compressed zipacs folder, go to File > Session > Load, and select the
session from the appropriate folder. When loading a previously saved session, the
session GUI displays the name and date of each study and allows for easy sorting of
files . Users can click on any session to see a Preview of that session in the window.

& Load Session ? X
Sessions 53
Name Date
Reposttory: 1 Customer 1 2021-10-26T17:26:36
3 RequestdHelp 2021-09-28T11:10:51
4 test.dicom 2021-09-23T18:09:28
Cancel OK
Load Session
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Right-clicking on a session in the Session Manager allows the user to delete that
session, export it as a compressed zipacs folder to a local storage location, or
create a Public Link to the session. Public links can be copied to the user’s clipboard

and pasted into a report, email, etc., as desired.

17°] Load Session

S Name Date

Repository: ) PACS Documentation  ~ 1 B Eport 16:41:32
R 2 New Session (0 Pl Lok NS

X Delete
3 SavedSession —cuei=wvweurivt:13:40

PublLink n

Copied to your clipboard:
https://invicro.apacs.invicro.com/publiclink/dl/9b8f23b2d4d38d31

OK

Cancel

Public Link
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Navigation

The Navigation operator is selected by default when VivoQuant is opened. This
tool enables the user to manually scroll through the image slices and rotate the
Maximum intensity Projection (MIP) (page 0). Similar functionality is available via
the View Control (page 265) tool.

O Note: this page is concerned with Navigation in Slice View (page 226). While
navigation is similar in other view modes, the keystrokes and movements described
below may not produce identical behavior. For information regarding navigation in
other view modes, see the Tile View (page 230), Multi View (page 233), or MPR
View (page 280) sections.

Getting There

To enter the Navigation Panel, select Navigation from the pull-down menu on the
VivoQuant front panel.

File View Tools Advanced Modules Help

=SS Mma - 88 0000 ng g oy L E o) E Sice View = | Nangation 1R
Display Reorientatio...Registratiol

Cropping

3D ROI Tool
Projection
Distance/Annotation

Modeling

Arithmetics
Time Series
Filtering

Navigation Panel

There are several methods for operating the slice control navigator. This section
describes manual manipulation using a mouse device. The View Control (page 265)
tool offers a wider array of options for controlling the Navigator window.

Function

Navigation through the viewports includes scrolling through slices, zooming and
panning.
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Navigation Function

Scrolling

To scroll through the individual slices, move the mouse cursor up and down or to
the side on the different viewports (sagittal, coronal or transverse). The mouse
wheel may also be used to scroll through slices or to rotate the MIP.

When in Slice View (page 226) or in Multi View (page 233) with Link Views

checked, scrolling is not independent across viewports: scrolling in one viewport
will affect the other viewports.

Zooming

To zoom in or out within a viewport, hold the Shift key and move the mouse
wheel forward or backward, respectively. Zooming is independent across
viewports: zooming in one viewport will not affect the others, and all viewports
may be zoomed to different amounts.

Panning

To pan within a viewport, hold the Shift key and click and drag the mouse.
Panning is independent across viewports: panning in one viewport will not affect
the others, and all viewports may panned to different amounts.
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Resetting Viewport

At any time, the zooming and panning within viewports may be reset to their

. N
default positions by clicking the S icon located on the toolbar.

|File View Tools Advanced Modules Help
- 00 0
=QQME - B[ ¢ o~

Reset to Default

5 &

=

MIP-Specific Function

The functions for controlling the MIP are slightly different than the functions that
control the slices.

VTKMIP

To freely rotate the VTK MIP, click and drag the mouse across the MIP. To zoom in
and out, scroll the mouse wheel forward and backward. To pan around the MIP,
hold the Shift key and drag the mouse across the MIP. To rotate the MIP about a
fixed axis of rotation, hold the Ctrl key and drag the mouse in a circular motion
across the MIP.
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VTK MIP

This information is also found in the MIP Control tool. For more information on

using this tool, see the MIP Control (page 270) page.
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Tooltip

The tooltip feature is available by briefly holding a mouse click on any of the three
slice views (transverse, sagittal, coronal) in the Navigator window. The tooltip
feature displays (x,y,z) coordinate locations and voxel values for each displayed
data set for that (x,y,z) position.

(80,114,292}
i <17 FIRAE

{020

NM: 0.000646776

Tooltip

This information is also found in the View Control tool. For more information on

using this tool, see the View Control (page 265) page.
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3D ROI Tool

Overview

ROl stands for Region of Interest and is used to describe a particular area or
volume within an image for which the user wishes to characterize some quantity or
quality. The 3D ROl operator provides advanced tools for drawing, visualizing,
saving, and quantifying both 2- and 3-dimensional regions. This tool allows for
having a voxel belonging to more than one ROI. For example, a user could have an
ROI that contains the whole brain and other ROIs for regions of the brain, meaning
that each voxel of the whole brain ROl would need to simultaneously be part of two
different ROls.

Invicro implemented overlapping of ROls by adding layers. The user is able to add
new layers in the 3D ROI Operator, select an active layer, and create and modify
ROls in that layer independent of the contents of other layers. Overlapping is then
possible as each voxel can belong to various ROls on each layer.

The previous ROIs approach limited the user to 256 ROls, as it used an internal
buffer of unsigned chars (1 byte per voxel). To allow for multiple layers, the new
approach keeps a list of buffers of unsigned chars that can be increased on demand
by the user up to a potential of 8 layers if the RAM allows it. The new maximum
total number of ROIs was then increased to 2048, and each voxel now supports up
to 8 overlapping ROIs. However, the allocated RAM for the ROIs object increases
significantly as the user adds more layers. We can also expect a small overhead
execution cost when drawing the ROls on the image for display purposes, as the
blending or the handling of the different layer will require more processing.

Getting There

The 3D ROI tool can be accessed via the operators pull-down menu on the
VivoQuant front panel.

File View Tools Advanced Modules Help

=SS M B> 88 (000 DBD o » & E Slice View ~ |Navigation -l R -
= = Navigation ~
Display Reorientat . gistration
Cropping
TE @ 00 TE @ 3D ROI Tool
*3 Projection
Distance/Annotation
Modeling
Arithmetics
Time Series

Filtering
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3D ROI Tool

When the 3D ROI Tool is selected, a 3D ROI Tool operator window is displayed.

File View Tools Advanced Modules Operator Help
=OOMEBOE 88Meg0e & O O B
= ] &) E_su:maw ~ |30 ROI Tool - a Quick Scripts v
Operator A x
A ® @
Gl v s X & O
= m e &

LA

!_ ~

ROI H |

B background ] v
Layers

+ A\ X v @ Layer #0 -
ROIs

-I- X ¥ % @ | B vackground v
Operator VC MC DM

3D ROI Operator Window

Each tab of the 3D ROI Operator window provides a grouped set of functionalities.

ROI Loading, Saving, and Quantification Tools (page 102)

@ Painting Tools (page 125)
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E 2D Drawing Tools (page 128
—1 3D Segmentation Tools (page 131

Expert Settings (page 145

R

Layers

We use ROls to label voxels in the image as belonging to a region, so we can extract
guantitative information about that region from the image. Layers allow the user to
specify that a particular voxel belongs to multiple regions. Within a layer, a given
voxel can only belong to one region; that is, ROls are associated with a layer. For
example, one layer could contain different brain sections, while another layer
defines the entire brain.

Operator & X Display

3 ® @ N | =

@ s X WO

B E® b
RO H

n background

Medulla

K X

Cerebellum

Midbrain

&

Pons

B Cortex

]
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]
DDDDDDDD_W}

¥ Thalamus

Layers
+ N[ | Layer #0 -
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+| % ¥ % <@ | M background -
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No brain sections defined
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Whole brain ROI (green) defined in Layer 1
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Brain sections separately defined as ROls in Layer O
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Cortex brain section (red) defined in Layer O over whole brain (green) of Layer 1
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Operator g X Display
A e & N =
@ s O X W0
=B % e v
ROl H [
M background O

5. Whole Brain [] [l

Layers
+ A\ X w @ Layer#
ROls

+ 5 X %

a3

M background

Operator VC DM

Whole brain section (green) layered over cortex brain section (red)
Layers can be created and deleted from the strip of icons at the bottom of the 3D
ROI Operator.
Layers

+ N X % @ Layer#0

Layer Options

Relevant layer actions are described in the table below.

[

E Add a Layer (page 85)
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Icon | Description

Edit a Layer (page 86

]

Hide a Layer (page 87

Reset a Layer (page 87

G [

Delete a Layer (page 87

(%]

Add a Layer

Click the Add Layer button E to create a new layer.

A popup window will open, prompting the user to name the new layer and set the
transparency of the ROIs by selecting an alpha value.

e Decrease the alpha value to increase the transparency of all ROls in the
layer.
e Values range from 0% - 100% and change by 10% increments.

e The option to make the layer hidden is not available during the layer
creation process and appears greyed-out.

\id 3proOITool  ? HEM

Add Layer
MName Layer #1
Alpha fl:mﬂ % =
Hidden
oK Cancel
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Add Layer

O Note: The maximum limit of layers in one session is 8.
Edit a Layer

Click the Edit Layer button = to edit a existing layer.

A popup window will open, allowing the user to edit the name of the selected layer,
change the transparency of the ROIls by adjusting the alpha value, or hide/unhide
the layer.

e Decrease the alpha value to increase the transparency of all ROls in the
layer.

e Valuesrange from 0% - 100% and change by 10% increments.

@ 3DROITool  ? HEMR

Edit Layer: O
MName Layer #0
Mmﬂ _ 100 % -
|| Hidden
oK Cancel
Edit Layer

Select Active Layer
Select the layer of interest from the dropdown Layer to set it as the Active Layer.

The display will show the active layer, and any layer actions, such as editing or
deleting, will be performed on the current active layer.
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Layers
+ A\ (% % @ |Layer# vl

- Layer #0
ROls

Active Layer

Hide a Layer

Click the Hide Layer button @ to hide the active layer. Click the Hide Layer button
again to show the layer.

Layers
+ (A (%] ] [®]|Layer# ¥
Hide / Show Layer

Reset a Layer

Click the Reset Layer button = to clear the contents of all ROls in the active layer.

Layers
EIRRNEE AL S ml_ayar#1 "

Reset Layer

Delete a Layer

Click the Delete Layer @ button to open options for the active layer.
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Layers
+ 3\ E %W @ Layer#1 -

Delete Layer

A popup window will open, prompting the user to delete or reassign the ROls
associated with the specified layer.

& VivoQuant ? -

[ ] Re-assign ROI Pixels?

TargetLayer: ID 0: Layer £0 d
Move policy: Respect Immutable hd
OK Cancel

Delete Layer

e Todelete all ROls in the layer, click OK.

e Toreassign the ROIs to another layer, click the Re-assign ROl Pixels check
box and the greyed-out options underneath will become active.

& VivoQuant ? _

Re-assign ROI Pixels?
Target Layer: ID 0: Layer £0 -

Move policy: Respect Immutable v

oK _CEncel

Re-assign ROI Pixels

Verify that the layer selected in Target Layer is the layer of interest then select the
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Move Policy to apply.

et

Re-assign ROI Pixels?

Target Layer: ID O: Layer %0 v

Overwrite

VivoQuant ? _

Respect Immutable
| New ROIs from Overlap

Select Move Policy

Available Move Policies are described in the table below.

Move

Policy

Overwrite

Keep Desti-
nation

Respect
Immutable
(default)

New ROls
from Over-

Description

ROIs from the layer being deleted (active layer) will trump any
overlapping ROIs existing on the destination layer. Use this op-
tion if you do not want any of the ROIs being moved to be
changed.

ROls on the destination layer will trump any overlapping ROls
existing on the layer being deleted (active layer). Use this option
if you do not want the ROls in the destination layer to be
changed.

Use this option if the user wants ROls from both the destination
layer and layer being deleted (active layer) to be preserved or
overwritten based on pre-specified information. ROls marked
immutable from the destination layer will trump any overlapping
ROls. ROIs not marked immutable from the destination layer will
be trumped by the ROls from the source layer if overlapping.

Using this option will create new ROls in areas where the desti-
nation ROls and the ROIs being moved overlap. Use this option if
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Description

lap you want the flexibility to decide how the overlap is handled.

ROI Creation and Deletion

ROls can be created and deleted from the strip of icons at the bottom of the 3D
ROI Operator.

ROIs
+/ [\ (% % @ EROI# =

ROI Creation and Deletion

Icon | Description

Add an ROI (page 20)

[+]

Edit an ROI (page 93

]

Delete an ROI (page 96

Reset an ROl (page 98

Gl [

Hide an ROI (page 100

]

Add an ROI

There are two methods for adding an ROI:
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1. Add Via ROl Section Buttons

Click the Add ROI button E to open options for adding a new ROI.

Add ROI

A popup window will open, prompting the user to provide specific information for
the new ROI, including:

The ROI's name and color.

The layer to which the ROl should be added

O Note: The Number of ROIs per layer should not exceed the limit of 256.
The transparency of the ROl in the slice and MIP views.

o To alter the transparency, increase or decrease the alpha values (a
lower percentage will increase the transparency of an ROI).

The ROI’s visibility by checking “Hidden” to turn the ROI off in all views.
The ROI’s ability to be edited by selecting “Immutable.”
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@ 3DROITool  ?

Add ROI
Mame ROI #2 .
Color 1] green v
Layer | Layer =2 v
Alpha s0% [ |wo% 5

[ ]Hidden [ ] Immutable

l oK Cancel

ROI Popup Window

2. Add Via Right-Clicking the Navigation Pane

Another option is to select any (or many) of the existing ROls is to right click and
select Add ROI. This will append a new ROI to the end of the list.
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Toggle Hide ROls
Toggle Immutables

% Reset ROIs

® Delete ROIs

Export ROls

Right-click Add ROI

Edit an ROI

To edit an ROI, double-click the ROI to be edited to select it and click on the Edit

ROI button™=". A popup window will opens and allow the user to change the name,
color, transparency (Alpha), visibility, and state of immutability of the ROI. To make
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ROIs immutable, check the boxes in the ‘I’ column.

Operator & X

ROI H I

B background

wer L U1y 3pRoITool  ? HEMN
Edit ROI: 2-blue
Name LeftiGdney
Color M biue
Alpha 50% =1 |100 %
[IHidden [ Iimmutable
| oK Cancel
‘ _
| ROIs |
+ A\ x|y @[ Wietkiaoney <] B
Edit ROI

Another option is to right-click on any ROl in the operator and select Edit ROI.

VivoQuant™ 2022 User Manual Page 94


http://127.0.0.1:4012/vqmanual/images/operators_3droitool_editroi.jpg
http://127.0.0.1:4012/vqmanual/images/operators_3droitool_editroi.jpg

3D ROI Tool Last updated: March 08, 2023

Operator & X
A | @ | @& | X
@ v e
= B M

ROI H I

™

o 3
» X

B background
B Heart []
B LeftKidney [ |

o
N\ Edit ROI Liver

s
4+ AddROI e

1 e [

Toggle Hide ROI
Toggle Immutable

Reset ROI
Delete ROI

X

Export ROI

ROIls
+| [N [ ] [@] [ wver E

b

Right-click Edit ROI

VivoQuant™ 2022 User Manual Page 95


http://127.0.0.1:4012/vqmanual/images/operators_3droitool_rightclickeditroi.jpg
http://127.0.0.1:4012/vqmanual/images/operators_3droitool_rightclickeditroi.jpg

3D ROI Tool Last updated: March 08, 2023

Delete an ROI

To delete an RO, double-click the ROl to be deleted to select it and click on the

Delete ROI button=—". A popup window will open and allow the user to move the
pixels of the selected ROI to either the background or another ROI.

Operator 5 X

ROI H
B background ]
M Heart E .

Liver & L]

\@ DeleteROI ?

Move pixels to ROI
' background v
background
Heart
ROIls
CINETID| [ TP —
Delete ROI
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Another option is to select one or many of the existing ROls, right click, and select
Delete ROI.

‘Operator 8 x
& [ 2 A
a & & [0
= E %

ROI H |

B background ]

B Heart B @

LeftKidnev I ]

N\ Edit ROI LeftKidney
+ AddROI

o
K

Liver

Toggle Hide ROI
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Reset ROI

—

Export RO

X ¢
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Right-click Delete ROI
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O Note: The ROI will no longer appear in the drop-down menu after being deleted.

Reset an ROI

To reset an ROI, double-click the ROI to be reset to select it and click on the Reset

ROI button . A popup window will open and allow the user to move the pixels of

the selected ROI to either the background or another ROI.

ROI H I
B background ]
M Heart B .
M LeftKidney []  []

[]

& Clear ROI

Move pixels to ROI

> IE

background

background
Heart
Leftikidney

ROIs

DINEINIO] T

Reset ROI

Another option is to select one or many of the existing ROls, right click, and select
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Reset ROI.
|Operdur & X
A e @#» N =
A v @0 X
= E O A
ROI H I
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LeftKidney [N
B Liver | (== ]
N\ Edit ROI Liver
4+ AddROI
Toggle Hide ROIs
Toggle Immutables
% Reset ROIs
M Delete ROIs
Export ROIs
ROIs
+ N (% %] (@] Liver v

Right-click Reset ROI

O Note: The ROI will still exist after it has been reset, but it will no longer have any
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voxels associated with it.

Hide an ROI

To hide an ROl in the slice and MIP views without deleting it, double-click the ROI
to select it and click on the Hide ROI button @ .

ROI H |

B background []
M Heart L] [
]

B LeftKidney [ |

Liver L]

ROIs
| [N] [9¢] ] -I-: Liver =

Hide ROI

Another option is to select any one or all of the desired ROls, right click, and select
Toggle Hide ROI(s). All selected ROIs will become hidden.
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Right-click Hide ROI

© Note: If the ROl is not immutable, it can be edited even if it is hidden.
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ROI Loading, Saving, and Quantification Tools

The first tab in the 3D ROI Operator window features tools for basic input/output
operations, quantification, and viewing functionality. To freely navigate through the
slices with the cursor, this panel must be active.
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Basic ROI Functions

The buttons in this tab perform several functions within the operator.
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Load or save an ROI from disk or iPACS (page 104)

&

Render ROls in the MIP view (page 116)

H

Reset the camera view (page 116)

Fl

Reset all ROls (page 116

Show the image histogram (page 119)

B X

Show the guantification table (page 122)

El

Export the guantification table to disk (page 123)

El

Perform a cut on an image using an ROl (page 123

Perform a copy or paste on an image using an ROl (page 125

Export ROIls into the Bed Removal tool (page 125

[ ™ A

Load an ROI from Disk

The 3D ROI tool supports file formats of VQ 3D ROI (.rmha), RTSTRUCT DICOM
(.dcm), and vtkStructuredPoints (.vtk). To load an ROI from disk, click the Load ROI

button €] , select the Load from disk option and choose the desired ROl from the
file browser.

Although RTSTRUCT files are intended to be paired with a referenced image, VQ
allows you to load any RTSTRUCT even if it was not created for that image. If
contours in the RTSTRUCT file overlap, the ROIs will be loaded in separate layers.
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Save an ROl to Disk

To save an ROI to disk, click the Load ROl button ==, select the Store to disk
option and specify a name and location for the file. All existing regions will be
written to the same ROl file.

When saving RTSTRUCT files, keep in mind that the RTSTRUCT file format
specifies contours using locations from a referenced image. If the referenced image
was resampled, the origin was moved, or any other changes were made to the
image in VQ that would change the coordinate space of the image, the currently
loaded image will need to be saved as well. This is to enforce that the locations of
the contour points in the RTSTRUCT file match the coordinate space of the new
referenced image.
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Load an ROl from an iPACS

To load an ROI from an iPACS, click the Load ROI button = and select the Load
from iPACS option. The image data currently loaded must have been retrieved

from an iPACS, and there must be an ROl associated with that image already stored
on the iPACS.

If only one ROI exists for the image, that ROI will automatically be loaded. If
multiple ROIs exist, the user will be given a drop-down menu of available ROls to
choose from. The choices can be distinguished by the ROl creator’s iPACS
username, date and time of creation, region names, and file type (RMHA or
RTSTRUCT).
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Load ROI from iPACS

Save an ROl to an iPACS

To save an ROl to an iPACS, click the Load ROI button ==, select the Store to
iPACS option, and select the desired format (RMHA or RTSTRUCT) of the file that
will be uploaded. The ROl will be automatically associated with the current image.
Unique filenames will be generated based on the creator’s username and the
patient’s name from the image header. Previously saved ROIs will not be
overwritten. The files will be saved to a subdirectory of the current project on the
WebDisk, named roi.

Similarly to saving RTSTRUCT files locally, the contour points in the generated
RTSTRUCT will be in the coordinate space of the current image, so if resampling or
other changes that affect the image’s coordinate space were performed on the
image in VQ, the current image will now be the referenced image for any
RTSTRUCT. The reference image should be saved to the iPACS before saving the
RTSTRUCT so that the RTSTRUCT files are associated with the referenced image
matches their coordinate space.
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Select Current Layer
By default, all layers are loaded or saved when loading or saving an ROI. However,
the user can specify to save only a single layer by loading or saving the current

layer. This functionality is only supported for RMHA files. The RTSTRUCT file
format does not support layers because contours can be overlapping.

:'Operator & X
A ® |&o | X | =

@ w o O (% b O

& Store to disk )
| W Load from disk
# Store to iPACS
| 8 LoadfromiPACS
Current Layer * | & Store Layerto disk
Merge * | B Load to Layer from disk
#®  Store Layer to iPACS
® Load to Layer from iPACS

Load or Save Current Layer

Merge ROls from an iPACS or Disk

To append previously stored ROls to a set of ROls currently openin the 3D ROI

tool, click the Load ROI button @ and select Merge from iPACS or Merge from
disk, depending on where the additional ROls are stored. The additional ROls
associated with that image will be appended to the currently open ROl set in the
3D ROl viewer. Previously saved ROIs will not be overwritten.
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If there is any overlap of existing and merged ROls, a new ROl will be created and
named as a combination of the two ROls listed names. For example, if a portion of a
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“Heart” and “Liver” ROl overlap after a merge, the new combined ROI created will
be named “Heart/Liver”, and consist of only the specific volume of Heart and Liver
that overlap.

To associate the combined ROI with the proper ROI, right-click the combined ROI
and select Delete ROI. A popup window will open and allows the user to move the
pixels of the selected ROI to either the background or another ROI. Selecting
“background” will delete the ROI all together.
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Center view on ROI

To center the field of view on the center of mass of a particular ROI, double click
the ROl in the ROI Table.

Render ROls in the MIP View

To trigger a new rendering of the current viewed ROls in the MIP view, click the

VTK button .

Reset the Camera View

To reset the MIP view to the original orientation and size, click the Reset Camera

button .

Reset all ROls

To reset all existing ROls, click the IE button and select Reset All. Empty ROIs will
still exist under the same naming and coloring scheme.
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To delete all ROls completely, click — and select Delete All. The background will
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be the only thing left in the ROl menu.
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Show the Image Histogram

To view a histogram of the image or any subset of the image determined by an ROI,

click the Show Histogram ™ button. Choose the image used to generate the
histogram by selecting it from the Data Set drop-down menu. The portion of the
image contributing to the histogram can be set under the ROl Controls by selecting
an ROl from the drop-down menu.

b Histogram ?
Data Controls Histogram Plot
Data set |01-CT: digitaldaszczakUAK [r Histogram: 01-CT:
No. bins |100 =
Min 0 600,000
Max |25 « 1 :
File Controls H
& prF | O update 400,000 J}5-
&t Data @ Close :
300,000 -+
ROI Controls i
= 1i: | :
I. background 1t
| M Heart i :
W L=ftKidne 1% -
100,000 —Jpi i iesivnoismisenensio i
Brain |
o i
r T T L T T
0 0.5 1 1.5 2 2.5
HU

Image Histogram

Set Quantification Table Columns
To determine which quantitative fields will be displayed in the quantification table

and stored to the iPACS, if applicable, go to the Operator tab on the main menu,
then select Quantification Table List.
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Set Quantification Table Columns

The available quantification values are described below:

ROI Name of the ROI. You can left-click this field to enter comments.
Patient Patient’s name for the current study.

Series Specific data set in the study from which the data was calculated.
Modality Modality from which the data values for the row were calculated.
Color Color of the ROI as drawn in the display.

Voxels Total number of voxels contained in the selected ROI.

Volume Volume of the selected ROl in units of cubic millimeters.

Mean Arithmetic mean of values of voxels contained in the ROI.
StdDev Standard Deviation of values of voxels contained in the ROI.

Min Minimum value of all voxels contained in the ROI.
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Max
Median

Sum

Unit

Conc 10%

Conc 50%

Conc
Peakregion

Conc Peak-
max

Conc Max

Conc

Conc Unit

Maximum value of all voxels contained in the ROI.
Median value of all voxels contained in the ROI.

Sum of all voxels contained in the ROI, sometimes interchange-
able with ‘Uptake’

Unit of voxels in the selected dataset.

Concentration (mean/volume) of the 10th Percentile of voxels
contained in the ROI.

Concentration (mean/volume) of the 50th Percentile of voxels
contained in the ROI.

Concentration (mean/volume) of the 3x3x3 cube of voxels with
the greatest mean of all 3x3x3 cubes of voxels contained within
the ROI. Referred to below as Highest-uptake region.

Concentration (mean/volume) of the 3x3x3 cube of voxels that
has at its center the maximum voxel of the voxels contained in the
ROI. Referred to below as SUVmax.

Concentration (mean/volume) of the maximum voxel of the voxels
contained in the ROI.

Concentration (mean/volume) of all the voxels contained in the
ROI.

Unit of voxels in the selected data set over volume (mm3).
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Suvma:

ROlpgak

Tumor u
™
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Suv - -

Highest-
uptake
0 region

“Impact of the Definition of Peak Standardized Uptake Value on Quantification of
Treatment Response”. Vanderhoek, et al. J Nuclear Medicine, 2012. Link .
Show the quantification table.

To display the quantification table, including all existing ROls, click the Show Table

button .

VivoQuant El

ROI Patient Series Modality Frame Color Voxels mm?* Mean StdDev |

1 background Hoffma... Average (Selected) PT [TO]0 transparent 2284880 18279040 0.0690180... 0.183947541.. 0
2 Heart Hoffma... Awverage (Selected) PT [TO]0 Red 0 0 nan nan n
3 LeftKidney Hoffma.. Average (Selected) PT [TO]0O Blue 0 0 nan nan n|
4 Liver Hoffma... Awverage (Selected) PT [TO]O Yellow 0 0 nan nan n
< >
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Show Quantification Table

Export the quantification table to disk.

To export the quantification table to disk as a comma-separated values (.csv) file,

click the Export Table button=—.

Perform a cut on an image using an ROL.

To remove voxels from image data based on an ROI, choose the desired ROI from

the ROl selector and click the Cut ROI button El .All visible images will be cut and
the ROI will remain unchanged. The cut tool is useful for eliminating undesired
features in images, such as metal instrumentation that may appear in some CTs.

Show or Hide an ROI

To hide an ROI, Check the boxes in the H column. An ROI can also be hidden by

=

selecting it and clicking on the Hide/Show button—.
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Copy or Paste the 3D ROI

Click the Copy/Paste ROI button == to copy and/or paste ROls between instances
of VivoQuant.

Export ROIls into the Bed Removal Tool

Click the Export to Bed Removal button E to export ROIls into VivoQuant’s Bed
Removal tool.

Import Layers and ROIs with Overlapping Regions

Certain image formats, such as PMOD VOI and DICOM RTSTRUCT, support
overlapping regions inherently. VivoQuant’s 3D ROI tool loaders handle the
overlap appropriately.

O Note: Overlapping ROls should be assigned to different layers.

Not only has the 3D ROI Tool been updated to be compatible with overlapping
ROls, but numerous pre-existing features also successfully operate on the active
layer supporting overlapping ROls. These include: Segmentation Algorithms,
Painting in the slice views, Tooltip Pixel hovers, Reorientation Operator, Modeling
Operator, Multi-view Visibility, VTK MIP, AutoRAD, MAS, Brain Atlas and
Smoothing Operator.

™ Tip: The number of imported layers should not exceed the limit of 8. Number of
layers should be efficient. Do not create one layer per region; but rather, collapse
regions to the same layer where possible.

Painting Tools

There are several paintbrushes to choose from when creating an ROI. The sphere
@ cube paintbrush can be selected by clicking the

corresponding radiobutton on the Painting tab @ . The radius of the paintbrush
can be set by changing the number of pixels shown in the numerical spin box. These
3D paintbrushes extend across multiple slices. To activate 2D mode, mark the ‘2D
only’ checkbox. In 2D mode, the paintbrush will only paint on the current slice.

, cyIinderIil ,or
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O Note: An ROI must be added before the painting tools can be used.

Operator & x

» (e (& s [ =

Use a sphere or circle to paint ROI over data.

® @ Sphere [] 2D only Highlight
) @ Cylinder 12 px =
() @ Cube [] Sync Pos

Erode/Dilate to remove/add layers of voxels to an ROI:

4 5Dilate ~ [ |Mapto v >
[ 12D only [] Current Slice only

Re-render ROl witk

Layers

* | N X || @ Layer#0 x|

ROls

* AN X | @ Liver -
Painting Tools

ROls can be drawn freely on any of the three slice views. The view currently being

drawn in will be denoted as Active in the upper left corner.

Each voxel can only belong to a single ROI. Painting over an existing ROl with a new

ROI will place the painted voxels in the new ROI, unless the existing ROl is
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immutable. (See Edit an ROI (page 23) to learn how to make an ROl immutable.)

To erase voxels from an existing ROI, paint over the existing ROl with the ROI
selector set to Background. Alternatively, set the ROl selector to the existing ROI
(from which to erase voxels) and hold down the Shift key while drawing. The Shift
key activates the background ROI for the painting tool, even if another ROl is set in
the ROl selector.

Sync Pos

If “Sync Pos” is checked, then the non-Active slice views will be updated in real time
to match the position of the drawing tool on the Active slice. When this option is
selected, drawing times will typically be slower.

Operator g5 X Display

S [} - N =

Use a sphere or circle to paint ROl over data

® @ Sphere [] 2D only [¥] Highlight
O W Cylinder 2 px =
) @ Cube [¥] Sync Pas

Erode/Dilate to remove/add layers of voxels to an ROI:
4 SDilate ~ [ ]Mapto |01 x v

2D only [] Current Slice only

Re-render ROl vtk

Layers

+ A X % @ |Layer#0 -
ROIs
+| A X % @ |HHeart -
£
Sync Pos Option

Erode/Dilate.

The Erode/Dilate tool can be used to remove or add up to 5 layers of voxels from
the input ROI. The erosion or dilation will be applied to the currently selected ROI
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If you would like the voxels that are being added or removed from the ROI to be put
in an ROl other than the one currently selected, mark the ‘Map to’ checkbox and

[=]

choose the ROI to put the new voxels in from the drop-down menu to the right—.

To perform the erosion or dilation, click the Checkmark button—.

Operator -

» [ ] - R =

Use a sphere or circle to paint ROl over data

® @ Sphere —] 2D only [+ Highlight
O @ Cylinder 2 px 3
@ Cube +] Sync Pos

Erode/Dilate to remove/add layers of voxels to an ROI:

4 4Dilate ~ | [v] Mapto 0.2 -, s
4+ 5 Dilate

[] Current Slice only
4 3Dilate
+ 2Dilate
4+ 1 Dilate
-
-

3

1 Erode
2 Erode
3 Erode
4 Erode

Operator 8 x

r 8 e | X =

Use a sphere or circle to paint ROl over data.

® @ Sphere | 2D only [+ Highlight
@ Cylinder 2px
_ @ Cube [¥] SyncPos

Erode/Dilate to remove/add layers of voxels to an ROI

% 4Dilate ~ [V Mapto |01 v &

[] 2D only [ cumentsiice only | |#5)Layer®0
O W background "~ ]
[v] M Heart

Re-render ROl vtk
m LeftKidney
[l Liver

N

Layers
+ %\ X % @ |Layer#0 -
ROIs
+ |v X % @ HHeart -

Perform Erosion/Dilation

2D Drawing Tools

Layers
* XN X % @ |Layer#0 -
ROIs
+ A X % @ | M Heat -

The 2D drawing tools match the options available within the Projection++ Tool

(page 152).
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Operator & X

r (@ & x| =

Use the drawing tools to make 2D ROI
perimeters and apply them when ready.
Global: Rotate: Ctri+Wheel, Scale: Alt+Wheel
Points: Drag: Left, Remove: Mid, Open curve:
Ctri+Mid

Curve: Drag: Cirl+Left, Add point. Double Click,
Close: Right

Bully: Add: start point inside curve, Remove:
outside curve

«@& Spline Tool >

Thickness: |1 [2]

- |« [ Netemptysiice |3

Layers

+| A x %] @ [Layer#o 5

ROIls

*+/ 7] (% ] [@ | W Hear -]
2D Drawing Tools

(%]

button to add

Choose the desired tool from the drop-down menu to begin drawing. Use the

button to delete a contour (this will not delete the ROI). Use the
the voxels within a drawn contour to the currently selected ROI.
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Spline tool (page 130

Bully tool (page 130

LY

Freehand tool (page 130

EY

2D Thresholding tool (page 130

]

Spline Tool

Use the spline tool to define points between which smooth curves will be filled in.
The base points can be moved by using the left mouse button to drag them.
Additionally, points can be deleted by click on a middle point, or added by double
clicking on a curve. Once a shape has been closed by clicking the right mouse
button, it can be re-opened by hitting Shift + middle click on a point.

Bully Tool

Use the bully tool to nudge the drawn boundary inward or outward with a circle-
shaped cursor. The cursor size can be changed using the paintbrush size selector in
the Painting Tools (page 125) panel. This mode provides an efficient way to fine-
tune an ROI made in Spline or Freehand mode. You may select which image data
you want to use as the input (“Ref” is the first image loaded in the Data Manager,
“Inp1” is the second, etc.) and the thickness of the tool, in the bully tool and for the
following three tools as well.

Freehand Tool

A freehand region may be drawn by moving the mouse while holding down the left
mouse button. The region may be drawn in segments through a series left clicks
and closed with a right click.

2D Thresholding Tool

Use the Percentage selector field to set a threshold for the ROI. Specify the image
on which to base the thresholding using the drop-down menu.
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Apply Spline Path to ROl and move to next slice (page 131)

Apply Spline Path to ROI (page 131)
Apply Spline Path to ROI (page 131

@ Clear Spline Path (page 131)

Apply Spline Path to ROl and move to next slice.

This button creates a 2D ROI within the spline path and moves to next slice.

Apply Spline Path to ROI

This button creates a 2D ROI within the spline path.

Clear Spline Path

This button clears the spline path and all points.

3D Segmentation Tools

The 3D Segmentation Tools are located in the Segmentation Algorithms tab—.
They be used to apply different thresholding techniques across input images and
user-defined ROls, as well as advanced ROl processing.

O Note: An ROl must be added before the segmentation tools can be used.
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Operator

ENENERNR

=

-

Classify input voxels to output ROI:

Global Thresholding

Connected Thresholding
Neighborhood Thresholding
Otsu Thresholding
Confidence Connected

ROI Connected

ROl Max Size

Low-pass Smoothing
Bounding Cylinders
Interpolate Slices

| voxels of
lin the

RIn S

L

@ Layer#0

@ M Heart

3D Segmentation Tools

Setting the Input and Output ROI

The Input ROl must be selected from the Input drop-down menu before applying
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thresholding. If an ROl other than the background is selected, only image pixels
within the chosen ROI will be considered when thresholding is performed.

The Output ROl is the ROI specified in the ROl drop-down menu located at the
bottom of the 3D ROI Operator window. If the Output ROl is not empty prior to
thresholding, the result of the thresholding will be added to the existing voxels of
the Output ROI.

Keep in mind that other ROIs may be overwritten if the result of a thresholding

technique intersects them. To prevent other ROIs from being altered, set them to
immutable. (See Edit an ROI (page 93) to learn how to make an ROl immutable.)
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' Operator N =
(» [0 [o | x [= ]
Classify input voxels to output ROI:
Global Thresholding =
Global thresholding classifying all voxels of
the input to the output class that fall in the
range.
Input | | ==
Image: ;rD | (=
Min || ,
. Max || |
Apply
Layers
+/ [N % [»] [®] Layer#o z
ROIls
+/ |\ %] % @ B Heart -
Set Input/Output ROI

Choosing the Image Data

The segmentation algorithm will work on the data from the image specified in the
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Image drop-down.

Setting the Seed Point

For methods that require a seed, the cursor location at the time the thresholding is
performed will be used.

Setting the Thresholds

For methods that require thresholds, use the number fields beneath the Image
Selection drop-down. Click the Min and Max buttons to the left of each threshold
field to fill in the minimum and maximum values, respectively, from the selected
image. The unit is assumed to match that specified in the header.

Available Thresholding Methods

The thresholding methods available can be selected from the Segmentation
Algorithm drop-down menu. After selecting a seed and thresholds as necessary,
click ‘Apply’ to perform the segmentation. The thresholding operation may take
about a minute to complete.
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Operator g x
e~ X =]
Classify input voxels to output ROl
Global Thresholding -
Global Thresholding ~
Connected Thresholding I e
Neighborhood Thresholding 1;;?“;15 .
Otsu Thresholding —p—
Confidence Connected
ROl Connected
ROI Max Size =3
nass Smoothing :| =]
=
| =l
Max | |0.000418288
Apply
Layers
*+/ [\ % [» @] Layer#0 >
ROIls
+/ (A (%] % @ M Hean -
Thresholding Methods
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_ Requires Seed? | Requires Thresholds?

Global Thresholding
Connected Thresholding
Neighborhood Thresholding
Otsu Thresholding
Confidence Connected
ROI Connected

ROI Max Size

Low-pass Smoothing
Bounding Cylinders
Interpolate Slices

Modal Smoothing
Connected Components

K-Means Clustering

ROI Max Size

No

Yes

Yes

No

Yes

Yes

No

No

No

No

No

No

Yes

Yes

Yes

Yes

Yes

No

No

No

No

No

No

No

No

No

The ROI Max Size filter can be used to fill holes in existing ROls. Any connected
components in the Input ROI that are comprised of fewer voxels than the Max size

specified will be mapped to the output ROI.
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Operator & x

r e e N =

Classify input voxels to output ROI:

ROl Max Size -

Re-classify all voxel clusters of input ROI with
less than max size voxels.

Display !

n

Scout View
Scan Recons
2016-05-114

Input: 0.1 i‘:,
Max size (voxels): | 1000 =3 F] 2
m
L]
]
X 76 Y:131 |
Val -1000 HU
Min: -3.277e+
Layers
+ N\ X % @ Layer#0 -
ROIs
+ v %% @ HLung -
ROI Max Size
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BEFORE

Before/After ROl Max Size

Low-pass Smoothing
Use the Low-pass Smoothing filter to remove jagged surfaces from manually

created ROls. The amount of smoothing can be controlled with the Low-pass radius
parameter. Smaller radii will result in smoother ROls.
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Operator g x
L e » N =
Classify input voxels to output ROI:
Low-pass Smoothing bod
Smooth the current ROl using low-pass
filtering. Use a smaller radius for smoother
ROls.
Low-pass radius (px): |2n “@|
Apply
Layers
+ [\ % % @ Layer#o -
ROIls
+ \ (% % @ = Rightidney v

Low Pass Smoothing
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BEFORE

Before/After Low Pass Smoothing

O Note: Smoothing ROIs contained in images with large dimensions can take
upwards of 30 seconds.

Modal Smoothing
Use modal smoothing to reassign every voxel’s ROl value to the mode of the

surrounding region specified by the given radius. The amount of smoothing can be
controlled by the Mode Radius and Iterations parameters.

VivoQuant™ 2022 User Manual Page 141


http://127.0.0.1:4012/vqmanual/images/operators_3droitool_beforeafterlowpass.jpg
http://127.0.0.1:4012/vqmanual/images/operators_3droitool_beforeafterlowpass.jpg

Last updated: March 08, 2023

3D ROI Tool
Operator 8 X
A | ® | | N = _
Classify input voxels to output ROI:
Modal Smoothing ot
Reassigns every voxel's ROl value to the
mode of the surrounding region specified by
the given radius.
Mode Radius (px). |2 {%]
lterations: |2 3
. Apply
Layers
+/ (3] % 3] (@] Layrso :
ROls
+ [\ % % @ I RightKidney =

Modal Smoothing
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Bounding Cylinders

The Bounding Cylinders tool can be used to generate cylindrical ROls that
encompass each animal of a multi-animal image. The number of animals is
automatically determined and the cylinder radius can be configured. This algorithm
works best on NM images, but may also work on some CT images.
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Operator & X

r (e e N =

Classify input voxels to output ROI:

Bounding Cylinders v

Generate cylindrical ROls encompassing
each animal in a multi-animal NM image.

Image: |1 [

Cylinder radius (mm): |16.00 : [ []0.CT:ScanRe...
[¢] 1. CT: Scan Re... !

1 |
Ap |
Layers
+ [\ X | |®@ Layer #0 -
ROIs
+ [\ (%] |y @ 1 RightKidney v]
Bounding Cylinders

O Note: If there are any ROIs present prior to using this tool, they will be deleted.
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" Generate Bounding Cylinder ROIs

In order to proceed, all existing ROls will be deleted. Continue?

Yes | Mo

Generate Bounding Cylinders

Expert Settings

The Expert tab, presents the advanced settings of the 3D ROI Operator. For the
typical user, these settings will not need to be changed.
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Operator & x
Data Rendering
compressed 1| [x]  Quality High -

Segmentation
[ ] Crop range Smoothing

o
;u;

lterations: |E Multiplier: -5_.5

"y
ik

Time Step: 10_125 || Neighborhood: |2

Expert Settings

Data Group
By default, VQ ROls are written in a compressed format. To extend compatibility

with other tools (e.g., ITK), uncheck “compressed.” If the ROI files will only be used
within VQ, leave the “compressed” box checked.

Importing and Exporting ROIls

To import an ROl loaded in the Data Manager from an image file, click the Import

| . .
button and select the corresponding dataset to import. To export a 3D ROl as
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an image to allow manipulations outside of the 3D ROI tool, click the Export button
X

Operator 8 x

k0o | =
Data Rendering

| compressed 1] |X

Segmentation

"] Croprange

llerations: |5 + Multiplier 25

o

Neighborhood: 2

4k

Time Step: 0.125

-

Import / Export ROls

Rendering

If “auto” is checked, ROIs will be re-rendered in the MIP view automatically upon
certain triggers. When unchecked, rendering will only occur when the VTK button
(page 116) is used. For systems with less speed and memory, it may be helpful to
select a less demanding setting from the rendering quality combo box.

Segmentation

To add a curvature flow smoothing preprocessing step to the segmentation
methods (page 131), check the “Smoothing” box. Use the Segmentation fields to
tune up the parameters of the segmentation methods. The Smoothing filter will use
the Iterations and Time Step settings; the Confidence Connected Thresholding will
use the Multiplier and NeighborRad (neighborhood radius) settings; the
Neighborhoood Thresholding will use the NeighborRad setting.

Crop Range

To perform any of the thresholding segmentation methods on only a sub-region of
the input image, follow these steps:
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1. Open the Cropping operator from the Operators drop-down menu.

a - =
» ,__EE-_. L @ & Slice View ~ | Cropping x u "
— Navigation -
Display Reorientati.. egistration

-“1. _..:-_iu
3D RON Taol
Projection
Distance/Annotation
Modeling
Arithmetics

Time Saries
Filtering

2. Usetheredsliders to select the desired region of the image.

Display

3. After you've selected the desired region, go back to the 3D ROl tool by
selecting the 3D ROl operator from the Operators drop-down menu.

4. Inthe Expert tab of the 3D ROI Operator, mark the Crop Range checkbox.

Dashed red lines will appear on the image, indicating the boundaries of the
selected region.

VivoQuant™ 2022 User Manual Page 148


http://127.0.0.1:4012/vqmanual/images/operators_3droitool_cropoperatorsmeu.jpg
http://127.0.0.1:4012/vqmanual/images/operators_3droitool_cropoperatorsmeu.jpg
http://127.0.0.1:4012/vqmanual/images/operators_3droitool_redslider.jpg
http://127.0.0.1:4012/vqmanual/images/operators_3droitool_redslider.jpg

3D ROI Tool Last updated: March 08, 2023

Display

5. When the desired thresholding method is performed (see Segmentation
Tools (page 131) to learn how to use the Segmentation panel of the 3D ROI
Operator), only the region within the crop range will be segmented.
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Display

Undo/Redo Functionality

To undo/redo operations performed in the 3D ROI tool go to the View tab on

r‘
ViviQuant’s main menu and click the Undo EI or Redo = button. The operation to
be undone or redone will be described in the drop-down menu.Keyboard shortcuts
(page 315) are also available for undoing or redoing an operation.

\ad
File | View | Tools Advanced Modules Operator Help

& ™\ Undo Activate 30 RO Ctrl+Z j g™ »
M FRedc Ctrl+Shift+Z i

Mmar £ | .

Undo / Redo

O Note: The input ROl will be set to background whenever the undo function is
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applied.

The undo/redo functionalities are applicable to all functions performed on 3D ROI
dataitself. Operations performed to actual volume image data cannot be undone or

redone. For example, performing a cut on an image using an ROI (page 123) cannot

be undone since it is applied to actual volume data and not just 3D ROI data.

O Note: To undo/redo filling a contour in the Spline Tool (page 130) the user must
navigate away from the spine tool window.
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Projection

The Projection Tool provides a means to quantify density and activity parameters
in CT and NM, MR, PET, or SPECT images. The tool provides several options for
generating quantification data. There are multiple methods for setting the region of
interest (page 155), flexibility in selection of the quantification view direction (page
153), easy-to-read presentation of data found in the Quantification Table (page
156), and options for saving and loading ROIs (page 162) or plotting data (page
159).

Getting There

To access the Projection tool, use the View sub-menu in the Operator section of
the main menu.

File View Tools Advanced Modules Operator Help

=sSOeMEeOE BMEA08 e 2 © @ e L [E & i SiceView - |Projection -| B »
Navigation A

Operator s x  Display Reorientation/Registration
m =2 ABTro 001 Cropping

Mode  Options [ 3D ROI Tool
®e O | 4§ | o Projection

O & Distance/Annotation
2 TR Modeling

O & O Threshold: Ref 0.30 + ! a Pl 8

o Time Series

O 7 % BullyRad: 12 px - m Filtering

Access Projection

Using the tool

Upon selection of the tool, the Projection panel appears. The first step in using the

projection tool is to define a Region-of-interest (ROI) (page 78).
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File View Tools Advanced Modules Operator Help

=SeMLeE B0 ® O ® s L [ iy Slice View | Projection - a e
Operator & x  Display

Mode  Options

@& g

QO Threshold: Ref 0.30 »

O % BullyRad: 12 px =]

Help

Global: Rotate: Shift+Wheel, Scale: Alt+Wheel, Submit: Rig.
Points: Drag: Left, Remove: Mid, Open curve: Shift+Mid
Curve: Drag: Shift+ eff, Add point: Double Click, Close: Rig
Bully: Add: start point inside curve, Remove: outside curve

Resampling images took 0.1 sec

Define ROI

Choosing the View Direction

The ROI may be drawn in either the transverse (default), coronal, or sagittal plane.
To toggle between these options, use the View menu in the Operator tab of the
main menu.

File View Tools Advanced Modules Operator Help

eSCSME DS 39m3(C ® savetable Ctrl+S te View ~|Project
™ Append to table Ctrl+A
Operator i
Quantification Table List L
[\dode Options "% Clear table
.!] 2 D
~ & K Load ROI Ctrl+Shift+L
O Threshold: Ref ( & SaveROI Ctrl+Shift+S
O & s . &3 Submit to iPACS
O) fc » BullyRad: 12 p» - [B
View L4 Coronal
Help :
Global: Rotate: Shift+Wheel, Scale: Alt+Wheel, Subi Cut outside ALL Sagittal
Points: Drag: Left, Remowe: Mid, Open curve: Shiff+, Cut »  ~ Transversal

Curve: Drag: Shiff+Left, Add point: Double Click, Clc
Bully: Add: start point inside curve, Remove: outside [J Select FOV
SPECT_CT Reg
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Choose View Direction

In this example, using the default settings, the axial sliders (page 0) determine the
extent of the ROl in the axial direction. The region or pre-defined shape described
below determines the bounds of the ROl in the transverse plane.

Transverse Plane

By using the View menu, it is also possible to draw ROl boundaries in the sagittal
plane or coronal plane:

Sagittal Plane
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Sagittal and Coronal Planes

Choosing the ROl type

There are four ROI types, labeled as Modes:

E Spline Points are defined, and smooth curves are drawn in between.
The base points can be moved by using the left mouse button
to drag them. Additionally, points can be deleted (middle
click point) or added (double click position on curve). Once a
shape has been closed (right mouse button), it can be re-
opened by using Shift + middle click on a point.

Freehand A freehand region may be drawn by moving the mouse while
holding down the left mouse button. The region may be
drawn in segments through a series of left clicks of the
mouse.

I Bully Push lines out or into the object with a circle-shaped cursor.

= The size of the cursor is defined by setting the Bully Rad field
in the Options section. This mode provides an efficient way
to fine-tune an ROl made in Spline or Freehand mode.

Threshold A reference voxel is determined with a left click in the trans-
verse window. The ROl is determined by finding the region of
voxels surrounding the reference voxels that share similar
values to the reference voxels. The threshold value establish-
es how near in value the boundary voxels must be to the ref-
erence voxel.

Mouse Actions

Mouse Shortcut

Rotate ROl Shift + mouse wheel
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Mouse Shortcut

Scale ROI Alt + mouse wheel

Move ROI Shift + left click

Once the desired ROl has been defined, click the Show Table button — or right-
click on the ROI to open the Quantification Table (page 156). This table contains a
wide range of information, as described below.

Click the Clear button @ in the Options section to clear the current ROl and begin
drawing another.

O Note: The unit used for measuring CT attenuation is the Hounsfield Unit (HU),
while the unit used for measuring activity in the NM, MR, PET, and SPECT images is
Mega-Becquerel (MBq), kilo-Becquerel (kBq), or micro-Curie (uCi).

VQ maintains the most recent ROl until a new ROl is defined. Each ROI for which
datais collected is assigned a new color. Note, for example, that editing a ROI
following data calculation results in a change to the color of the ROI. Also, the MIP
(page 0) reflects the currently selected ROI by shading the region encompassed by
the ROl according to the appropriate color.

Quantification Table

After defining the ROI, the quantification table will fill the following fields.

VivoQuant n
ROI Patient Series Modality Color Voxels \E:!::;']E Sum Unit Conc Conc Unit Mean StdDev Min Max ZRange

1 M ROI#1 DEMO DEMO CT red 37720 301.76 1.05032e+06 HU 3480.65 HU/mm* 27.8452 139.166 -794.793 225042 54.55-63.85

2 M ROI#2 DEMO DEMO NM red 37720 301.76 15.2599 pCi  0.0505696 pCi/mm’ 0000404557 0.000286029 1.13096e-05 0.00101808 54.55-63.85

Quantification Table Fields

oo

ROI Name of the ROI. You can left-click this field to enter com-
ments.
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o

Patient Patient’s name for the current study.

Series Specific data set in the study from which the data was calculat-
ed.

Modality Modality from which the data values for the row were calcu-
lated.

Color Color of the ROl as drawn in the display.

Voxels Total number of voxels contained in the selected ROI.

Volume Volume of the selected ROl in units of cubic millimeters.

[mm3]

Sum Total amount of attenuation/activity in the selected ROI for

CT and NM, MR, PET, or SPECT data sets, respectively.

Unit Unit of voxels in the selected dataset. CT data use Hounsfield
units (HU). You can specify the units used by SPECT data in the

Data Panel (page 20) of the Configuration Tool (page 15). Op-
tions include MBq, kBg, mCi, and uCi.

Concentration Total amount of attenuation/activity in the selected ROI for
CT and NM, MR, PET, or SPECT data sets, respectively, divided
by the ROI volume.

Conc Unit Unit of voxels in the selected data set over volume. CT data
use Hounsfield units (HU/mm* 3). You can specify the units

used by SPECT data in the Data Panel (page 20) of the Config-
uration Tool (page 15). Options include MBg/mm3, kBqg/mm3,
mCi/mm3, and pCi/mm3.

Mean Average amount of attenuation/activity in the selected ROI.

StdDev Standard deviation is a measurement of the variability in at-
tenuation/activity in the selected ROI from voxel-to-voxel. The
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o

smaller this value, the more uniform the distribution of attenu-
ation/activity in the ROI.

Min Minimum attenuation/activity value of the voxels in the select-
ed ROI.

Max Maximum attenuation/activity value of the voxels in the se-
lected ROI.

ZRange Distance spanned by the axial sliders specified via slice num-
bers.

Quantification Table Options

Right-click on one or more entries in the Quantification table to view the following
options:

Max Sum Unit Conc Conc Unit ZRange

6193.732421875 W HIl  _10ANA4 207617672780 Hilimm? N AN_EN AN
P

lot data
6193.732421875 -3195549°
Data to Quanti Calc
6193.732421875 EERERRE L] Data to SpecAct Calc
Data to SUV Calc
O Submit SPECT_CT Registration-CTReco:s (bed removed)-ROI #2 to iPACS

¥ Remove line
W Clear table

Quantification Table Options
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Menu
Item

Plot da-
ta

Datato
Quanti
Calc

Datato
SpecAct
Calc

Datato
SUV
Calc

Submit
ROI #*
to iPACS

Remove
line

Clear
table

Plot data

Last updated: March 08, 2023

Description

Plots the selected data on a line graph.

Calculates the Quantification factor with the acquired data.

Calculates the specific activity with the acquired data.

Calculates the standarized uptake value with the acquired data.

Submits #* ROI (the selected ROI) to iPACS.

Deletes the entire row of the corresponding selected cell.

Deletes all information from the table, but not permanently. The

table can be reopened by right-clicking and the data for the corre-
sponding selection will reappear.

It is possible to plot the quantified data. This function is useful to look at changes in
activity, concentration, volume, etc., particularly in gated, dynamic, and longitudinal

studies.

To plot data from the quantification tool, select the column of interest (i.e., Sum,
Mean, etc.), right-click on any element in the column, and then select Plot Data.

The plotted data will open in a new window and may be saved into an output PDF
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file.

Profile Plot n
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Sum plot: SPECT_CT Registration
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Plot Data

Data to Quanti Calc

The calculator will automatically import the associated data.

QuantiCalc =

Dose meter 10.000 v| MBq =~ |7/29/2010 12:23PM &
NanoSPECT 1027.359 | kCounts [7/29/2010 12:23PM 5
Isotope In-111 ~ | Halflife | 67.37| h
Decay factor | 1.00| Aperture |APT1 =
Quantification factor | 0.000000| EWin  |245/15%; 171/15% |
+ Close
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Quantification Calculator

Data to SpectAct Calc

The calculator will automatically import the associated data.

|Specific Activity Calculator =
Activity 0.655 | MBq * [7/29/2010 12:23PM /|
Volume 5286.770 2 ' mme -
Isotope > Half-life | 6.01 h
Specific Adtivity  |1.000 + MBg/pmol = |7/22/2021 12:00 AM |

Calculated values:

Amount | 0/ pmol i
»| Amount of substance
Molarity L 0] pmol/ml ' concentration
Close

Specific Activity Calculator

Data to SUV Calc

The calculator will automatically import the associated data.

SUV Calculator =
Activity 0.6548 | mBq ~ | Patient Weight |0.0000 5 g 7|
Volume 5.2868 = mi ~ Injected dose |0.0000 = MBq -
Concentration [0.123856 2| MBg/ml  ~| suv ‘mg/ml 4

SUV Calculator
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Operator Menu

The Projection operator also provides several options for saving quantification and
ROl information, as well as viewing and cutting options, and miscellaneous ROI
functions. To access these options, click on the Operator section in the main menu.

File View Tools Advanced Modules Operator Help

=S @ W & © &= Bg 1111 DB C ® Save table Ctrl+S e
Operator # Append to table Ctrl+A
g Quantification Table List »

@MDdB Options % Clear table

o

O & = B Load ROI Ctrl+Shift+L
(O Threshold: Ref - % Save ROI Ctrl+Shift+S

O & 3 Submit to iPACS

ik

O % BullyRad: 12 px

View r
Help
Global: Rotate: Shift+Wheel, Scale: Alt+Wheel, Subi Cut outside ALL
Points: Drag: Left, Remove: Mid, Open curve: Shift+ Cut >

Curve: Drag: Shift+Left, Add point: Double Click, Ck

Bully: Add: start point inside curve, Remove: outside Select FOV

File Menu
Save table Saves the current Quantification table to a local file. Accepted
formats include .csy, .txt, and xls.
Append to Appends the current Quantification table to a previously
table saved table.

Quantification  Allows users to choose what fields to be displayed in the Quan-
table list tification table (page 156).

Clear table Clears the current Quantification table.

VivoQuant™ 2022 User Manual Page 162


http://www.vivoquant.com/
http://www.vivoquant.com/

Projection

Last updated: March 08, 2023

onten o

Load ROI

Save ROI

Submit to
iPACS

View

Cut outside
ALL

Cut

Select FOV

Copy table

Close

VivoQuant™ 2022 User Manual

Loads a previously saved ROI.
Saves the current ROl as a .roi file.

Submit the quantification data as a Data Point to the associat-
ed image on the iPACS.

Allows users to choose the ROl view direction (page 153).

Clears all voxels outside the ROl within the currently selected
slices, and all voxels outside the currently selected slices. Slices
outside the set axial range will be cleared entirely.

Clears all voxels inside/outside the ROl within the currently
selected slices, depending on which direction (inside/outside)
is selected. Slices outside the set axial range will not be affect-
ed.

- Apply ROl to all slices: Applies the ROl to every slice in the
image.

Creates a new ROl entry representing the field-of-view (the
entire volume of the image). The quantification table will be
populated with this entry, labelled as FOV.

Copies the data in the Quantification table to the clipboard.

Closes the Quantification panel and returns the VQ to the
Navigation screen.
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Reorientation / Registration Tool

The Reorientation/Registration Tool enables manual and automatic realignment of
image data via translation, rotation, or flipping. Reference and input data may be
manipulated separately, and specific translation settings may be saved and/or
loaded for future studies, including the option for setting automatically applied
default image shifts.

Getting There

The Reorientation/Registration Tool can be accessed via the tool pull-down menu
on VivoQuant’s front panel.

File View Tools Advanced Modules Help
eSS MEOE B0 8 » £ [E & W Slice View - |Navigation ~|
g Navigation ~
Display
Cropping
3D ROI Tool

Projection
Distance/Annotation

Time Series
Filtering

an_in111

Reorientation / Registration Tool

Using the Tool

Upon selecting the tool, the Reorientation/Registration operator window is
displayed.
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File View Tools Advanced Modules Operator Help
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=SS WE = 88 (000 Dg C] o o i :1:5_ @ E Slice View - Reorientation/Registration ~ a Quick Scripts ~
Operator s x  Display
~ ~
Selected: |0 » [Rc -
@ 0 o v
Interpolator: Linear ~ [] Quick Preview

{IManual [ Rigid [@ Deformable  £® Landmark

EC_Invicro_Mosel_Headscan_in111

® 3D O 20
Rotation
X axis Y axis Z axis

0.00° % 0.00° 3] 0.00° %

Translation
| [ | |
0.000 mm 3 0.000 mm (3] 0.000 mm '
Flips
[ ] Head / Feet [] Left/ Right [ ] Ant/ Post

Reorientation / Registration Window

The Data Selector Widget (page 0) is used to determine which inputs will be

reoriented by the Operator.

ROIs can be selected by checking the ROl checkbox. By default, all ROls will be
subject to reorientation when the ROl box is checked. If you wish to select only
specific ROIs, click on the pull-down menu and select the desired ROls. You may
also choose to simply view the ROIs while performing a reorientation, without
performing the reorientation on the ROls themselves, by selecting View Only from

the ROI pull-down menu.
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Reorientation / Registration Tool

Operator
Selected: ﬂ

w0

Interpolator: Linear

{) Manual ] Rigid

(® 3D

X axis
0.00°

0.000 mm
[ ] Head / Feet

Select ROls

M Re |01

» [ | Quick Preview
[B| Deformable

()2n

Rotation
Y axis
0.00°

Translation

0.000 mm
Flips
] Left/ Right

I
&)
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& X

Display

1 Ny
(=
( L] An ViewOnly
V[:| Layer #0
._ }-"‘-“‘-kf.-’.r.”f I !1;‘1_ ]
W ROI #1
[Im ROl #2
L] RrROI#3

Landmark

Z axis
0.00° &

0.000 mm

[ ] Ant/Post

The buttons at the top of the operator window perform various functions within

the operator.

o & B &

4]

VivoQuant™ 2022 User Manual

Force re-render of VTK Viewer

Reset VTK Viewer position

Toggle ability to perform reorientation in VTK Viewer

Resets current reorientation operation

Apply current reorientation operation
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The Interpolator drop down menu designates which interpolator will be used
during the transformation. The default interpolator value is Linear.

@ Tip: When manipulating atlases and other integer-only datasets, linear
interpolation may be detrimental. The Nearest-Neighbor (NNB) interpolator is
recommended in these cases to preserve integer values upon transformation.

The Quick Preview option enables VivoQuant to generate a low resolution
preview of an automatic registration. Users can apply by clicking Apply in the
Operator menu.

3D and 2D Manual Options

3D and 2D manual registration options are available in the first tab of the operator.
Images/ROls can be rotated up to 360 degrees around their X, Y and Z axis;
translated in any direction along their X, Y and Z axis; and scaled in any dimension.
The reorientation will be performed on all images/ROls selected at the top of the
operator window.

{)Manual [ Rigid [BlDeformable  £® Landmark
® 3D O 20
Rotation

X axis Y axis Z axis
0.00° 5] | 0.00° 3] | 0.00°

4k
ik

Translation
] [ | [ |

0.000 mm 0.000 mm = 0.000 mm =

Flips
[ ] Head / Feet [ ] Left / Right [ ] Ant/ Post

3D and 2D Manual Registration

¢ Rotationis completed by either using the up and down buttons next to the
box or by typing in the number of degrees you wish to rotate the image.
Once the desired positioning has been achieved, click ‘OK’ to apply the
transformation.

¢ Translation is achieved by scrolling the bar to the left or the right or typing
in the number of mm to be moved in the box below. Translation can also be
achieved by holding the “Ctl” button on the keyboard and dragging images
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in the Viewports.

e Flips can be performed about any of the three axes by selecting the check
box for Head/Foot, Left/Right, or Anterior/Posterior.

e Scaling can be enabled in the Operator menu. When enabled, images and
ROls can be scaled during reorientation by scrolling the bar to the left or
right or typing in the % by which to scale. To scale uniformly in all three
dimensions, check the “Uniform” box.

O Warning: When scaling data, please use caution, as scaling can lead to errors in
guantitation. For more information, refer to the Treatment of Quantitative Data

(page 0) page.

3D and 2D Automatic Options
3D and 2D automatic registration options can be found in the second tab of the

operator. There are Basic Settings (default) and Expert Settings available for each
type of automatic registration.
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Operator 8 x
Selected: | | = ROL | -
oy O o v

Interpolator: Nearest NB + [v] Quick Preview
{7 Manual = Rigid @ Deformable &® Landmark

3D (® 2D

Fixed: |0 i" Moving: -

Basic Settings
Transform i'ranslatim Rigid Affine

Quality Fast | Standard Fine

[ | Expert Settings

Metric Range None v v Register

3D and 2D Automatic Registration

The default options for registering data include Translation, Rigid and Affine. The
Translation registration is a rigid registration which will shift the input data set in
the (x)y,z) directions. The Rigid registration will rotate and translate the input data
set. The Affine registration is a linear transformation which will rotate, translate,
shear and scale the input data set.

The Expert Settings are intended for experienced users only and provide access to
avariety of transform, optimization, interpolation, and metric (figure-of-merit)
schemes. User-configurable fields are also provided for the number of sampling
bins, minimum and maximum step length, maximum number of iterations,
percentage of voxels to be used for registration, and a relaxation factor.

A crop range can also be defined which, when enabled, will perform the registration

optimization calculations based solely on the voxels within the crop range. This can
be useful when images have noise, regions of little to no signal, or other artifacts
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that may affect optimization calculations. For information about setting a crop
range, see Crop Range under Expert Settings (page 145) on the 3D ROI Tool page.

'Operator 5 x
Selected: | - ROI: -
il Y] o v

Interpolator: Nearest NB - Quick Preview
{)Manual [ Rigid [Bl Deformable  £® Landmark
3D (® 2D

Fixed: |0 | = Moving: | | =

|| Basic Settings
Transform ranslatio.  Rigid Affine

Quality Fast Standard  Fine

[v] Expert Settings

Transform Affine ~ | Optimizer Regular Step Gradient De: ~

Interpolation  Mearest NB = Metric Mattes Mutual Information ~

Sampling 20 %/ bins 16% $ samp

Steplength  0.100° | min 60.000° |+ max

lterations {100 7 Relax [0.75 S

Metric Range Crop Range - > Register
Expert Settings

To begin the registration, select the desired dataset and click Register. A window
will appear that shows information about the progress of the optimization.
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EOperator 8 x '
Iselected: [1 = RO |0 | =
| vtk i ) LI A O v

_D 0 CT: CT recon: s

Interpolator: Nearest NB =| [ 1
[rierpo | [+] 1. NM: NM Reco ... |

£ Manual HRigik Bl
O 3o @® 2D

Fixed: |0 | = Moving: |1 | =

[ ] Basic Settings

Transform ranslatiol | Rigid Affine
Quality Fast Standard Fine

Expert Settings

Transform Affine - Optimizer Regular Step Gradient De: ~
Interpolation  Nearest NB = | Metric Mattes Mutual Information ~
Sampling 20 2 bins 16% +| samp
Step length 6_130;—_3 min i_sﬁﬁd?—f max
lterations 100 = Relax [0.75 3]
Metric Range Crop Range - - Register
\l VivoQuant ? X
Registration of data at 1
| 7%

:Slice-by-Srice Registration took 11.1 sec

Begin Registration

Menu Options

The Reorientation/Registration operator menu can be used for storing
transformations, setting a default image transformation, and controlling the
behavior of the operator.
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File View Tools Advanced Modules Operator Help

=SS E D gg Clg C Load Transformation... Ctrl+Shift+L |/
| Save Transformation... Ctrl+Shift+S ||
Operator
| Save as default
‘Selected: v R Save Reg. Movie
| itk @ o) Reset Ctrl+R
[nterpolator: Nearest NB T Quick Pren Apply Gl betan
| H ]

{)Manual [ Rigid [B) Deformable Hips

Resample

@® 3D O 2D
Pre-compose

Rotation @ Post-compose
X axis Y axis

0.00° % | 0.00

Reorient ROl around Center
Enable Scaling

Translation

Operator Menu

Option Keyboard Description

Shortcut

Load Transfor- Ctrl+Shift+L  Applies a pre-defined transformation to the

mation... active data set.

Save Transfor- Ctrl+Shift+S  Saves the current transformation settings
mation... (rotation, translation, flips) into a .xml file.
Save as default Saves the current transformation settings

(rotation, translation, flips) as default set-
tings for image data. If the Apply Default
Shift checkbox is selected, these settings
will be automatically applied to any image
data that then gets loaded. See the How To
Guide for more on setting a default image
shift.

Reset Ctrl+R Resets all transformation settings (rotation,
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Keyboard

Shortcut
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Description

Apply

Flips

Resample

Pre-compose

Post-compose

Reorient ROI
around center

Enable scaling

Ctrl+Return

translation, flips) back to the default values.

Applies the current transformation settings
(rotation, translation, flips) to the active da-
taset.

Provides the option of flipping the datain
any of three directions, described as Head/
Feet, Left/Right, and Anterior/Posterior.

Directs the user to the Resample Data tool.
The Resample Data tool allows rebinning of
reconstructed data into an arbitrary voxel
size.

Transformation which applies T1 to the
source, and then applies T2 to that result to
obtain the target.

Transformation which applies T2 to the
source, and then applies T1 to that result to
obtain the target.

Sets reference point for transformation as
center of ROl instead of center of image.

Toggles appearance of Scaling under 3D and
2D manual registration panels.

Automatic Non-Linear Registration

The 3D Automatic Non-Linear Registration tool provides deformable registration
of the data by computing a unique transformation matrix for all voxels of data
represented. After selecting your preference from the dropdown, the number of
iterations for each resolution level can be adjusted. Drop-down preferences

VivoQuant™ 2022 User Manual
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include: Fast Symmetrical Demons, Symmetric Demons, Diffeomorphic Demons,
and Demons. To show the deformed grid overlaid or a heatmap of the Deformable
vector field over of the image, use the toggle buttons.

To learn more about the Non-Linear Registration techniques please visit the link
below:

e http://www.insight-journal.org/browse/publication/154

!épemtor o x|

 Selected: - [RC - 2
w 8 O O v
Interpolator: Nearest NB » [v] Quick Preview
OManval  HRigk Bl Deformable  £® Landmark
3D O 20
Automatic Non-linear Registration E .
Fixed: 0 *  Moving: -
Fast Symmetric Demons -
Select number of iterations for
each resolution level.
Low 10 S Med 10 < Fine 10 <
Field Smooth: 1.00vox +
Max Step Size: 0.50vox '~
Register

Non-Linear Registration
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Automatic Slice-by-Slice Non-Linear Registration

The 2D Automatic Slice-by-Slice Non-Linear Registration tool provides
deformable registration of the data by computing individual transformation
matrices for each voxel of data represented. After selecting your preference from
the dropdown, the number of iterations for each resolution level can be adjusted.

To learn more about the Non-Linear Registration techniques please visit the link
below:

e http://www.insight-journal.org/browse/publication/154

Operator & x
Selected: | - RO | |- 2
o O O ¢
Interpolator: Nearest NB - Quick Preview

{)Manual [ Rigid Deformable  5® Landmark

3D O 2D
Automatic Non-linear Registration E =
Fixed: [0 | Moving: | =

Fast Symmetric Demons -

Fast Symmetric Demons

Symmetric Demons ons for
Diffeomorphic Demons
Demons
—|Log Demons -
Low 10 Symmetric Log Demons |10 =
Field Smooth: :1.DD VOX $:
Max Step Size: [0.50 vox 3]
Register
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Slice-by-Slice Non-Linear Registration

How to Set a Default Image Shift

One of the most powerful features of the NanoSPECT is its ability to automatically
register SPECT and CT data to create anatomically and functionally valuable fused
images. Imaging without the application of any transformation typically results in
data that are fused well within 1.5mm in any direction. However, taking the time to
set up a default image shift can help insure that all image acquisitions are perfectly
fused.

Make a simple phantom, but one that breaks symmetry along multiple directions. A
syringe with an air bubble, placed in the bed at an angle works well.

Collect an image/CT of the phantom. It is recommended that standard
reconstructions (or better) are used for both the image and the CT to enable more
precise transformation settings.

1. Uncheck the Apply Default Shift box located in the DICOM browser.

Data
Show data type:
All data tvoes Y
@ B -
] Apply default shift

Auto-Start reconstructi
|| Force pl [_] Stack 3D
»» Apbent #» Open

Transfer

@ Close @ Stoo

Open Data

2. Load the datainto VivoQuant.
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Display

Load Data

3. Use the reorientation tool to shift and/or rotate the image data set (Input
1) so that the image and CT data are perfectly aligned. Typically, only shifts
are needed for this operation. If rotations are needed, they should be only
plus/minus 1 degree. Before clicking Apply, go to Operator > Save As
Default and save the transformation

VivoQuant™ 2022 User Manual Page 177


http://127.0.0.1:4012/vqmanual/images/operators_reorientation_loaddata.jpg
http://127.0.0.1:4012/vqmanual/images/operators_reorientation_loaddata.jpg

Reorientation / Registration Tool Last updated: March 08, 2023

File View Tools Advanced Modules Operator Help

= @ @ m & B3 = BE m 08 C Load Transformation... Ctrl+Shift+L ! Reorientation/Registration a Quick Scripts ~ '\c u -
Save Transformation... Ctrl+Shift+S |
Operator play
I Save as default
Selected: - - Save f .
Rl LY Reset Ctrl+R
i Appl |
Interpolator: Nearest NB - Quick Pre\ BRY Ctrl+Return
Flips »

O Manual  HRigid B Deformable
. Resample

Automatic Non-linear Regit Post-compose
Reorient ROI around Center
Enable Scaling

Fixed: |0 \J Movir

Symmetric Demons <
Select number of iterations for
each resolution level.

S

Low 10 & Med 10 5 Fine [10
Field Smooth: |1.00 vox

LOREDT

Register

Save as Default

4. Returntothe Data Browser or go to the Tools Menu and re-check the
Apply Default Shift box.
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'\ Configuration ? X

Display = Data  DICOM  Network  VivoScript 4i?|

Data Loading

[ ] Disable MIP viewer  Grow reference to input vc ' no -

Ask Disable MIP Max voxsize ratio for vol  [2.50 =
MinVoxSize [0.00mm #| Anchor input data at center ~

| Quantification Options
| Unit of Activity | MBq = CSV Separator :Eomma {.) Z

Data Manager
Confirm moving [ ] show seconds in Browser
Apply default shift [] collapse Dynamic Data

| Contin Datal ist Tnto

Processing
[ ]ITKMaxThreads 8 = [ ] VTIKMaxThreads 8 =

(] 17K Priority

OK | e

Apply Default Shift

5. Reload the image/CT phantom data that were just acquired. They - and all
other data sets - will now be perfectly fused.
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Display

Reload Data

O Note: This same formalism may be used to generate other Transformation files.
Instead of choosing Save as Default in the operator menu, choose Save
Transformation. Then, it is possible to later load that transformation (using the
Load Transformation option in the operator menu). These saved transformations

are useful when fusing data from other modalities with NanoSPECT CT data, for
example.
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Time Series

The Time Series operator provides an easy way to visualize sets of dynamic data as
atime series. This operator can be used to play slice views of each image of a
collection in sequence.

Getting There

The Time Series operator can be accessed via the tool pull-down menu on
VivoQuant'’s front panel.

File View Tools Advanced Modules Help
=sCSMEOE BmMEOE & > X X & wuSice View -|[Navigation -]
Reorientation/Registration

Display Cropping

3D ROI Tool
Projection
Distance/Annotation

Checker Board

Time Series Operator

Using the Tool

Data must be loaded into VivoQuant in the correct time-order, with the reference
image (if any) loaded first. Use the Data Manager to sort the datasets as necessary.

If there is a reference image loaded, check Lock Ref to keep the reference image

visible with all other images of the series. Check Lock Inp1 to keep the image in the
Input 1 position visible with all other images of the series.
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Operator & X

Sliders

4k

L 0
All

(] 8 Ref & Inp1 1 MIP

[] Global  Mi Max 0360 56

D Play

Lock Image

The Time Series operator also enables users to set a global windowing, which will
apply to all loaded images. The windowing format (either Min/Max or Level/Width)

is determined by the Display Configuration (page 16). To set it, simply check the
Global box and enter appropriate windowing values into the respective boxes.

Use the slider or image index field to manually scroll through the datasets of the
series. Click Play to run the sequence in a loop.

Saving a Movie

To save a Time Series movie, open the Save Movie dialog with the Time Series
operator. This can be done by clicking the Save Movie icon in the toolbar ; by
navigating to File > Save Movie, or by the keyboard shortcut Ctrl + M.

The options for the output movie are similar to those in the regular Save Movie
(page 220) dialog box. The only difference is that the options in the Movie Type
drop-down box reflect the Time Series movie types. Once the desired options are
set, click Save to save the movie file.
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\&l Save Movie ? p 4
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Files of type: Movie files (*.gif *.mng *.mpg* = Cancel

Movie type: [Time Series: MIP -
Time Series: MIP

Colorbar options | Time Series: Sagittal slice
| Time Series: Coronal slice

Storage Type | Time Series: Transversal slice

Time Series: All slices

Save Movie
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Distance / Annotation Tool

The Distance/Annotation tool enables you to measure the distance between two
points in any image. For example, it can be used to measure the size of a tumor by
measuring its length, depth and width. One of the most powerful options available
with the distance measure is the capability to perform landmark co-registration.

(page 187)

Getting There

The Distance/Annotation tool can be accessed via the tool pull-down menu on
VivoQuant'’s front panel.

File View Tools Advanced Modules Operator Help

=M Eg®OE S8mSO8 es > X [ &} v Slice View - [Distance/Annotation = R E:
Navigation ~
Operator s x  Display Reorientation/Registration
Cropping
+ Point ~ | ® green - &N - [ 30 RO Tool

| 2 & ) (8 vtk examine " Distance/Annotation

Input Label Type Hide
P B Time Series

Filtering

Distance / Annotation Tool

Using the tool

Upon selecting the tool, theDistance/Annotation operator is displayed. The
physical distance between two points can be measured by clicking on the Add New

icon — to add an object. To measure distance, left-click on two points of the image.
A line is displayed between the two points to show what is being measured.

In the Distance/Annotation operator, each line is identified by a unique color tag.
For each line, the 3D start and end points of the line are displayed as well as the
length of the line (in mm). Multiple distances can be measured on the same image
and are easily distinguished by their unique color. The results can be saved into an
Excel file by clicking Save. The Profile (page 186) function enables a graphic plot of
the distance to be displayed for both the reference and the input data.
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Operator 5 x|
+ Line ~ M green v
& ke &0 X vk examine
Input Label Type Hide
1 B %d mm 35.9 mm Line

Add Object

Goto with-in the object

Since a single left click sets a new point, you have to use a single middle mouse
button click to go to the given position in the two respective other slices.

Removing Distance Measures

Right-click on any of the distance measures and click Remove to delete the
distance measure completely.
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Flip points
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" Link label
Type L4
Color L
I Remove I
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Profile

The Profile tool plots the values in each voxel through which the line passes. Values
are displayed for both Reference and Input data sets and, given proper calibration,
the plot values will be in Houndsfield units and MBq for CT and NM data sets,
respectively. The File menu provides an option to save the Profile data as a PDF.
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Landmark-based Co-Registration

One of the most powerful features of the Distance/Annotation tool is the built-in
capability of performing landmark-based co-registration. With two data sets
loaded, use the Distance/Annotation tool to draw at least one line that connects
corresponding locations (i.e., locations which should be registered) between the
reference and input data sets. The line should start on the reference image and be
dragged to the input image. For example, if using a CT image as a reference and a
SPECT image as input 1, left click on the CT, drag to the corresponding location
in the SPECT image, and left click again to end the line. It may be useful to use the
arrow line type to make clear the direction the input image will be reoriented. The
user should perform landmark-based co-registration on one view at a time to
optimize registration results.
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Landmark-based Co-Registration

Click on the Landmark-based Co-registration icon =— to perform the registration.
Once registration is complete, the shifted input data set will appear in the Main
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Window as input 2.

Input 2
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Checker Board

In Checker Board mode, the reference and input data sets are arrayed in a pattern
of alternating squares. This mode is especially useful when checking image
registration.

Getting There

The Checker Board tool can be accessed via the tool pull-down menu on
VivoQuant'’s front panel.

File View Tools Advanced Modules Help

=sSSM B O 88 (000 08 D g 2 L E& E Slice View - |Checker Board -
. Reorientation/Registration
Display Cropping

3D ROI Tool
Projection
Distance/Annotation
Modeling
Arithmetics

R - update dsabled

Time Series
Filtering
Checker Board

Checker Board Tool

Using the tool

Upon selecting the Checker Board tool, the display of the coronal, sagittal, and
transverse windows is automatically updated. In these windows, the reference and
input data sets are displayed in an alternating grid pattern. Both the Input 1 and
Input 2 data sets are displayed in the same squares of the checkerboard. To return
to normal viewing, select Navigation (page 73) in the Tools menu. To adjust the size
of the tiles, hold Shift and use the mouse wheel.
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Cropping Tool

The Cropping Tool allows images to be made smaller by removing any unwanted
areas. For example, if an image has been cut, then the cropping function can be
used to trim away the blank areas of the image.

Getting There

The Cropping tool can be accessed via the tool pull-down menu on VivoQuant’s
front panel.

File View Tools Advanced Modules Help
=SS MEL O M S0E e 2 © @ e X [ &} s Slice View - [Checker Board ¥

' Reorient...stration A
Display
3D ROI Tool
Projection
Distance...notation
Modeling
Arithmetics

Time Series

Filtering
Checker Board e

Cropping Tool

Using the tool

Upon selecting the Cropping tool, the standard view options disappear and red
sliders are displayed in their place.

File View Tools Advanced Modules Help

=CeMaE®E. BSOSO O B e £ (] {} W Slice View ~|Cropping - R lauickserpts -]\, O @
Operator 8 x  Display
Cropped Area
X Y z
From [o 23 2] (a8 2
To [175 2| 126 2] [103 2
Embed  [176 <] 176 2] [152 g
Information
Voxel mm
Old size 176x176x152 35.2x35.2x30.4
New size 176x61x56 35.2x12.2x11.2
Auto crop
0 - » Set
O v
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Cropping Sliders

Two red sliders appear for each view direction (i.e., coronal, sagittal, and
transversal). The red sliders may be moved using the mouse (click and hold on a
slider and then move the mouse to move the slider) or by using the arrow keys in
the cropping dialog. Manipulation of the red sliders creates a three-dimensional
rectangular cropping volume. The current voxel position of the red sliders is
displayed in the Cropped Area section of the operator window.

To apply the crop, once the red sliders are in the desired positions, click the Crop

button )

To reset the crop range sliders to their original positions, click the Refresh button

o)

The Cropping dialog provides information about the pixel location of each red
slider (x,, z), and current and cropped image size information in both voxels and
mm. The embed function will pad background slices to increase the dimensions of
the image. The auto-crop feature starts its search the end slices of the image and
adjusts the sliders towards the center of the image until a non-background voxel is
detected from all 6 faces.

VivoQuant™ 2022 User Manual Page 193



Cropping Tool Last updated: March 08, 2023

Image before cropping Image after cropping
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Arithmetics

The Arithmetics operator can be used to add, subtract, multiply, divide, average or
merge multiple images. Additionally, a scalar multiplier or addend can be applied to
all voxels of an image with the Arithmetic operator.

Getting There

The Arithmetics operator can be accessed via the tool pull-down menu on
VivoQuant'’s front panel.

File View Tools Advanced Modules Help

=SS M 6 ® e SBMO0F s 2 O @ e 2 [E) &} s Slice View ~[Navigation -
. Navigation A
Display Reorient... stration
Cropping
3D ROI Tool
Projection
Distance...notation
Modeling

Arithmetics
Time Series
Filtering

Arithmetics Tool

Using the tool

Upon selecting the operator, the Arithmetics window is displayed.
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|| Append Data

oK Cancel

Arithmetics Tool Window

The main drop-down menu in the operator window contains a selection of the
available operators:

e Add, Subtract, Multiply, Divide, and Average: each of these operates on
two images selected via the Data Selector Widget (page 0). These

operations are performed voxel-wise.

e Scalar Multiply and Scalar Add: can be applied to any of the loaded images,

selected via the Data Selector Widget (page 0). Set the factor or addend by
increasing or decreasing the scalar value.

e Merge whole integer value phantoms to load into the 3D ROI tool. It can be
applied to any of the loaded images, selected via the Data Selector Widget
(page 0). This is very useful for fixed-volume ROl analysis.
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Merge

Click OK to perform the chosen operation. A dialog will appear to indicate
successful application of the chosen function.

& Arithmetics X
Q. Applied Merge.
QK
Operation Applied

For all arithmetic operations, the user has the option to append the resulting
volume(s) or perform the function in-place, thus replacing the existing data with
the amended data.
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Data List

Units are considered by the Arithmetics operator. A warning will be displayed if an
attempt is made to add, subtract, multiply, divide or average two images of differing
units and will allow the user to halt the operation.

& Arithmetics X

Units for Vol 1 (HU) and Vol 2 (kBq) differ. Do you
L* want to continue ?

Yes Mo

Arithmetic Units
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Filtering Tool

The Filtering tool offers a variety of smoothing filters with configurable input
parameters and can be applied to any of the loaded images.

Getting There

The Filtering tool can be accessed via the tool pull-down menu on VivoQuant’s
front panel.

File View Tools Advanced Modules Help
=SS M B e BB E s @ O B e £ (&) &} wp Slice View - [Navigation -
Reorient...stration A

Display Cropping
3D ROI Tool

R -Update clagBiee Projection
% Distance...notation
e 4 Modeling
- Arithmetics
‘ | Time Series
GC_vicrseMBtse 1 HeatScan Checker Board M
Filtering Tool
Using the Tool

Upon selecting the tool, the Filtering operator window is displayed.
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Bilateral Smoothing

Bias Field Correction

Adaptive Non-Local Means o

Filtering Tool Window

Using this tool, any loaded data can be selected for smoothing via the Data Selector

Widget (page Q).

Select the desired smoothing algorithm from the available options in the
Smoothing drop-down menu. Use the parameter fields to set appropriate values.
The effect of the chosen smoothing filter will be previewed in 2D in the slice views.
To remove the 2D preview, go back to None in the drop-down menu of smoothing
filters.

Currently available filters include:

e Gaussian Smoothing

e Curvature Flow

e Gradient Anisotropic Diffusion

e Curvature Anisotropic Diffusion

e Positivity Smoothing (to remove negativity from FBP reconstructions)
e Zero Crossing Edge Detection

e Bilateral Smoothing

e Bias Field Correction (page 204)
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Each filter uses a different subset of the configurable parameters. See the table
below if parameters other than the default settings are desired.

Parameter Description Used by

FWHM Full-width half-maximum Gauss, Zero Crossing 1.00mm
kernel size Edge Detection

Conductance Parameter governingsen-  Gradient Anisotropic 1
sitivity to edge contrast Diffusion, Curvature
Anisotropic Diffusion

Iter Number of iterations Curvature Flow, Gradi- 5
ent Anisotropic Diffu-
sion, Curvature
Anisotropic Diffusion,
Positivity Smoothing

CutOffFrac If the fraction of voxels Positivity Smoothing 0.005
that are negative falls be-
low this value, further iter-
ations of the filter will not
be performed.

Time Step Stepsize, effectively analo-  Curvature Flow, Gradi- 0.125
gous to kernel width ent Anisotropic Diffu-
sion, Curvature
Anisotropic Diffusion

Max Error Difference between the Zero Crossing Edge 0.5
area under the discrete Detection
Gaussian curve and the
area under the continuous
Gaussian

Range Sigma The standard deviationof  Bilateral Smoothing 50
the gaussian blurring ker-
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Parameter Description Default

Value

nel in the image range.
Units are intensity.

Domain Sig- Thestandard deviationof  Bilateral Smoothing 4
ma the gaussian blurring ker-

nel in each dimensional di-

rection. Units match image

spacing units.

The smoothing function is executed by left-clicking on OK. Depending on the image
size and filter selected, this may take several seconds. Once the smoothing function
is applied, any subsequent operations will be based on the smoothed images.

Each filter will have different edge-preserving and noise-reduction properties.
Choose the one that best suits your application.
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No Smoothing Curvature Flow Gradien
D

The bilateral smoothing filter could take several minutes for large images in 3D,
especially for greater values of domain sigma. Check the Force 2D option to speed
up this filter.
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No Filtering Applied Various Bilateral Smoothing Parameters

range sigma =1 range sigma =4

domain sigma = 50

domain sigma = 90

The positivity smoothing filter will also typically take longer to run than the other
smoothing filters, up to several minutes for larger images. This filter was specially
designed to redistribute the activity across neighboring voxels such that the total
sum of the image is preserved but the number of voxels with negative values is
reduced. It is intended to be used to correct images reconstructed with FBP.

Bias Field Correction

Intensity gradient artifacts in magnetic resonance imaging can often cause
difficulties with automated segmentation and analysis tools that rely on intensity
contrasts, not to mention the detriment to qualitative appearance. The Bias Field
Correction filter implements the N3 bias correction algorithm (Tustison 2010) to
estimate the gradient field present in the image and uses this filter to normalize
each voxel of the image. Due to the higher performance cost, a preview of its
filtering is not available but the filtering can be applied via the filtering operator.
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The user may optionally adjust the field smoothness to avoid or allow high spatial
frequency corrections and also append the estimated bias field as an image to the

data manager.

Before

Bias Field Correction
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Modeling

The Modeling operator provides an integrated solution for representing the loaded
data set with one of the following relevant mathematical models to allow for
predictions and analysis.

Getting There

The Modeling operator can be accessed via the tool pull-down menu on
VivoQuant'’s front panel.

File View Tools Advanced Modules Help

=SS M & D& BVBMSO T es » £ [E & su Slice View ~|Navigation -
. Navigation A
Display Reorientat...gistration

Cropping

3D ROI Tool
Projection
Distance/Annotation

Arithmetics
Time Series
Filtering

= _1vcro_Mouse |_HeadSoon

Modeling Tool

Function

Upon selecting the tool, the Modeling operator window is displayed.
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Modeling

Operator

Saved Curves:

Param (Unit) Fit?

A0 ™

B1 (min)

B2 (min)
@ ROIs

Last updated: March 08, 2023

R B R @

Rise/Fall Exponential ~

Time Points (table rows): |0 3]
Concentration Unit: 9%ID/g =
Value Lower Bnd Upper Bnd
0.2 | [o | [inf
0.1 o | linf
1 o | linf

& Save Interp & Save Fit + Run

Use Time (min) Signal

To add Blood/Plasma/Reference data:
* Increase rows above and manually enter or

Modeling Tool Window

* Copy/paste from spreadsheet

Appropriate data should be loaded into VivoQuant in the correct order, with the
reference image (if any) loaded first. Use the Data Manager (page 282) to sort the

datasets as necessary.

From within the Modeling operator drop-down, you can select the specific
mathematical model applicable to your analysis. Once chosen, the operator
window will fill with the model’s parameters and settings.

O Note: Access to models depends on your specific VivoQuant license. For
information regarding your license, please contact your account manager or email

support@invicro.com.
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Models

MR Models

MR models are included with every VivoQuant license. These models include T2,
T1, ADC, Fat and GLM.

Pharmacokinetic Models

Pharmacokinetic models are available as a plug-in for the Modeling operator.
These models include the Two-Tissue Compartment Model (2TCM), One-Tissue
Compartment Model (1TCM), Logan Graphical Method, Simplified Reference
Tissue Model 1 & 2 (SRTM/SRTM2), Logan Non-Invasive Graphical Method, and
Patlak Analysis. Detailed information for these models may be found on the

Pharmacokinetic Modeling (page 351) page.

O Note: Access to models depends on your specific VivoQuant license. For
information regarding your license, please contact your account manager or email
support@invicro.com.
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Main Window

VivoQuant’s Main Window contains the primary display and is the focal point for
reaching all other functions.

@ - D X
File View Tools Advanced Modules Help

sSamMgeE. S8me80 & @ » £ (K] § waSlice View - Navigation - 12 lquickseripts -1 % O @

Display

DEMO

Display

Menus

There are five menus across the top of the Main Window:

N

File Used for file manipulation and includes options for opening, saving,
printing, and publishing files.

View Used to control the display of data already loaded into the VQ. En-
tire data sets may be toggled as may a variety of display options, in-
cluding layout and zoom.
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N

Tools Provides access to several VQ image processing tools, including da-
ta control, reconstruction, calibration, and configuration features.

Advanced Provides access to more advanced VQ image processing tools, in-
Modules  cluding data control, reconstruction, calibration, and configuration
features.

Help Help content, including licensing information and the manual, are
available in this menu.

Docks

The View Control (page 265), MIP Control (page 270), Data Manager (page 282),
and Operators are automatically placed into Docks (page 223) upon opening.

Docks may be dragged and dropped into and out of the Main Window display, and
multiple controllers/operators are dockable at any given time.

Thumbnails

The thumbnail icons described below provide fast access to different features:

Thumbnail | Function

Icon

Opens the Data Browser

Opens a browser that will unload currently loaded data and re-
place it with the data selected in the browser.

@ Opens a browser that will append data to currently loaded data.

Opens the Save Image window.
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Thumbnail | Function

Icon

Opens the Save Movie window.

[E

Changes the display layout to a 2 x 2 grid layout.

Changes the display layout toa 1 x 1 grid layout.

El

Changes the display layout to show the sagittal, coronal, and
transverse data slices but not the MIP.

Changes the display layout to show only the transverse data slices.

Changes the display layout to show only the MIP.

<« O

Resets the zoom and pan within each viewport in the display.

Zooms in 25%.

e G

Zooms out 25%.

[@

Auto-zooms to fit data to screen.

i

Opens RGB color options.

Opens the Viewer Control panel.

TENH

Opens the MIP Control panel.
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Thumbnail | Function

Icon

1 Opens the Data Manager panel.

Opens the Min Max Tool panel.

&

Opens the VivoScript Evaluation window.

(5]

Edits the VivoScript file selected in the Quick Scripts menu.

]

Evaluates the VivoScript file selected in the Quick Scripts menu.

[+]

Aborts the VivoScript in execution.

@]

Activates the Peek tool, used to reveal names of operator widgets
for use in VivoScripts. See the VivoScript page for more.

]

View Modes

There are three viewing modes available via the pull-down menu located next to
the thumbnail icons.

File View Tools Advanced Modules Help

=geMaos BEmaE0) & ey ~ & W& i [Mutiiview -|Layout Z I lauickseripts -1 % O @
Slice View
Display Tile View
| - - Multi View

Viewing Modes
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Function

Slice The Slice View (default) simultaneously displays images of single
View slices for the MIP, sagittal, coronal, and transversal views of the
(page loaded data sets.

226

Tile View The Tile View displays an array of slices for either, sagittal, coronal,
(page or transversal view of the loaded data sets.

The Multi View displays sagittal, coronal, or transversal slices of
View each data set adjacent to one another simultaneously.

Operators

The operators are accessible via the pull-down menu located next to the thumbnail
icons.

File View Tools Advanced Modules Help
=SS o oS BmEOeese © » L ® & e siceView -[Navigation ) R

Display | Recrientation/Registration
r Cropping
3D ROI Tool
Projection
Distance/Annotation

Time Series
Filtering

Operators
Navigation Enables manually scrolling through the image slices and rota-
(page 73) tion of the Maximum intensity Projection (MIP).
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3D ROI Tool Provides advanced tools for drawing, visualizing, saving, and
(page 78) quantifying both 2- and 3-dimensional regions.

Projection Provides a mean to quantify density and activity parameters in
(page 152) CT and NM scans, respectively.

Reorientation/ Enables realignment of image data via translation, rotation, or

Registration flipping. In registration mode, a variety of registration algo-

(page 164) rithms are available to automatically register data from a wide
variety of modalities.

Time Series Allows sagittal, coronal, and transverse slices of datasets from
(page 181) atime series to be played sequentially in a loop or easily

scrolled through manually.

Distance/An- Allows you to measure the distance between two points in any
notation (page image.

184)

Checkerboard Incheckerboard mode, the reference and input data set(s) are

(page 184) arrayed in a pattern of alternating squares, resembling a
checkerboard.

Cropping Allows images to be made smaller by removing any unwanted

(page 192) areas.

Arithmetics Allows voxel-wise arimethic operations on two input images,
(page 195) or scalar operations on any number of input images.

Filtering (page Uses a selection of built-in smoothing filters with configurable
199) parameters.

Modeling Provides an integrated solution for representing the loaded
(page 206) data set with one of several mathematical models to allow for

predictions and analysis.
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Display

The Display field is the main component of the Main Window. The first three
images loaded in the Data Manager are visible in the Display field. Many tools and
image-processing steps are visible in the data sets shown in the Display field.

Projections vs. Reconstructions

The Display window recognizes whether a loaded data set is projection data or
reconstructed data. The default viewing scheme, known as Slice View (page 226),
for reconstructed data includes an MIP (page 0) and three separate viewing
directions (sagittal, coronal, and transversal). When viewing projection data or
sinograms (sets of CT projection data), VivoQuant displays the data accordingly.
For example, transverse slices of projection data are displayed with a P in the top-
left corner.

Display
r.

Projections vs. Reconstructions

For CT data, selecting the correct layout will display the relevant sinogram data.
For the corresponding windows, the data are labeled as sinogr ., denoting
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“sinogram”.

Display

Sinogram

O Note: It is not possible to view projection (non-volumetric) and reconstruction
(volumetric) data simultaneously. Attempting to append reconstruction data to
projection data, or vice versa, will result in an error message.
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Save Image Data

This function saves images as picture files. Slices can be saved individually (sagittal,
coronal or transversal) or all in one image. This feature can also save a Maximum
intensity Projection (MIP) (page 0) picture (MIP viewer must be active). Images will
appear exactly as they do in the viewer.

Getting There

There are three different methods for saving images. The first method is to go to
File > Save Image.

File View Tools Advanced Modules Help

= Data Browser Ctrl+D moe0]) & e
B Open Local Data L
0 Connect to iPACS

Save Image Ctrl+1
Save Movie Ctrl+M

Save Data r

Session r
VivoScript Ctrl+Shift+V

Exit

© mE EI

File Menu

The second method is to use the keyboard shortcut Ct rl+I. For more information

on keyboard shortcuts, please see Keyboard Shortcuts (page 315).

The third method is to click on the Save Image button .

Function

Upon selecting any of the above options, the Save Image window opens.
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Save Image Data

\& Save Image
Look in: 2 C:\Users\luana
- My Computer I Name e mSize
& luana B Desktop
& Documents
¥ Downloads
¢ Favorites
InviCroAPI
# Links
Jﬁ Music
<
File name: [
Files of type: Image files (*.png *.jpg *.bmp *.gif *_tif)
Image type: Maximum intensity projection

Colorbar options  none

Storage Type Local image file

Last updated: March 08, 2023

00 0AEBEE

Type
File...
File.
File...
File...
File...
File...
File...

Date Modi ™

Ider 7/27/2...1

der 8/5/20...:

Ider 8/6/20...
Ider 5/11/2...:
Ider 6/17/2...:
Ider 5/11/2...:
Ider 5/11/2...:

07
3C

:0C

54

1e

Magnification | 1

Save Image Window

There are several options for the output images.

File name

Files of type
-.png
-.jpeg
-bmp
- .gif
- tif

Image type

Sets the name of the image file.

- Maximum intensity projection (MIP)

- Sagittal slice

- Coronal slice

- Transversal slice

- All views in one image
- All images separately

VivoQuant™ 2022 User Manual
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Colorbarop-  Sets the colorbar and label options for the image. Options in-
tions clude:
- None - no colorbars or labels
- No labels - colorbars with no labels
- Simple labels - colorbars with one set of evenly distributed
gradations placed across all color bars.
- Smart labels - colorbars with separate sets of gradations for
each color bar incremented with respect to the units of each
color bar.

Storagetype  Sets whether the image file will be stored as a local image file or
as a DICOM Secondary Capture (page 238).

Magnification Sets a scalar magnification factor to be applied to the resulting
image. This affects only the magnification of the image file be-
ing generated.
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Save Movie

This function enables saves images as movie files. The slices can be saved
individually (sagittal, coronal or transversal) or all in one movie. This feature can
also be save a Maximum intensity Projection (MIP) (page O) picture.

Getting There

There are three different methods for saving movies. The first method is to go to
Save Movie under the File menu.

File View Tools Advanced Modules Help

o
Data Browser Ctrl+D 0 o8 O
Open Local Data * |
Connect to iPACS

B ODE ®

Save Image Ctrl+1
Save Movie Ctrl+M

Save Data r

Session r

VivoScript Ctrl+Shift+V

@ @WE K

Exit

File Menu

The second method is to use the keyboard shortcut Ct rL+M. For more information

on keyboard shortcuts, please see Keyboard Shortcuts (page 315).
i

The third method to save image slices is to click on the Save Movie button

the Main Window (page 209).

n

Function

Upon selecting any of the above options, the Save Movie window opens.
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|\ Save Movie ? »

Look in: C:\Users\juana\...\vivoQuantioeMo ~+ O © © @& () ()
L] My Computer Name B Size Type .

& luana Customer Sessions File Fa

< >
File name: [ Save
Files of type: Movie files (*.gif *.mpg *.mpeg *.mp4) - Cancel
Movie type: 3D ROI Rendering -
Colorbar options none -

Storage Type DICOM Secondary Capture at

Save Movie Window

There are several options for the output movies.

File Sets the name of the movie file.
name

Files of Sets the type of the movie file. File types can be:
type - .gif

-.mpg

-.mpeg

-.mp4

Movie Sets the type of Movie. Movie types can be:
type - Maximum intensity projection (MIP)

- Sagittal slice

- Coronal slice
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Colorbar
options

Storage
type

- Transversal slice
- All movies separately

Sets the colorbar and label options for the movie. Options include:
- None - no colorbars or labels

- No labels - colorbars with no labels

- Simple labels - colorbars with one set of evenly distributed grada-
tions placed across all color bars.

- Smart labels - colorbars with separate sets of gradations for each
color bar incremented with respect to the units of each color bar.

Sets whether the movie file will be stored as a local movie fileor as a

DICOM via Secondary Capture (page 238).
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Docks

The Viewer Control, MIP Control, Data Manager, and all Operators are
automatically placed into docks upon opening. Docks may be dragged and dropped
into and out of the Main Window display and multiple Controllers are dockable at
any given time.

Operator 8 x DM & x
Selected: | | = ROL | = ~ Data List
Loaded: 2 Memory: 1743MB % % ©O
Ll Ly O v
A . Available Dat:
Interpolator: Nearest NB - [] Quick Preview R e
. Type: PT
) Manual H Rigid Deformable &® Landmark Name: A1_G1_HO1 [A1_G1_H01]
Date: 2017-02-23 17:09:54 (series 2017-02-27 17:07:44)
e Desc: Average (Selected)
@ 3D O 20 Dim : -.evaxms«sn: Vox: 2.00x2.00 mm
Rotation i
X axis Y axis Z axis fype= T
o Name: SPECT_CT Registration [1001]
0.00° : 0.00° : 0.00° ; Date: 2010-05-19 18:33:33 (series 2010-05-19 20:58:45)
z - 1L z Desc: CTReco:s (bed removed)
Tl'anslation Dim : 169x169x80 (176x176x252); Vox: 2.00x2.00 mm (0.20x0.20x0.20)
B B o ErT—— 7e+03
0.000 mm %/ 0.000 mm %] | 0.000 mm [/
Flips
[[] Head / Feet [] Left/ Right ] Ant/ Post
v
Docks

Using Docks

Any controller or operator displayed in a dock may be popped out into its own
window by dragging and dropping. Similarly, any controller or operator can be re-
docked by dragging it back into a docking area (the left, right, or bottom area of the
main window).
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DM & x
Data List
Loaded: 2 Memory: 17.43MB % % O

Available Data

Type: PT
Name: Al1_G1_HO1 [A1_G1_HO1]
Date: 2017-02-23 17:09:54 (series 2017-02-27 17:07:44)
Desc: Average (Selected)
Dim = 169x169080; Viox: 2.002.00 mm

[ 1|

Type: CT -
Hame: SPECT_CT Registration [1001]
Date: 2010-05-19 18:33:33 (series 2010-05-19 20:58:45)
Desc: CTReco:s (bed removed)
Diem = 16916980 (1761 76:252); Vox: 2.00x2.00 mm (0.20000.2000.20)

S 7e+03

Docks Pop-In and Pop-Out

Docks may be placed on either side of the main window, allowing immediate access
to many VivoQuant tools without changing windows. If you need more main
window space for image viewing, close or re-arrange the docks to your preference.
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Docks

File View Tools Advanced Modules Help

=SoSM B O

Operator
Cropped Area
X
From 0 < [0
To 168 <168
Embed 176 = 176
Information
Voxel
old size 176x176x352
New size 169x169x80
Auto crop
0 ~
MM
Min/Max
Min Max
Reference
Input 1
Input 2
ok, Hist %0 %0
% Tool ~ min ~b max

Dual Docks

BmS0sse e -

z
< 0 >
2 [79
< 352 2

mm

35.2x35.2x70.4

33.8x33.8x16.0

Unit
kBq
N/A
N/A
# From Pal

44 To Pal

» Set

# Re-calc

A Reset

+ Apply
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R lquickseripts -/ %, 0 @

DM
Data List

Loaded:

Available Data

1

Memory: 41.59MB % A\ O

Name: SPECT_CT Registration [1001]
0: 18:33:33 10-0

33 0-05-19 21:03:16)
sterey
0.20%0.20 mm

— 00729
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Slice View

The Slice View (default) simultaneously displays images of single slices for the
sagittal, coronal, and transversal views of the loaded data sets.

Getting There

The Slice View is available via the view pull-down menu on the Main Window.

File View Tools Advanced Modules Help

=SS e oa MO0 ® © ®eve L [ &} o Slice View ~|Navigation -
5 Slice View
Display Tile View i

Multi View

Slice View Display

Using the Slice View Display

Display

IR- u;:--:j-mf disabled
-

n‘/

Slice View

You can scroll through slices in the Slice View by using the scroll wheel on a mouse
or by using the arrow and paging keys on your keyboard.
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Slice View

Last updated: March 08, 2023

The keys control different views (coronal, sagittal, or transversal) depending on the
current active view. Click on a view to make it the active view. Generally, you will
control the active view with the paging (PageUp, PageDn) keys, and scroll the

other two views with the arrow (-,<,1,1) keys.

& EEE)E)
EIEJE JEJE JE JEJE JE JE JR JE JE Je==]
E e e 0 )

il i i
T O )G

aoaayE

EE EE B ] |

Keyboard Controls

Scrolling Example

You can use the arrow and paging keys to scroll through slices in the Slice View.

In the example image below, the transversal view is the active view. The « and -
keys move the crosshairs (page 243) towards the L (left side) and R (right side) in
the transversal slice, respectively. Moving through the object to the left or right
steps through the sagittal plane of the object; thus, the sagittal slice changes.

The t and 1 keys will move the crosshair towards P (posterior side) and A (anterior
side). Both these sides are also visible in the sagittal slice of the object (rotated

90-degrees). Using the 1,1 keys in the transversal plane will shift the vertical

crosshair in the sagittal plane, and step through the coronal views of the object.
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R - update disabled

N

Scrolling Example

Scrolling Shortcuts Table

The following table displays the function of the arrow and paging keys for each
active view.

PageUp PageDn

Coronal Previous Next Previous Next Previous Next coro-
sagittal sagittal transversal transversal coronal nal slice
slice slice slice slice slice
Sagittal Previous  Next Previous Next Previous Next sagit-
coronal coronal transversal transversal sagittal tal slice
slice slice slice slice slice
Transversal Previous  Next Previous Next coro- Previous Next
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Active « - T l PageUp PageDn
View

sagittal  sagittal coronal nal slice transversal transversal
slice slice slice slice slice

Other Slice View Tools

You can also scroll through slices through the Viewer Control panel using the
sliders and their associated spin boxes. Additionally, you can use the Layout and
Zoom options to control the Slice View.
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Tile View

The Tile View displays an array of slices for either sagittal, coronal, or transversal
view of the loaded data sets. The number of slices displayed depends on the size of
the VivoQuant window.

Getting There

The Tile View is available via a pull-down menu on the Main Window (page 209).

File View Tools Advanced Modules Help

=sSST E e B0 2 & B e £ (E] &} v [Slice View -|Navigation - a auickseripts < % O @
Slice View

Display Tile View
Multi View

3'-up-.:ki§dlsab‘\ Aot @
’&;E?{' \

Tile View

Using the Tile View Display

Display

Tile View Display

You can scroll through slices in the Tile View using the scroll wheel on a mouse or
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using the arrow and paging keys on your keyboard. The keys control the rate at
which the user scroll through the tiles.

ojaaaajaaasjanan)E
ggmguauuuu;gg%qt III
E T L T T E LI B
0 e aaa
A G G G G O O
e 3 JEEE B )6)

Keyboard Controls

Previous Next Previous Next Previous Next
slice slice row row screen screen

|a
| 2

To switch between views (coronal, sagittal, transversal) in the Tile View, right-click
on a tile and choose the desired view.

Sagittal

Coronal

Transversal

Switch View
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There are two operators available in Tile View. The Time Series (page 181)
operator, which enables dynamic data to be viewed as a time series, and the 3D ROI

Tool (page 78) operator, which enables ROIs to be displayed in Tile View.

© Note: ROls can't be edited in Tile View.
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Multi View

Use the Multi View to create a fully customized Display for your data. You can
select how many Viewports and in what orientation they will be displayed, and
which datasets will be rendered in them. This is especially useful if you work with
data across multiple image modalities.

Getting There

The Multi View is available via a pull-down menu on the Main Window (page 209).

File View Tools Advanced Modules Help
=SS mag oS B0 L OB e X (] {& W [Siice View ~|Navigation - R |auickserpts -1 % O @
Slice View

Display Tile View

Multi View

Setting Up the Multi View Display

The Multi View tool activates a view-specific layout operator.

("] - = O X

File View Tools Advanced Modules Help
=SS G e B0 ® O B e A (] &} s Multi View - |Layout - R lauckserpts 7|y @ @
Operator & = Display

Use the data manager to drag and drop
images into your layout.

No Images

1 x 1 Layout

Hanging Protocol: None = |+| |-
Data: - - -

[] Show ROIs 'Show ROIs All

Resampling images took 0.1 sec
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Multi View Layout Operator

Use the Layout operator to customize the Multi View display:

1. Select the desired layout, which will define the number of rows and
columns of the Viewports.

2. For eachviewport, select the datasets and slices that will be displayed.
3. Use the Hanging Protocol pull-down menu to set the desired layout.

The 5x5 grid will populate with the corresponding number of rows and
columns, and control both the datasets displayed in each viewport and the

slice type.

File View Tools Advanced Modules Help
=sSOM B D BB Fe P L 8o X ) @) e Multi View ~|Layout *| 1 auickserpts -~ % O @
Operator 5 x  Display

Use the data manager to drag and drop
images into your layout.

.. " . R = R No Images

No Images

3x3 Layout

Hanging Protocol: |§de by Side 3 = 1| |-
None |
Data: = Focus Head 1 | | =

Focus Head 2 [
] Focus Head Fusion
["] Show ROIs ShSide by Side 2 :
Side by Side 3 =
Whole Body 1 [ L R L R No Images
Whole Body 2 .
Whole Body Fusion

Resampling images to reference image took 0.3 sec

Hanging Protocol

To load data into a particular viewport, click on the corresponding box in the grid,
and select the Reference, Input 1 and Input 2 dataset(s) image from the Data pull-
down menus. The dataset(s) will be loaded automatically.
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File View Tools Advanced Modules Help

=SaQM g e SEME0E e © B eoe (%] 46} ok Multi View ~|Layout - B |ouickserpts -1 % B @®
Operator & x Display

Use the data manager to drag and drop
images into your layout.

Tra Tra Tra

No Images

No Images

3 x 3 Layout

Hanging Protocol: None = *| |-

Data: - -~ |0 =

[] 0. NM: NM Reco ...

[[] Show ROIs |Show ROIs All ] 1. CT: Series 01 D..

Resampling images to reference image took 0.3 sec

Load Viewport

The boxes in the 5x5 grid are labelled Cor, Sag, or Tra, indicating the type of slices
displayed in the Viewports. To change the type of slice, double click on the
corresponding box in the grid and select the desired slice type.

File View Tools Advanced Modules Help
s GeMma o SBMB0Tee o B
Operator & x Display

=

() & W Multi View ~|Layout - R |auickserps <[ % B @

Use the data manager to drag and drop
images into your layout

Tra Tra Tra
No Images
Sag Sag Sag
Cor Cor |[Cor ~
Cor
Tra__|
No Images
3x3 Layout
Hanging Protocol: None -+ -
Data: - - 0 -

[[] Show ROIs  Show ROIs All

Resampling images to reference image took 0.3 sec

Select Slice Type
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To show ROls in a Viewport, select the desired Viewport, by either clicking on it in
the Display or clicking on the corresponding 5x5-grid box, and check Show ROls. To
show ROls in all viewports, click the Show ROIs All button.

Operator & x

Use the data manager to drag and drop
images into your layout.

Tra Tra Tra

5ag Sag Sag

Cor Cor .

1x 1 Layout

Hanging Protocol: None | |+ |-

Data: | = [ 8 [ |E

[] Show ROIs Show ROIs All

Show ROls

Using the Multi View Display

Navigation

To use the Multi View in the same way as other Displays, close the Layout operator
and select the Navigation operator. The Navigation operator in Multi View has
identical functionalities as in Slice View. Mouse and keyboard functions, including

Keyboard Shortcuts (page 315), are preserved.
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Viewer Control in Multi View

The View Control (page 265) functionality is extended in Multi View to cover the
new viewport layout. This includes the ability to view voxel and color information
for each viewport in the Display, as well as the ability to unlink the viewports,
enabling them to be navigated independently of one another.

File View Tools Advanced Modules Help

=SSW L DE BWEO GNP OB e £ &) & wp Multi View - |Navigation - 1) |ouickserpts -] % @ ®
VC s x Display

[ea) [~] Link Views ¢
[¥] Link Views (Y

X | | 88
Y [ ] 88 v
z [ | 176 =
c [ | 176 =

Voxel Value Intensity
[v] Ref |0.0481263 kBg| 100 =

[V Inp1 0 HU | 100 =

Inp2

Resampling images to reference image took 0.3 sec =

View Control Functionality
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Capture Viewer

The Capture Viewer allows for editing image and movie files prior to saving.

Getting There

When saving an image (page 217) or movie (page 220) file, the second option in the
Storage Type drop-down menu is DICOM Secondary Capture. Select this option
and click Save to load the data into the Capture Viewer.

\& Save Image ? h4
Look in: C:\Users\lua...cuments\DEMO ~ Q@ © © 4 @ @
s
™ My Computer Name Size Type
& luana
L 4 >
File name: | | Save
Files of type: Image files (*.png *.jpg *.bmp *.gif *.tif) v Cancel
Image type: All images =
Colorbar options 'none v
Storage Type DICOM Secondary Capture b
ificati Local image file _
MCCLL UL DICOM Secondary Capture

DICOM Secondary Capture Option

Function

The Capture Viewer panel is split into four fields: Info (page 240), Convert (page
241), Edit (page 241), and Image View (page 241).
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\& Capture: SPECT_CT Registration [NM Reco NOT-Registered]

Info

02-CT: Series 01 Descriptior =

PatientsName

Patient 0001

Study Desc Study 01 Desc
Series Desc Series 01 Desq

Capture Desc

Content Date

i

2021-08-13~

Data size 128x128x1
Image size 1048x758x1
DICOM Close

ong [100% %] [® [8

Convert
Save Image Save Movie
Save Capture | Play Movie

-

(® No compr () Lossless J

O Lossy JPE quality: 90+

Edit
Annotate PushButton
Circle PushButton
Arrow PushButton

Image View

Capture Viewer Panel
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Info

The Info field includes functions that affect the output image.

Series De-
scription

PatientsName
Study Desc
Series Desc

Capture Desc
Content Data
Data Size

Image Size
DICOM

Close

orig

and

VivoQuant™ 2022 User Manual

Image pull-down menu. The selected image will be reflected in
the Series Desc field.

Patient name as stored in the DICOM header.
Protocol used to collect the data.
Series description including modality.

Name of image/movie to be saved. Manually entered by the
user.

Date and time at which the image/movie was loaded into the
Capture Viewer.

Size of the original data referred to in the Series Description
pull-down menu.

Size of image currently being displayed.
When pressed, displays the DICOM header for the data.

When pressed, closes the Capture Viewer without saving im-
age.

When checked, maintains, or returns to, the original image size.

Increases/decreases the image size.
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Convert

The Convert field includes several options that affect the output image.

Savelmage Opens the Save Image (page 217) screen.
Save Movie  Opens the Save Movie (page 220) screen.

Play Movie  Plays/stops the movie.

Save Cap- Saves image/movie into the repository specified in the pull-down
ture menu.
Edit

The Edit field includes several buttons

Annotate Creates atext box in the image space.

Circle Creates acircle in the image space that can be moved and resized to
highlight an ROI.

Arrow Creates a movable arrow in the image space.

Image View

The Image field displays of the image or movie that is currently being edited.
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Show Reference / Input 1/ Input 2

The datasets rendered in the display (Reference, Input 1 and Input 2) may be
turned on and off.

Getting There

To toggle the appearance of these datasets, go to the View menu and select Show
Reference, Show Input 1, or Show Input 2. The change will be immediately visible
in the Display.

File View Tools Advanced Modules Help

& " Undo Ctrl+Z | NP O B e
M Redo Ctrl+Shift+7

RO ]

=

Show Reference F2
«* Show Input 1 F3
Show Input 2 F4

RGB data

Cross hair

Position labels

| Corner Information Ctrl+E

Active indicator

Layout

Reset View Transform

Zoom

Advanced

Show Reference / Input

Alternatively, you can use the keyboard shortcuts: F2 for Reference, F3 for Input 1,
and F4 for Input 2. For more information on keyboard shortcuts, visit the Keyboard

Shortcuts (page 315) page.
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Cross Hair

This function allows for displaying cross hairs on the images to assist navigation
through the slices.

Getting There

To display the Cross Hairs on the image, go to the View menu and select Cross hair.

File View Tools Advanced Modules Help
& *\ Undo Ctrl+Z

. # Redo Ctrl+Shift+Z
Dis

Show Reference F2
Show Input 1 F3
Show Input 2 F4

RGB data

Cross hair
Position labels

Corner Information Ctrl+E
Active indicator

Layout s

Reset View Transform Ctrl+R

0383 O EdRS

Zoom »
Advanced

Cross Hairs

Function

The Cross Hairs are displayed over each cross-sectional image: sagittal, transversal
and coronal. To display the cross hairs in the images, go to the View menu and
select Cross Hair. To conceal the cross hairs from view, unselect the Cross Hair
functionality by left-clicking onit.

VivoQuant™ 2022 User Manual Page 243


http://127.0.0.1:4012/vqmanual/images/viewingandlayout_viewmenu_crosshairs_filemenu.jpg
http://127.0.0.1:4012/vqmanual/images/viewingandlayout_viewmenu_crosshairs_filemenu.jpg

Cross Hair Last updated: March 08, 2023

Sow / Hide Cross Hairs
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Position Labels

The Position Labels are displayed on each image plane and MIP. They indicate
which side of the subject is being viewed.

Getting There

To display the position labels on the image, go to the View menu and select
Position Labels.

File View Tools Advanced Modules Help
& " Undo Ctrl+Z
# Redo Ctrl+Shift+Z

F2
Show Input 1 F3
Show Input 2 F4

Show Reference

RGB data

Cross hair

Position labels

Corner Information Ctrl+E
Active indicator

Layout L7

Reset View Transform Ctrl+R

o @el Ok

Zoom L4
Advanced

S lall o

~

Position Labels

Function

The labels indicate the plane of view (sagittal, coronal and transversal), and also the
left/right and anterior/posterior side of the subject.

VivoQuant™ 2022 User Manual Page 245


http://127.0.0.1:4012/vqmanual/images/viewingandlayout_viewmenu_positionlabels_filemenu.jpg
http://127.0.0.1:4012/vqmanual/images/viewingandlayout_viewmenu_positionlabels_filemenu.jpg

Position Labels Last updated: March 08, 2023

Sagittal There is an S on the top left corner of the image to indicate that it
is the Sagittal plane. There is also a P to indicate the posterior
side of the subject, and an A to indicate the anterior side of the
subject.

Coronal There is a C on the top left corner of the image to indicate that it is
the Coronal plane. Thereis also an H to indicate the head of the
subject, and an F to indicate the feet of the subject.

Transversal ThereisaT onthe top left corner of the image to indicate that is it
the Transversal plane. There is also an L to indicate the left side of
the subject, and an R to indicate the right side of the subject.
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Corner Information

This feature allows for configuring the image information to be displayed on the

four corners of each viewport.

Getting There

To display the image information, go to the View menu and select Corner

Information.

File View Tools Advanced Modules Help
=/ "M Undo Ctrl+Z @ ;E}I ﬁ 9.3

. & Redo Ctrl+Shift+7
Dis

®* Show Reference F2
¢* Show Input 1 F3
Show Input 2 F4

RGE data

1 Cross hair

| Position labels

Corner Information Ctrl+E

Active indicator

Layout
Ctrl+R

Reset View Transform
Zoom
Advanced

Corner Information

Alternatively, you can use the keyboard shortcut (page 315) Shift+E to display

the image information.

To conceal the information labels from view, unselect the Corner Information

VivoQuant™ 2022 User Manual

Page 247


http://127.0.0.1:4012/vqmanual/images/viewingandlayout_viewmenu_cornerinfo_filemenu.jpg
http://127.0.0.1:4012/vqmanual/images/viewingandlayout_viewmenu_cornerinfo_filemenu.jpg

Corner Information Last updated: March 08, 2023

function by using either of the above alternatives.

Function

Once this option is selected, the information for the active image is displayed on
the corners of all of the image planes (sagittal, coronal and transversal) and also on
the MIP.

File View Tools Advanced Modules Help
=sCOME D8 SBMBOTes 2 © ®es X [E & pSiceView ~|Navigation MIRE

Display

Activeqgy| 1001 TE:@ 1001 TE. @
CT+SPECT _In111[bed removd®] Topo ECT_In111[bed remove]
removed) [28] CTRi d removed) [28]
2010

XA11Y- 1412 T
Val: -1000 0.2mm L: -21.8mm
Min: -1000 Max: 7000 2357251

Val: -1000 HU
> Min: -1000

Info Displayed

Configuration

You can configure what type of information to be displayed on each corner of the
image viewports by going to Tools > Configuration.

Comer Inf
On the Display tab, click on the = button and use the patterns shownin

the window to select what information you want to display on each corner of the
image viewports.
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Caorner View Information =
Corner Information
Top Left: Top Right:
%op || %F
%S [%]] %z %2
| Oas [0/l i
Bottom Left: Bottom Right:
0o %G )
YoA %R %H 9%h
04N et
- None ~ Basic Advanced
Parameters
96 - Palette Information %M - Modality 4] - SeriesNumber
%o8 - PatientsBirthDate %N - Shce Numbers %ok - AccessionMNumber
9%C - Crosshair Information %60 - ProtocolName %%l - Dynamic Index
%o - StudyDate 9P - PatientsName %m - ManufacturersModeiame
%E - AcquisitionDate %R - Window Preset Name %0 - Manufacturer
9%F - MagneticFieldStrength %S - StudyDescription %p - PatientlD
866 - Anatomical Plane %T - StudyTime %45 - SeriesDescription
%&H - Shice Thickness %7 - Echo Time st - SeresTime
ol - SOPInstancelID %od - SeresDate %0z - RepetitionTime
5] - StudyID e - AcquisitionTime
%K - AcquisitionNumber %ah - Shce Location
%L - Dynamic String %i - InstanceNumber
oK . Cancel

Configure Corner Information
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Active Indicator

The Active Indicator option places icons in the viewports that indicate which
datasets are currently active in the Display.

Getting There

To turn on this option, go to the View menu and select Active Indicator.

File View Tools Advanced Modules Help
Undo Ctrl+Z |G O O P ees L @EEH

Redo Cirl+Shift+Z |

Show Reference

Show Input 1

Show Input 2
RGB data

Cross hair
| Position labels
| Corner Information
Active indicator
Layout
Reset View Transform Ctrl+R
Zoom
Advanced

Active Indicator

Function

The Active Indicators appear in the upper right corner of the viewports.
The top, middle and bottom indicators correspond to the Reference, Input 1 and

Input 2, respectively. If the indicator is a solid circle, the corresponding input is on.
If the indicator is a hollow circle, the corresponding input is off.
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Active and Inactive Data
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Layout

This feature offers a variety of layouts for viewing studies. You can view all the
slices and the MIP together simultaneously or each study individually.

Getting There

To select a layout option for the images, go to the View menu and click Layout.

File View Tools Advanced Modules Help
= ® Undo Ctrl+Z
# Redo Ctrl+Shift+Z

TGO O P e () &) v

iit=

Show Reference F2
Show Input 1 F3
Show Input 2 F4

RGB data

i Cross hair
| Position labels
Corner Information Ctrl+E

Active indicator

Layout > B8 Grid 2x2
Reset View Transform Ctrl+R 0 Grid 1:4
Zoom * & MIPonly
Advanced o8 Slices only

D Transversal only

Layout

Alternatively, the different layouts can be activated by clicking on the Layout
thumbnails in the Main Window (page 209).
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[T Grid 2x2

Grid 1x4

MIP only

@ B

Slices only

Transversal only

O

Layout Options

Grid 2x2
In the Grid 2x2 layout, the MIP and the coronal slice are located on the upper half

of the screen, and the sagittal and transversal slices are located on the bottom half
of the screen.
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Layout

File View Tools Advanced Modules Help
=sSCSMEOSE BSOSO O 8o

DM & x  Display
Data List R - update disabled
f 3 L |

'3

Loaded 2 Memon 59.55M % % O

Available Data

Type: CT -
Name: SPECT_CT Registration [1001]
Date: 2010-05-19 18:33:33 (series 2010-05-19 20:58:45)
Desc: CTReco:s (bed removed)
Dim : 176x176x252; Vox: 0.20x0.20 mm

SrTEE— 7e+03

Type: NM -
Name: SPECT_CT Registration [1001]
Date: 2010-05-19 18:33:33 (series 2010-05-19 21:03:16)
Desc: NM Reco NOT-Registered
Dim : 176x176x252 (176x176x352); Vox: 0.20x0.20 mm

—— 0.0722|

Resampling images to reference image took 0.2 sec

Last updated: March 08, 2023

AL () i} siw | Slice View - Navigation

=

Grid 2x2

Grid 1x4

In the Grid 1x4 layout, the MIP and all three slices are laid out in a single row.
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File View Tools Advanced Modules Help
=SS WMEAEOE B0 @ e LE My Slice View ~|Navigation ~ a auickseripts - % 0 @

DM 8 x
Data List

Loaded 2 Memon 59.55M % % O

Available Data ‘

Type: CT
Name: SPECT_CT Registration [1001]
Date: 2010-05-19 18:33:33 (series 2010-05-19 20:58:45)
Desc: CTReco:s (bed removed)
Dim : 176x176x252; Vox: 0.20x0.20 mm

| Er— 7e+03

| Type: NM
Name: SPECT_CT Registration [1001]
Date: 2010-05-19 18:33:33 (series 2010-05-19 21:03:16)
Desc: NM Reco NOT-Registered
Dim : 176x176x252 (176x176x352); Vox: 0.20x0.20 mm

P 00722

Eesampliﬁg }mages to reference fmage tbok 0.2 sec

Grid 1x4

MIP only

In the MIP only layout, only the MIP is visible. The slices are not in view.

File View Tools Advanced Modules Help
=SS WEoE BB 2 8- LK@ My Slice View ~|Navigation - a Quick Scripts ~|  »

DM & x  Display
Data List

Loaded 2 Memon 59.55M % % O

Available Data |

Type: CT
Name: SPECT_CT Registration [1001]
Date: 2010-05-19 18:33:33 (series 2010-05-19 20:58:45)
Desc: CTReco:s (bed removed)
Dim : 176x176x252; Vox: 0.20x0.20 mm

[ ei03 7e+03
Type: NM -

Name: SPECT_CT Registration [1001]

Date: 2010-05-19 18:33:33 (series 2010-05-19 21:03:16)

Desc: NM Reco NOT-Registered
Dim : 176x176x252 (176x176x352); Vox: 0.20x0.20 mm

I 0.0722|

Resampling images to reference image took 0.2 sec
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MIP only

Slices only

In the Slices only layout, only the slices are visible. The MIP is not in view.

File View Tools Advanced Modules Help
=eCOeME DS BMEOL O O O ece | L [ E i Slice View ~|Navigation ~| =]

DM # x  Display
Data List

Loaded 2 Memon 59.55M % % O

‘ Awvailable Data

Type: CT -
Name: SPECT_CT Registration [1001]
Date: 2010-05-19 18:33:33 (series 2010-05-19 20:58:45)
Desc: CTReco:s (bed removed)
Dim @ 176x176x252; Vox: 0.20x0.20 mm

[et0z 7e+03]

Type: NM -
Hame: SPECT_CT Registration [1001]
Date: 2010-05-19 18:33:33 (series 2010-05-19 21:03:16)
Desc: NM Reco NOT-Registered
Dim : 176x176x252 (176x176x352); Vox: 0.20x0.20 mm

I 0.0729|

Resampling images to reference image took 0.2 sec

Slices only

Transverse only

In the Transverse only layout, only the transverse slice is in view.
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File View Tools Advanced Modules Help
sCeMEA oS B0 ® © ® e L @& Wy Slice View - Navigation - a »

DM # x  Display
Data List

Loaded 2 Memon 59.55M % % O

‘ Awvailable Data

ype: LI
Name: SPECT_CT Registration [1001]

Date: 2010-05-19 18:33:33 (series 2010-05-19 20:58:45)
Desc: CTReco:s (bed removed)

Dim : 176x176x252; Vox: 0.20x0.20 mm

[ e+03 7e+03]

I A
Hame: SPECT_CT Registration [1001]

Date: 2010-05-19 18:33:33 (series 2010-05-19 21:03:16)
Desc: MM Reco NOT-Registered

Dim : 176x176x252 (176x176x352); Vox: 0.20x0.20 mm

I 0.0724

Resampling images to reference image took 0.2 sec

Transverse only
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Zoom

The Zoom function allows for altering the viewpoint of the images by zooming in
and out, and also provides the option of a full screen view.

Getting There

There are three different methods for operating the Zoom function. The first
method is to go to the View menu and select Zoom.

File View Tools Advanced Modules Help

8 " Undo Ctrl+Z NP P .@ e % E @-
Dis # Redo Ctrl+Shift+Z |

i ® Show Reference F2

¢* Show Input 1 F3

Show Input 2 F4

DoE A L
"::.i 'klll.'ltl.l

Cross hair

Position labels

Corner Information Ctrl+E
Active indicator

Layout v

G 85 & Eird

Reset View Transform

Zoom L
Advanced

In (25%) Ctrl++
Cut (25%) Ctrl+-

Mormal size Ctrl+0
Full screen Ctrl+F
Ctrl+U

90O

Auto zoom

Zoom

The second method is to use the following keyboard shortcuts:
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Zoomin (25%) Ctrl++

Zoomout (25%) Ctrl+ -

Normal size Ctrl+0
Full screen Ctrl+F
Auto zoom Ctrl+Z

For more information on keyboard shortcuts, see the Keyboard Shortcuts (page
315) page.

The third method is to click on the Zoom In and Zoom Out =— thumbnails in the

Main Window (page 209).

Function

The Zoom In option allows for to zooming in by 25% increments. The Zoom Out
option allows for zooming out by 25% increments.

File View Tools Advanced Modules Help File View Tools Advanced Modules Help
soomaoE BwIS0ra|es sCOoMaoE BmB0 e e 9[0]p -

Display Display
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Zoom In and Out

The Normal Size is the default angle. Selecting this option will bring the images
back to their original viewing angle.

The Full Screen options displays VivoQuant in full screen mode. To enable and
disable this mode, hit the keyboard shortcut Ctrl + F.

The Auto Zoom option automatically increases the viewing angle of the images if
the size of VivoQuant’s window is increased. To access this option, click on the

Auto Zoom thumbnail =— on the top bar.

O Note: If the Auto Zoom function is not selected and the size of VivoQuant’s

window is increased, the image slices will stay in the same viewing angle and will
not automatically fit the larger window size.
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VQScript

VQScript, or VivoScript, is an implementation of ECMAScript (JavaScript) that
allows users to access large parts of VivoQuant.

JavaScript structures

VQScript syntax is identical to JavaScript syntax.

Loop
for (var 1=0; 1i&lt;10; ++1i) {

}

Function

function blub() { ... }
function bar(pl, p2, p3) { return pl+p2+p2; }
var res = bar(1,2,3);

Array

var array = new Array();

array[0] = 'foo’;

array[1] = 'bar';

var array2 = new Array('foo', 'bar');

var array3 = [ 'foo', 'bar' ];

var last = array2.pop(); // remove and get last
element

array2.push('burp'); // add element

Other array functions are, for instance, concat, join, reverse,sort,unshift,
shift.
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The VQScript Toolbar

Adding Script Shortcuts to the Toolbar

Shortcuts for commonly executed VQScripts can be added to the Quick Scripts
menu on the VQScript toolbar

To add a Quick Script shortcut:

1. Goto Tools->Configuration and click on the VivoScript tab.

\& Configuration ? X
ta  DICOM  Network  VivoScript  Registration 4 *

cknan Full Path

Mer... C:/Users/luana/Documents/DEMO/Mer...

s %+

L4

< >

|_| Enable VivoScript Debugger (EXPERIMENTAL)

OK Cancel

2. Select ascript for which quick access is desired by clicking the Add Quick
Script button — and navigating to the directory where the script is saved.
3. Add a nickname for the script in the dialog box that appears.

4. The script will now appear in the configuration window as well as in the
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Quick Scripts menu on the VQScript toolbar.

Quick Scripts can be edited directly from the VQScript toolbar by clicking on the

Edit VivoScript button
script.

. A window will appear in which the user can edit the

Edit VivoScript

C:/Users/kgoettier Documents Projects fmisc/tool. vas

Sindude “ipacs.vgs” A~
Sincude "VQSTools. vas”

var dm = V.dataManager();
var mw = VQ.mainWin();
var ctl = VQ.controker();

e, SetViewMode(Shoe View', 30 ROI Tool);
var roi = ViQ.currentOp();

/f Create ROI for Processing

roi. addROI(ROI Pre Comg',red);

VQ.getwidget{'qt_tabwidget_tabbar’).setCurrentindex(1);
roi, setCurrentROI (roi. numROLs()- 1);

1 Allows user to place ROI
VQ.suspend(Place ROI);
I Apply "Connected Components’ on ROI
ViQ.getWidget{'gt_tabwidget_tabbar").setCurrentindex(3);
VQ.getWidget{MagicSegmentatonSelector”). setCurrentindex(11);
roi. applyConnectedComp();
[ Create final ROI
roi.addROI(RO!I Final', red’);
roifinal = rol.numROIs()-1;
J/ Dilate +1 and map to new ROI
VQ.getWidget{aqt_tabwidget_tabbar’), setCurrentindex(1);
VQ.getwidgst( chMagicEDRadius’), setCurrentindex(4);
¥Q.getWidget{ chErodeMapTo’). setCheded(true);
¥Q.getWidget({ cblayerROl). setCurrentindex(roifinal);
VQ.getWidget{cbROIs"). setCurrentindex(0);
VQ.currentOp(). applyErode();
/I Delete all but new ROL
varis 1;
while{j < rol.rumROls() - 1) {

rol.deleteROI(,0): ]

Edit Quick Script

Using the Peek Tool

The Peek Tool is used to reveal the names of elements (called widgets) in the
operator GUIs for use in scripts. The command VQ.getWidget ("widgetName")
can then be used to interact with these elements.

For example, to determine the name of the button in the 3D ROI Tool that resets all

ROls, click on the Peek button— on VivoQuant’s top bar, and then click on the
desired button in the 3D ROI Tool operator box. A yellow box containing the class
and name of the selected button will be displayed.
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Operator & x

A @ o N =

G [aal My —
@ | QToolButton: buttonResetROIs

ROI H I

B background []

Using the Peek Tool

Then, the command VQ.getWidget ("buttonResetR0Is").click() cabe
used to click the button and reset all ROls.

VQScript Examples

Included with VivoQuant are 30 VQScript example scripts to help you get started
working with VQScript. These scripts illustrate some of the many ways VQScript
may be used to streamline workflows in VivoQuant. To learn more about each files,

see the VQScript Example Scripts (page 0) page.

VQScript Classes

Click here to see the list of VivoScript Classes.
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View Control

The View Control palette is a powerful tool for manipulating image appearance in
the Main Window.

Getting There

There are three different methods for reaching the View Control tool. The first

method is to use the View Control thumbnail @ in the Main Window (page 209).

The second method is to go to View Control under the Tools menu.

File View Tools Advanced Modules Help
=SS View control F5
Display MIP control F6
—— : '@' Data Manager F7
R - updote dis E Min/Max
4k Histogram Ctrl+Shift+H
W Workflow Assistant
H Pre-processing
B8 Resample data
. % Frame Time Editor
| © DICOM :
&« Image & Movie 4
5 eCRF ’
\& Update Check Ctrl+Shift+U
%, Configuration Ctrl+Shift+C
| Min: -1000 Max 7000  88/17

View Control

The third method is to use the keyboard shortcut F5. For more on keyboard
shortcuts, please see Keyboard Shortcuts (page 315).
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Function

The View Control window provides a variety of options for manipulating the
appearance of open data sets in the main window. Options include Sliders (page

266) for slice selection, Color Controls (page 267) and Voxel Values.

Ve El
SliceView 1 - Link Views O
Sliders
X N 88 <
Y B 88 =+
5 Kl 1126 &
Color Controls

Voxel Value Intensity
Ref |-15.3541 |HU |[100 %]
Inp1 0.0481263 |kBq|/100 +
Inp2 | [ ]100 2
View Control Operator
Sliders

Adjusting the X, y, and z sliders in the Sliders section changes the sagittal, coronal,
and transverse slices, respectively, that are shown in the Display. The cross hairs
displayed on the main window also reflect the X, y, and z slider values.

VivoQuant™ 2022 User Manual Page 266


http://127.0.0.1:4012/vqmanual/images/tools_viewcontrol_vcoperator.jpg
http://127.0.0.1:4012/vqmanual/images/tools_viewcontrol_vcoperator.jpg

View Control Last updated: March 08, 2023

Color Controls

The Color Controls display information about the datasets loaded at the
Reference, Input 1 and Input 2 positions.

The checkboxes on the left toggle the visibility of the datasets in the Display. Next
to these, the Voxel Values of each dataset at the current slice are displayed along
with their respective units.

O Note: If given proper Hounsfield or quantification calibration, the voxel values
will be given in Hounsfield units or MBq.

The Intensity pinboxes control the relative transparency of the dataset. Decreasing
the intensity value increases the transparency of the image.

View Control in Multi-View

The Multi View mode enables users to customize the layout of viewports in the
Display. When in Multi View, additional controls become available, extending the in
the View Control normal functionality to the Multi View Display. Users may also
select whether navigation is linked across viewports, or if viewports may be
navigated independently of one another. For more information on setting up the

Display in this view mode, see the Multi View (page 236) page.

In Multi View, the information in the Sliders and Color Controls is automatically
updated to reflect information from the viewport through which the user is
navigating. To update these with information from another viewport, use the drop
down menu in the upper left hand corner and select the desired viewport.
Alternatively, click on or navigate through another viewport in the Display to
update the Viewer Control.
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Ve [«

MultiView 1,1 - e [ Link Views O
SliceView 1
SliceView 1 ,
SliceView 1 88 =
MultiView 1,2 88 -
_MuItMew 1,3 _ ’126 :
Color Controls

Voxel Value Intensity
[V] Ref |-15.3541 | HU |[t00 <
Inpl 0.0481263 | kBq|[to0 3

Inp2 | | |lto0 S

Update Dataset Information

By default, the Viewer Control links all viewports in Multi View together. This
means that any navigation through the slices in one viewport is reflected in all
other viewports automatically. Viewports may be unlinked by unchecking the Link
Views checkbox in the upper right corner of the Viewer Control. This will allow
users to navigate through each viewport independently.
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File View Tools Advanced Modules Help

eSS MageE BBWE08e® 2 ®ee L E S v Mutiview -|Layout - aQuwckScnpls - O0®
vC s x Display
Multiview 1,2 -| e [] Link Views O
Sliders
X ] 89
Y B 82
z E 138 &
Color Controls
Voxel Value Intensity
[v] Ref [119.664 HU |[100 =

[ Inp1 [0.049363 kBq|[100 =

Resampling images to reference image took 0.2 sec

Navigate Viewports

To reset all viewports to the same slice, click on the Sync Viewport Settings button
located next to the Link Views checkbox.
O Note: The Link Views functionality only affects the slice-by-slice navigation

between viewports. Zooming and panning within each viewport will remain
independent.

To reset the Zoom and Pan in a specific viewport, select the desired viewport
(either by selecting it from the drop down menu or by clicking on the viewport) and

viewport. To reset all viewports at once, click the Reset button

click the Reset button in the Viewer Control. This will reset only the selected

on the toolbar.
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MIP Control

The MIP (Maximum Intensity Projection) control can be used to manipulate the
active 3D rendered volume. See MIP Explained (page 0) for a more detailed
description of how the MIP is generated.

This tool also allows to automatically rotate the 3D volume and create custom
movements that can be exported as videos or gifs.

Getting There

There are three different methods for reaching the MIP Control window. The first

method is to use the MIP Control thumbnail @ in the Main Window (page 209).

The second method is to go to MIP Control under the Tools menu.

File View Tools Advanced Modules Help

- @@ 2 View control F5 :I:E} JORN': My
MIP control F6 :

i

Display

Data Manager F7
Min/Max
Histogram Ctrl+Shift+H

Workflow Assistant

Pre-processing

Resample data

Frame Time Editor

DICOM b

¢r@BOSE HE

~ e Image & Movie ;
GC_In®=o_Mo L:_l eCRF '

Update Check Ctrl+Shift+U
Ctrl+Shift+C

>~ E

Configuration

MIP Controls

The third method is to use the keyboard shortcut Fé. For a complete list of
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keyboard shortcuts, see Keyboard Shortcuts (page 315).

Function

The MIP Control window provides a variety of options for manipulating the MIP
and the appearance of open data sets in VivoQuant’s main window. Options include

Playing a MIP Movie (page 272), Color Controls (page 272), View Controls (page
276), VTK Viewer (page 276), Transfer Function (page 278), and MPR View (page
280).

MC a5
| Color Controls
+ - Presets Light Ambient Diffuse Specular Shininess
Ref Custom - 0.15 | |0.90 & (045 5| [13.0
Inp1 |Palette g 015 % (090 + 010 5 (150 »
Inp2 Paletie " 0.15 5 |0.90 &1 |0.10 & [15.0 %

View Controls

View Angle | O Play
Speed [ ] 0%
VTK Viewer

B @ & O™ e(TH

Reference  Input 1 Input 2

Computation Hardware Default Render Mode 5
Ray Projection Mode Maximum >
Interpolation Linear =

Intensity Opacity Ramp / Color Function

in: -1000 Max: 155
Max Blend -~

=0
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MIP Controls Function

Playing a MIP Movie

The MIP movie is automatically generated upon the loading of a data set. Using the
mouse, it can be manually rotated in the main window. Hitting Play in the MIP
Control enables automatic rotation of the MIP movie. The slider bar marks the
rotation progress of the MIP movie. For large data sets, it can sometimes take
several moments for the MIP movie to be generated. The progress bar in the MIP
Control indicates how much of the MIP movie has been successfully calculated.

Color Controls

The Color Controls section provides users with the ability to define tissues and
their corresponding coloring properties (opacity and RGB), for volume rendering.

Color Controls

- Presets Light Ambient Diffuse Specular Shininess
Ref Palette - 0.30 % [0.90 ¥ [0.45 7] [13.0 7]
Inp1 |Palette 015 5 (0,90 ¥ 0.10 ¥ 50
Inp2 Palette : 0.15 | (0.90 5| 10.10 & [150 =

Color Controls

VivoQuant volume renderer allows for manipulating 3 data sets at the same time:
Reference, Input 1 and Input 2. Users can select canned tissue presets, as well as
creating and saving custom tissue properties, and editing existing tissue opacity
and color functions.

Tissue properties can be selected from the Presets combo box.
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Color Controls

= =- Presets Light
Ref |Palette - O
Palette P
Inp1 Custom

Inp2 CT. Human Airways
CT: Human Bone

View CT: Human High Contrast
CT: Human Muscle

View |CT: Human Skin
CT: NHP Basic

Spee CT: NHP Endoscopy |
1hn‘.“.T: NHP Flow v

LEE e s

Select Presets

Users can select any of the following preset options:

o Palette: Syncs with the palette selected in the Data Manager (page 282)
and reacts to min/max changes. This option does not allow custom coloring

for the function. New presets cannot be added based on this option.
Therefore the Add Preset and Remove Preset buttons are disabled.

e Custom: Allows for coloring from the current function. The default colors
will be those of the palette option if no presets were selected beforehand.
This is the only option that allows for adding new presets. To add a new

custom preset, click on the Add Preset button—. A popup window opens
prompting the user to enter a name for the new custom preset.

Choose a name ? X

Name:

ITESt Preset |

0K Cancel

Create Preset

The newly created preset will then appear on the list of presets in the
Presets combo box.
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- Presets
| Custom -
CT: NHP Rainbow A

CT: Rodent Bone

CT. Rodent Bone + Skin
CT: Rodent Bone + Skin 2
CT. Rodent Bone + Tissue
CT. Rodent Bone + Tissue 2
CT. Rodent Bone 2

CT: Rodent Dark Bone

CT. Rodent Dark Bone 2

v

Newly Created Presets

A Important: When adding preset with a name that already exist, a popup
window appears asking the user to confirm whether they would like to
overwrite the previous preset or not.

Add Preset X

e A preset “Test Preset” already exist. Do you want
to overwrite it?

| Yes || Mo

Overwrite Preset

To remove a custom preset, click on the Remove Preset button E A
popup window opens asking the user to confirm deletion of the custom
preset.
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Color Controls

+ o] Presets Light Ambient Diffuse Specula
Ref Test Preset * [ [0.30 % |0.90 %] [0.45 ]
Inp1 |Palette : 0.15 + [0.90 = [0.10 %
Inp2 Palette - 0.15 = 0.90 % 0.10 %
Remove Preset o |

e Are you sure you want to remove "Test Preset" ?
Y |

Yes No

& [l [or] e |

Remove Preset

e CT Tissue Types and Species: These are presets that present CT property
configurations that are specific to different tissue types and species. Some
examples include: CT: Human Bone; CT: Human Muscle; CT: NHP Basics;
CT: NHP PET; CT: Rodent Bone + Skin; CT: Rodent Dark Bone; among
others.

Users can edit the shading settings by enabling the Light checkbox under Color

Controls. The

Ambient

Diffuse

Specular

Shininess

available shading and lighting settings are as follows:

Ambient light is the light that is scattered by the environment. It is a
simple approximation of global illumination that is independent
from the light position, object orientation, observer’s position or
orientation. That is, ambient light has no direction.

Diffuse light is the illumination that a surface receives from a light
source and reflects equally in all directions.

Specular light is a light that retains its reflective qualities. When
this light hits a surface, reflection bounces back into the camera.
Specular light is a bright spot on an object. It is the result of total re-
flection of incident light in a concentrate region.

Shininess is a material property that determines the size and sharp-
ness of specular highlights.
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View Controls

Upon loading a data set, an MIP movie showing the image rotation is automatically
generated. By using the mouse, the image can be manually rotated in the main

window. Clicking on the Play button = in the View Controls enables automatic
rotation of the MIP movie. The View Angle slider bar shows the rotation progress.
It also allows for fine control of the camera position. By default, the camera rotates
around the Z-axis, and each step is a 3-degree rotation.

For large data sets, the MIP movie may take several minutes to be generated. The
progress bar in the under the Play button indicates how much of the MIP movie has
been successfully calculated. The Speed slider allows for fine control of the MIP
rotation speed.

View Controls

View Angle 5] O Play
Speed [ - 100%

View Controls

VTK Viewer

The Visualization Toolkit (VTK) is open source software used for manipulating and
displaying scientific data. VivoQuant uses the VTK library to generate the 3D
Volume (MIP).

Each operator has default VTK Viewer settings which are refreshed upon opening
an operator window.

The MIP Projection VTK Viewer allows for fine tuning of some of the parameters
offered by the VTK renderer. Some functions include:

e Opacity and color transfer editing function by means of image histograms.
e CPU and GPU based volume rendering pipelines.
¢ Interpolation mode selector to change the quality of the VTK rendering.

e Ability to save settings to disk and load previously saved VTK settings.
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| VTK Viewer
BB o & [l [or] = (o] [T] 1
Reference input 1 Input 2
Computation Hardware Default Render Mode =
Ray Projection Mode Composite - Gradient b
Interpolation 'Nearest Neighbor v
Intensity Opacity Ramp / Color Function
Min: -1 Max: 155

| Gradient Opacity Ramp

VTK Viewer

The following table describes the options that are available for adjusting the VTK

viewer:

W § &

Save / Load
Settings

Auto Up-
date

Force Re-
fresh

Reset Cam-
era

Bounding
Box

Gradient
Box

Provides an option to save the current settings or load
previously saved VTK settings.

Provides an option to enable or disable automatic settings

update.

Forces re-rendering of the VTK viewer.

Resets the camera of the VTK viewer to its initial position.

Enables VTK bounding box and clipping.

If enabled, replaces black background with VTK gradient
grey background.
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@ Toggle MIP  Toggles the classic MIP in the VTK viewer.

IEI Toggle Toggles Multi-planar reconstruction (MPR) view in VTK
MPR viewer. Hold down to toggle background transparency.

Orientation Toggles orientation cube in the VTK viewer. Hold down to
Cube select the orientation model: Default, Human, Human
Head, Rodent or Rodent Head.

m Annotation Toggles visible annotations in the VTK viewer.

Quality Changes performance of VTK viewer by optionally down-
— sampling the VTK image. Hold this button down to specify
the resolution of the image: Fine, Standard, or Fast.

Transfer Function

Transfer functions are tools for assigning optical properties to scalar volume data
sets. For direct volume rendering, for example, opacity can be set depending on the
gray value at a given voxel position.

VivoQuant’s VTK Viewer allows for editing opacity and color transfer functions by
using image histograms and other volume rendering options.

e Computation hardware: This option allows users to choose the desired
processing platform for image rendering. Options are: Default Render
Mode; CPU Render Mode; or GPU Render Mode.

™ Tip: GPU processes data faster than CPU, but usually has smaller
memory.

Depending on the available hardware, use GPU for rendering images
smaller than 1 GB, and CPU for rendering images bigger than 1GB.

e Ray Projection Mode: This option allows users to choose the desired ray

projection method. Options are: Maximum; Minimum; Average; Surface;
Composite-Gradient; and Composite-Feature Detection.

VivoQuant™ 2022 User Manual Page 278



MIP Control Last updated: March 08, 2023

¢ Interpolation: This option allows users to change the quality of the VTK
rendering by changing the smoothing applied to the texture mapping when
sampling between two voxels. Options are: Linear; or Nearest neighbor.

e Histogram: For Intensity Transfer Function, the X-Axis represents pixel
intensity. For Gradient Transfer Function, the X-Axis represents gradient
intensity. For both of the previous modes, the Y-Axis represents the weight
factor between O-1.

You can add a point to the transfer function in the histogram. To do so,
right-click on the position you would like the new point to be added to
within the histogram, and select Add new point. You can also reset the
point to their original value by right-clicking the histogram and selecting
Reset.

To manually edit the X axis values of the histogram, right click and select
Properties. A window opens with editable fields to enter the Minimum and
Maximum values. You can return the X axis to its original minimum and
maximum values by clicking the Reset button.

Intensity Opacity Ramp / Color Function

Add Point
in: -1000 Reset Points Max: 155
Alpha Blend -~ Properties | B

Add Point

When adding a new point to the function, a color picker window opens
which by default assigns interpolated color between the two surrounding
points. Users are allowed to change this color. Also, the color of any of the
function points can be changed by right-clicking it and selecting Color. To
remove a point from the histogram, right-click on the point to be deleted
and select Delete Point.

Intensity Opacity Ramp / Color Function

Color...

Delete Point

Max: 155
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Delete Point

¢ Blending: Controls how volume blend together. Options are: Max or Alpha.

MPR View

The Multi-Planar Reconstruction View (MPR) simultaneously displays a sagittal,
coronal, and transversal slice of the reconstruction. The View Control (page 265) is
used to change the active planes while the sliders and checkboxes across the top of
the window may be used to rotate the view, display the bounding box, reset the
view, and turn on/off individual planes.

MPR View

The image in MPR View may be rotated by using a left-click and dragging the
mouse. Similarly, panning may be controlled by holding the Shift key, using a left-
click, and dragging the mouse. The zoom may be changed by using the mouse’s
scroll wheel.

To change the active planes in the MPR View, use the (X,Y,Z) sliders in the View
Control (page 265).
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Sliceview1 & ~ Link Views @)
Sliders
X | m <
Y m 109 =
z | 157 =
Color Controls
Voxel Value Intensity
] Ref (275759 |[Hu |100 3|
Inp1 [0.0105982 |kea|[100 3]
~ Inp2 | L _Joo =
Sliders
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Data Manager

The Data Manager presents information about the datasets loaded into
VivoQuant. While VivoQuant only displays up to three datasets in the Display at a
time, post-processing operations may be performed on any number of datasets in
the Data Manager. The only limiting factor in the number of simultaneously loaded
dataset is the system memory.

Getting There

There are three methods to open this tool. The first method is using the Data

Manager thumbnail == in the Main Window (page 209).

The second method is to go to Data Manager under the Tools menu.

File View Tools Advanced Modules Help
2 @@ £ View control F5 ® O B ece
MIP control F6 |
Data Manager F7
Min/Max

Display

Histogram Ctrl+Shift+H
Workflow Assistant

Pre-processing

Resample data

Frame Time Editor

DICOM >
Image & Movie =

eCRF >

Update Check Ctrl+Shift+U
Ctrl+5Shift+C

f£@$©WEE§Fm 0= i

Configuration

Data Manager
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Finally, the Data Manager is also available by using the keyboard shortcut (page
315) F7.

Using the Data Manager

The Data Manager displays a list of all datasets loaded into VivoQuant, along with
information about each of them. This tool can hold as many datasets as the system
memory allows; however, the first, second and third datasets in the Data Manager
are the only three that appear in the Display. These datasets are the Reference,
Input 1, and Input 2, respectively.

The information displayed by the Data Manager includes the image type, name,
dimensions and voxel size. For DICOM data, the Study Date, Series Date, and
Series Description will also be included when available.

Below this information is a color bar specific to each dataset. The color bar defines
the colors that will be used to represent the dataset in the Display. The colors can
be changed by right-clicking the color bar and selecting the desired color palette.
VivoQuant selects color palettes for datasets by default based on modality (CT, PT,
MR, etc.). Default color palette options may be changed in the Display (page 16) tab
of the Configuration window. These changes do not affect the minimum and
maximum values stored in the Min/Max Tool. For more information on changing
the minimum and maximum values, see the Min/Max Tool (page 290) page.
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DM & x
Data List

Loaded: 3 Memory: 89.33MB % *\ O

Available Data

Type: CT
Hame: SPECT_CT Registration [1001]
Date: 2010-05-19 18:33:33 (series 2010-05-19 20:58:45)
Desc: CTReco:s (bed removed)
Dim @ 176x176x252; Vox: 0.20000.20 mm

7e+03

l

Type: NM
Name: SPECT_CT Registration [1001]
Date: 2010-05-19 18:33:33 (series 2010-05-19 21:03:16)
Desc: NM Reco NOT-Reqisterad
Dim : 176x176x252 (176%1 76:352); Voo 0.20x0.20 mm

0.07239

I

Type: CT
Name: Patient 0101 Name [Patient 0101 ID]
Date: 1970-01-01 12:12:12 (series 1970-01-01 12:12:12)
Desc: Series 1 Description
Dim @ 176x1 760252 (128x128x252); Voo 0.20060.20 mim (1.00x1.0000.20)

254

I

Data Manager Window

If the windowing is using the Min/Max option, the palette can be adjusted by
clicking on the black bars at the far left or right of the palette to adjust the window
min or max, respectively. If the windowing is using the Level/Width option, the
width of the window is adjusted by clicking and dragging the ends, while the center
is adjusted by clicking and dragging the middle of the palette display. The Level/
Width palette can be also adjusted similarly to the Min/Max by holding the Shift
key while dragging the ends.

The windowing can be adjusted within the image as well, by holding a right-click

and dragging the mouse. In the Min/Max setting, dragging left/right will adjust the
min while up/down will adjust the max. In the Level/Width setting, dragging left/
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right will adjust the level, while up/down will adjust the width. This function works
within any of the operators and does not require that the Data Manager is active.

The color palettes for a single frame of data can be edited in the Data Manager by

right-clicking on the color palette.

DM = atlas11
Data List = blackbod
Loaded: 3 Memory: ® blue

! ® cardiac
Available Data ® cool

Type: CT = ctyd

Name: SPECT_CT Registration [1001]

Date: 2010-05-19 18:33:33 (series 2010-05-19 20:58:45)
Desc: CTReco:s (bed removed)

Dim @ 176x176x252; Viooe: 0.20:0.20 mm

default

]

exp

I

flow

Type: NM
Name: SPECT_CT Registration [1001]
Date: 2010-05-19 18:33:33 (series 2010-05-19 21:03:16) « gold
Desc: NM Reco NOT-Registerad
Dim : 176x176:252 (1761 76x352); Voo 0.20x0.20 mm = gray

I

ge_color

green
= greenhoté

hot

hotblue

= hotgreen

linear
& linw
& log
= mpi
nih
nih_fire
nih_fire2

nih_ice

]

phase

prism

prism2
prism3

ptq

step10
step20
stepd
step5
step50
stern
w_gray
warm
watson

wprism

Edit Single Frame
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To edit multiple frames at once, use Ctrl or Shift to select multiple frames, then

right-click on one of the palettes, and all frames will be edited together. This

technique can also be used for editing the Min/Max for the palettes of multiple

frames at once.

DM
Data List

Loaded: 3 Memony:

atlas11
blackbod

cardiac
cool

ot yd
default

exp

:

Available Data

Type: C1
Mame: SPICT_CT Registration [1001]
Dade: 2010-05-19 18:33:2] (seres 2010-0%- 19 20:38:43)
Desc: CTReco:8 (bad removed)
Dam 2 160 P25 Voo 0.200.20 mvn

BT ESSSSS———

ge_color

Z

gray
green
« greenhot6

nih
nih_fire
nih_fire2
nih_ice
phase
prism
prism2
prism3
& piq

- PP, T

1

step10
step20
stepd
step5
step50
stern
w_gray
warm

walson

wprism

o

Edit Multiple Frames

VivoQuant™ 2022 User Manual

Page 286


http://127.0.0.1:4012/vqmanual/images/tools_datamanager_editallframes.jpg
http://127.0.0.1:4012/vqmanual/images/tools_datamanager_editallframes.jpg

Data Manager Last updated: March 08, 2023

Ordering Data

Data may be rearranged into any order in the Data Manager by dragging a dataset
and dropping it to the desired position. Alternatively, data can be moved into the
Reference, Input 1 or Input 2 location by right-clicking and selecting Move to
Reference/Input 1/Input 2.

DM
Data List
Loaded: 3 Memory: 89.33MB X A\ O
Available Data
Type: CT
Name: SPECT_CT Registration [1001]
Date: 2010-05-19 18:33:33 (series 2010-05-19 20:58:45)
Desc: CTReco:s (bed removed)
Dim : 176 76@52; Vo 0.20000.20 mm
_ :-'e+0:-:|
Type: NM

Name: SPECT_CT Registration [1001]
Date: 2010-05-19 18:33:33 (series 2010-05-19 21:03: 16]

Move to Reference

A prompt will appear confirming the move. Click OK to complete the move.

@' Confirm Move X
@ Do you want to move 3 to 27
Yes No
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Confirm Move

A dataset can also be quickly swapped with the dataset in the Reference, Input 1,
or Input 2 positions by right-clicking on a dataset and selecting Swap with
Reference /Input 1 /Input 2.

— ﬂ

Data List

Loaded: 3 Memory: 89.33MB XN O

Available Data

Type: CT
Name: SPECT_CT Registration [1001]
Date: 2010-05-19 18:33:33 (series 2010-05-19 20:58:45)
Desc: CTReco:s (bed removed)
Dim : 1761 76:252; Vox: 0.2000.20 mm

T 7e+09

Type: NM
Name: SPECT_CT Registration [1001]
Date: 2010-05-19 18:33:33 (series 2010-05-19 21:03:16)
Desc: NM Reco NOT-Registered
Dim @ 176x176x252 (176x176:352); Voux: 0.20000.20 mm

I 0.0724

Move to Reference

Mowve to Input 1

Swap with Reference
Swap with Input 1

Annotate

eCRF 4
Copy Details

DICOM Dump

o e

CT Window Presets  *

Save Data as r
Merge Data
Unload Data

X » L

Swap with Reference
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Options

Right clicking on a dataset brings up a menu with several data manipulation
options.

Move to Reference/ Moves the selected data set to either the Reference/In-
Input 1/Input 2 put 1/Input 2.

Annotate (page 0) Allows an annotation to be added to the data details.
Copy Details Copies data set details to the clipboard, from where

they may be pasted into other files.

DICOM Dump (page  Opens the DICOM header information for the selected
304) data sets.

Save Data as (page O Allows data to be saved as DICOM, TRaster, Raw, 4D or

ITK image file.
Merge Data Merges two or more selected data sets into one.
Unload Data Unloads data from VivoQuant.

More Information

Many of the functions in VivoQuant are directed to specific images loaded in the
Data Manager, so it is important to pay attention to the order in which data has
been loaded into it.

See How To Make a Dynamic Movie (page 330) for a practical example that makes
use of the Data Manager.
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Min/Max Tool

The Min/Max Tool allows you to adjust the windowing of visible voxels for the first

three Inputs.

Getting There

The Min/Max Tool is available via the Tools menu.

File View Tools Advanced Modules Help

E@@ =

R - update dis

&, |

p

SrEDNIFBBE

o

/E

Min/Max Tool

View control F5 |® £
MIP control F6 |

Data Manager F7

Min/Max

Histogram Ctrl+Shift+H
Workflow Assistant

Pre-processing

Resample data

Frame Time Editor

DICOM 4
Image & Movie 4
eCRF ¢

Ctrl+Shift+U
Ctrl+Shift+C

Update Check
Configuration

You can also access the Min/Max Tool by clicking on the Min/Max Tool thumbnail

@ in the Main Window (page 209).
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Function

The Min/Max Tool displays the windowing values with units for the Reference,

Input 1 and Input 2. The Display Configuration (page 16) determines whether the
windowing is displayed based on Minimum/Maximum or Level/Width.

‘MM |
Min/Max
Min Max Unit

Reference HU # Reg-calc
Input 1 kBq | % Reset
Input 2 : HU

4, Hist 0 %0 ™ FromPal

% Tool ~}e min ~ max 4 To Pal ¥ Apply

Min/Max Tool Operator

The windowing values allows you to calculate the colors for each voxel in the
Display, via a mapping from voxel values to the colors in the color palette. Any
values below the minimum will return the lowest color (e.g. black in the gray
palette), while any values above the maximum will return the highest color (e.g.
white in the gray palette).

The Min/Max Tool uses a cache feature, whereby minimum and maximum values
for inputs are stored in a cache and used by the color mapping until the user forces
the tool to recalculate them. This enables you to keep the color scale consistent
when working with multiple datasets.

Re- Recalculates the min/max values for all data sets from the original da-
calc ta. Min/max value will be min/max voxel values in dataset.

Reset Resets the min/max values to the values stored in the cache.
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Apply  Stores min/max values in cache and applies values to the datasets.

From Copies the current palette window as set in the Data Manager to the
Pal Min/Max Tool fields.

To Pal Copies the current Min/Max Tool fields to the palette window settings
in the Data Manager.

The buttons with the Cuticon Iﬂ will clip the data based on values in the tool. This
can be useful when trying to clip dense bone from a CT scan, for instance, or
background noise from a PT scan.

Sets all values below the minimum to O.

*0 | (Min)
e Sets all values above the maximum to O.
(Max)
T Sets all values below the minimum to the minimum.
Sets all values above the maximum to the maximum.
=4 max
Histogram

Hist |
The Histogram button" __ “opens the Histogram Tool. This tool generates a
histogram of voxel values in the loaded datasets. For more on this, visit the

Histogram Tool (page 295) page.
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Percentile Tool

| % Tool |
The Percentile button’ ‘brings up the Percentile Tool, which calculates
the pixel value associated with the xth percentile from the histogram of the image.

MM g x
Min/Max
Min Max Unit

Reference HU & Re-calc
Input 1 kBq " Reset
Input 2 N/A

A& Hist + 0 < 0 ® From Pal

% Tool == min = max & To Pal « Apply

Percentile Tool

Selected: 0 v

Percentile: 99.000% = w 271477

B 4+ M ROl FieldofView -~ O Copy To Max

Percentile Tool

Calculates the percentile value for selected image in the drop
. .
down list to the right.
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Shows percentile value with Patient Name, Patient ID, Acquisi-
tion Time, Percentile, Cutoff Value, and Units information from
image metadata.

|E| Loads calculated percentile value into table.
@ Deletes the selected row from the percentiles table.
@ Resets the value in the ROI field to Field of View.

Copies computed pecentile value to the Max value above.
Copy To Max
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Histogram

The Histogram tool is used to plot a histogram of the voxel values in a loaded data
set.

Getting There

The Histogram tool may be reached via the Tools Menu or by using the keyboard
shortcut (page 315) Ctrl+ Shift+H.

File View Tools Advanced Modules Help
= @@ £ View control F5 |® O
MIP control F6
Data Manager F7
Min/Max

it

R - update dis

A

/

Histogram Ctrl+Shift+H
Workflow Assistant

Pre-processing

Resample data

Frame Time Editor

DICOM ’
Image & Movie »
eCRF 4

Update Check Ctrl+Shift+U
Ctrl+Shift+C

Configuration

fEORO-BADN3) HOBE

Histogram

Function

The Histogram tool is operated via two control panels: Data Controls and File
Controls.
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Mk, Histogram ? ;e
Data Controls Histogram Plot
Data set. [BIENE Pk oo s Histogram: 01-CT: CTReco:s
No. bins (100 & (bed removed)
Max  [6193.73 | [@] 600,000 - otore
File Controls 500,000 Al

= 400,000 31}

& Data @ Close

300,000
200,000
100,000 -

0-

1,000 0 1,000 2,000 3,000 4,000 5,000 6,000
HU

Histogram Panels

Data Controls

Data
Set

No.
bins

Min

Max

This pulldown menu allows the selection of the data set to be his-
togrammed.

Sets the number of bins into which to divide the data.

Sets the minimum value for which data will be displayed. The Set but-

ton,lE, automatically loads this field with the minimum value in the
object.

Sets the maximum value for which data will be displayed. The Set but-

ton,lE, automatically loads this field with the maximum value in the
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Histogram
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object.

File Controls

= PDF

K Data

(O Update

@® Close

Saves the existing plot into a PDF file.

Writes the data into a text file. The format is in two
columns with the first column representing bin center
points (x-axis values) and the second column representing
the number of voxels in each bin (y-axis values).

Refreshes the histogram plot. Use this button after chang-
ing the No. bins, Min., or Max. values.

Exits the Histogram Tool.
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Preprocessing Tool

The Preprocessing Tool lets you specify a unique pre-processing protocol and
execute it in one step. There are many preprocessing operations included in the
Preprocessing tool that may be added to the protocol.

Getting There

The Preprocessing Tool is available via the Tools Menu.

File View Tools Advanced Modules Help

=SS = View control F5 ® P
Display MIP control Fb i
Data Manager F7
R - updatedis
x ; ﬁil Min/Max
Histogram Ctrl+Shift+H
Workflow Assistant

Pre-processing

Resample data

Frame Time Editor

DICOM 4
Image & Movie 4
eCRF 4

OBl 3k HEOB

o Is

Update Check Ctrl+Shift+U
Ctrl+Shift+C

’E

Configuration

Preprocessing Tool
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Function
\& Preprocessing ? X
Preprocessing Options Information
[ No Bed Removal Translatior Loaded 2 datasets(2 images)
Co-register Fast 2 Full 30
- . - Dim = 176x176x252
(] Autocrop Vox = 0.20x0.20%0.20 mm
[ calibration factor NM=1.0 kBg z 3
+ CT: SPECT_CT Registration [1001], CTReco:s (bed removed)
[ Resample 0.200 mm = Unit = HU
- OrigDim = 176x176x252
[_J NM/PT Convert unit kBg OrigVox = 0.20x0.20x0.20
Decay elapsed time = 0
Injected Dose Missing Tags = DecayCorrection, DecayFactor, FrameReferenceTime,
(] series Desc Rad\»onuclldeHalfL»lfe/ Rad\onu;l\deCodeSequence,
RadiopharmaceuticallnformationSequence
() Quality Control Image * NM: SPECT_CT Registration [1001], NM Reco NOT-Registered
[ ; — Unit = kBq
sthre et fotnat SO OrigDim = 176x176x352
& o OrigVox = 0.20x0.20x0.20
DOREER00S Decay elapsed time = 0
Missing Tags = DecayCorrection, DecayFactor, FrameReferenceTime,
: RadionuclideHalfLife, RadionuclideCodeSequence,
Repaskacy) RadiopharmaceuticallnformationSequence
Storage:
Project - * CT:Multi-Frame (MF module)

* NM:Multi-Frame (MF module)

Protocol

[ OK Cancel

Preprocessing Tool Panel

The Preprocessing Tool panel is divided into three sections. The first section is the
Preprocessing Options section, which includes the preprocessing operations that
may be included in the protocol.

CTBed Re- Automatically detects the bed position within the image and re-
moval moves the CT voxels which constitute the animal bed. (Only sup-
ports Minerve beds).

Co-register Performs automatic image co-registration of all inputs to the Ref-
erence. If Fast or Full 3D are not checked, then Standard and
Translation are used respectively.

Autocrop Performs automatic cropping. Search for boundaries starts at the
end slices of the image and moves towards the center of the im-
age until a non-background voxel is detected from all 6 faces.
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Applies a scalar multiplication to NM data (PET/SPECT). It is im-
portant to pay attention to the formatting of the input cell. Cali-
bration factors per modality [comma separated] informat -

“Mod=1.0 Unit”. Example: “PT=13456.7 BQML". The case of the

unit should match what is listed in the Information window.

Up/Downsamples voxels to the specified pixel dimensions.

Converts to supported uptake and concentration units. If con-
verting to SUV, please make sure the Weight and Injected Dose
fields are accurate, including their units. The default unit for the
dose is [Bq]. The weight and dose fields will automatically popu-
late with values from the DICOM header, or can be set manually
or from an iPACS datapoint using the VQS functionsetUptakePa-
rameter . If Use Lean Body Mass is checked, the weight will be
corrected using the James or Janmahasatian formulas , where
the Janmahasatian formula is used for BMI greater than 43 for
men and 37 for women. If Use Decay Correction is checked, the
dose will be decay corrected using information about the half-life
and scan times obtained either from the DICOM header or from
values set using the setUptakeParameter function. The Informa-
tion section of the Preprocessing Tool shows the DICOM tags
that are used for decay correction and their values in each loaded
image, including for each frame of a dynamic dataset.

Appends text to end of series description for all datasets.

Generates and stores quality control image of preprocessed im-
age. Results stored in the project webdisk of the repository spec-
ified below.

Saves image data being preprocessed to specified iPACS reposi-
tory below.

Specifies formats in which the data will be saved. The numbers O,
1, and 2 correspond to multi-frame (MF module), multi-frame
(MF function groups), and single frames (one Z slice per file) for-
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mats, respectively. For multiple data sets, formats are separated
by a comma. The current formats of the loaded data sets will be
displayed in this section upon opening the tool as well as in the
Information section.

The second section is Storage Options, where users may designate the iPACS
repository and Project folder where preprocessed datasets will be saved (note:
Store data must be checked).

Repository Specifies the repository. Repositories can be configured in the DI-
COM tab of the Configuration window. See the DICOM settings
(page 28) page for more information.

Project Specifies the sub-project (iPACS) or sub-folder (local path) to
which data will be saved.

Protocol Copies and/or pastes preprocessing protocol settings to be used
at a later time. Modifications can be made directly within the Pro-
tocol window.

Store Store Image data to the specified location.

The final section is the Information section, which features information about the
current state of datasets loaded in VivoQuant. Included in this information is the
image dimensions and voxel size for the datasets as a whole, as well as basic header
metadata about each dataset specifically.

To execute the pre-processing protocol, click OK.
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Resample Data

The Resample Data tool allows for rebinning of reconstructed data into an
arbitrary voxel size. This tool may be useful when attempting to fuse multiple large
data sets, especially when dealing with high-resolution modalities like MRI and CT.

Getting There

The Resample Data option is available within the Reorientation/Registration Tool
via Operations -> Resample, or by navigating to Tools -> Resample Data.

File View Tools Advanced Modules Help

= @@ = View control F5 IO C
Display [E] MIP control F6 |
'@ Data Manager F7
' E Min/Max
M Histogram Ctrl+Shift+H
B W Workflow Assistant
H Pre-processing

Resample data
% Frame Time Editor
< DICOM »
= Image & Movie 4
E eCRF 4

G
4, Configuration

Update Check Ctrl+Shift+U
Ctrl+5Shift+C

Resample Data
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Using the Tool

Upon selecting Resample Data, a small dialog box appears, displaying the current
voxel size and dimensions of the image. Uncheck the Isotropic Voxels box to adjust
the slice spacing. Similarly, uncheck the Auto-compute Dimensions box to adjust
the dimensions of the image. Enter a new voxel size into In-plane Voxel Size and hit
OK to resample the data to have voxels at the new size.

7]
Isotropic Voxels
In-plane Voxel Size: :G.ZIEI{IIDG mm :
Slice Spacing: 0.20000 mm
Auto-compute Dimensions
Sagittal Dimension (X): 176 =
Coronal Dimension (Y): 176 s
Transverse Dimension (Z): 252 =
OK, Cancel
Resample Data Options
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DICOM Tools

The DICOM Tools submenu contains features to aid in the management of DICOM
data.

DICOM Dump

The DICOM Dump tool provides the information contained in the DICOM headers
for DICOM files currently loaded in the Main Window. The DICOM Dump is now
also compatible with . img and . hdr files.

Getting There

There are three ways to access the DICOM Dump. The first method is via the Tools
Menu in theMain Window (page 209).

File View Tools Advanced Modules Help

= @ @ 2. View control F5 If,r) O B eee % -@ E sli
- MIP control F6 |
Display -
Data Manager F7
Min/Max
Histogram Ctrl+Shift+H

Workflow Assistant
Pre-processing

Resample data

~HDSE S&®BE

Frame Time Editor

DICOM : DICOM dump  Ctrl+Shift+D
Image & Movie k Anonymizer

eCRF : Rename DICOM

Update Check Ctrl+Shift+U Relabel Study
Ctrl+Shift+C

s ol

Configuration

DICOM Dump

The second method for reaching the DICOM Dump is to use the keyboard shortcut
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(page 315) Ctr1+Shift+D.

The third method is via the Data Browser (page 46). Right click on a dataset and
click Dump Header.

& Data Browser ? x
Repository - SECURE Study Browser
) Testing 7| | Patients Name  StudyDate StudyDescription  Patient 1D

fanghelall MR Patient 0101... 1970-01-01 12:12 Study 0101 Des... Patient 0101 1D

[Project Filter |

1970-01-01 12:12 CT

Se "..‘ 5 0.
v Series 1. :
7 + Projects: 1746/: e
b3 45 Ima... Image Date Dimensions InstanceMo
- 2 O T .. 1970-01-01 12:12 128x128 0001
Patients Name | i
| O .. 1970.01c ™ Appenddata
Patient 1D:
Description: | | >
Study Date: Al w >
. »
) O Bl Patient 0001...
R Delete Data
Data
Show data type: FileType: dem
(Al data tvoes z
@ e [
Apply default shift

[] Auto-Start reconstructic
[] Foree pl [] Stack 20
# Aopene = Open

Transfer

@ Close | @ Ston

Access via Data Browser

The fourth method is via the Data Manager (page 282). Right click on a dataset and
click DICOM Dump.
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DM 8 X
Data List
L oaded: 3 Memory: 89.33MB 13 N O

Available Data

Maove to Input 1

Move to Input 2

Swap with Input 1

Type: NM - Swap with Input 2
Name: SPECT_CT Registration [1001]

Date: 2010-05-19 18:33:33 (series 2010-05-19 21:03:16) 3‘1 Annotate
Desc: NM Reco NOT-Registered =

Dim : 176x176x252 (176x176x352); Vox: 0.20x0.20 mm = [ eCRF :
- .
_ =5 Copy Details JJI
Type: CT - &) DICOM Dump
Hame: Patient 0101 Name [Patient 0101 ID]
Date: 1970-01-01 12:12:12 (series 1970-01-01 12:12:12) CT Window Presets  »
Desc: Series 1 Description
Dim : 176x176x252 (128x128x252); Vox: 0.200.20mm ( ga iy ;
_ 1
& Merge Data

® Unload Data

Access via Data Manager

Function

Upon activating the tool, a new DICOM dump window opens, showing information
from the DICOM headers for any active datasets. Use the Data set pull-down
menu, in the top-left corner, to choose which set of DICOM header information to
display.
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\& DICOM dump ? X

Data set: 00-CT: CTReco:s (bed removed) =~ Hnd:[ | Find

00-CT: CTReco:s (bed removed) =

(0008,0008) C8 [ORIGINAL\PRIMARY\AXTAL\NANOSPECT]
(0008,0016) UI =CTImageStorage
(0008,0018) UI [1.2.276.0.7230010.3.1.4.3351418413.5184.1476918631.623)
(0008,0020) DA [20100519]
{(0008,0021) DA [20100519]
(0008,0022) DA [20100519]
(0008,0023) DA [20100522]
(0008,002a) DT [20100519205857.000]
(0008,0030) T [183333.405]
(0008,0031) TM [205845.045]
(0008,0032) TM [205857.000]
(0008,0033) TM [150104.312]
(0008,0050) sH [578]
(0008,0000) Cs [CT]
(0008,0070) LO [Mediso]
(0008,0080) LO [inviCRO - SW Department]
(0008,0081) ST ["Rhonda Silva™ - "Software™ ]
(0008,0090) PN (no value available)
(0008,1010) SH (nco value available)
{0008,1030) LO [TopotCT+SPECT_Inlll[bed removed]]
(0008,1032) LO [CTReco:s (bed remowved)]
(0008,1040) LO [Softwara]
(0008,1090) LO [NanoSPECT]
(0008,9124) 8Q (Sequence with undefined length #=5)
(fffe,2000) na (Item with undefined length #=6)
(0008,0023) DA [20100522]
(0008,0033) T™™ [150104.281]
(0008,1070) PN (no walue available)
(0008,1155) UI [1.3.6.1.4.1.12842.1.1.14_2.20100519.205856.85%.337043062]
(0008,2111) ST [HU calibration: slope=635.1, intercept=-1000]
(0018,1020) LO [katchCT]
(fffe,e00d) na (ItemDelimitationItem)
(££fe,2000) na (Item with undefined length #=6)
(0008,0023) DA [20100524]
(0008, 0033) TM [113241.512]
(0008,1070) PN [local:Ey] v

DICOM Dump Window

Enter a search string into the Find field, in the upper right portion of the DICOM
dump window. The DICOM Dump tool uses the DICOM dictionary listed in the
DICOM Configuration (page 28) to read the DICOM header. Each row in the
DICOM Dump represents a DICOM header data entry.

See the dummy DICOM entry below that illustrates the meaning of each field in the
DICOM Dump:

(0000,FFFF) AZ [12\18] # 4,2 VQ DICOM Example

e (0000, FFFF)is ahexadecimal DICOM address where 0000 represents the
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group number for that data entry. Even group numbers correspond to
DICOM defined groups, while odd numbers are reserved for private
groups. The FFFF half of the address specifies the element number for that
particular entry in the group indicated by the first half of the address.

e Atwo-character item of the form AZ identifies the Value Representation
(VR) for that data entry. Several VR types are specified in the DICOM
standard. For example, a Value Representation of US indicates that the
data entry will be in the form “Unsigned Short”.

e The actual data values for the data entry (12,18) are displayed next in the
Value Field (VF). The values are shown inside square brackets.

e After the hash mark (#), the Value Length (VL) for the data entry is
displayed. The VL depends on the VR type and the number of values in the
data entry.

e Some data entries contain multiple subsets as indicated by the Value
Multiplicity (VM). Subsets are indicated by the backslash character in the
data value field. In the example shown above, there are two subsets: 12 and
18.

e The final element of the DICOM entry is the description of the data entry.
For DICOM-defined tags, this field will display relevant information
regarding the content of the dataentry (i.e., VQ DICOM Example).For
private tags, this field will display Unknown Tag and Data.

Anonymizer

The Anonymizer anonymizes the data to the user.

Getting There

Go to the Tools Menu in the Main Window, then to DICOM.
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File View Tools Advanced Modules Help
= @@ 2 View control F5

(] MIP control F6

: {&} Data Manager F7

B ¥ Min/Max

| b Histogram Ctrl+Shift+H
W Workflow Assistant

" K Pre-processing

B Resample data

% Frame Time Editor

Display

DICOM 8
. &5« Image & Movie »
R & eCRF b
. \@ Update Check Ctrl+Shift+U

2, Configuration Ctrl+Shift+C

Anonymizer

Function

Last updated: March 08, 2023

© O Pes K@ G W

DICOM dump  Ctrl+5Shift+D
Anonymizer

Rename DICOM

Relabel Study

Upon selecting the Anonymizer, a dialog box appears prompting the user to decide
whether to anonymize each loaded dataset individually (Yes) or anonymize them

all together (No).

\& DICOM Anonymizer

¥’ individually? If not, the same anonymizat
be applied to all data sets.

Yes

9 Do you want to anonymize each loaded data set

X

ion will

Mo

Anonymize Dataset

In the Anonymizer, header fields can be edited to remove sensitive information,
such as the imaging dates, or identifying text fields. The fields can be edited
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manually or by setting the text to the label of the field and the dates to a new date.
The buttons Text to Label and Dates to Today will fill in these sections as
described. Use the Load Config File button to upload a configuration file. Selecting
OK will apply the changes.

\& DICOM Anonymizer ? X
Data Options
Patients Name SPECT_CT Reglstratlon . Text to Label Dates to Today
Patient ID 1001 | Use " to delete field, % to keep field
Study Description ?Topo+CT+SPECT_~In111[bed removed] | Delete: AcquisitionDateTime, PatientsSex,
: . PatientsAge, PatientsSize, PatientComments,
Series Description |CTReco:s (bed removed) SoftwareVersions, InstitutionName,
Patients Birthdate 20000101 ' éﬁﬁ:ﬁggﬁ:ﬁ;‘:ﬁgmdDepa’tme"mame‘
Protocol Name |CT Helical Scan Load Config File
Study ID |578
Study Date 20100519
Series Date 20100519
Acquisition Date  |20100519
Content Date 20100522
Study Time 183333
Series Time 205845
Acquisition Time | 205857
Content Time (150104
Accession Number :5}'8
Manufacturer 'Mediso
ModelName |NanoSPECT
Referring Physician
Station Name |
Weight o
OK Open Cancel
Edit Header Fields
Rename DICOM Files

Use the Rename DICOM function to rename locally stored DICOM files according
to information from selected fields of the headers.

VivoQuant™ 2022 User Manual Page 310


http://127.0.0.1:4012/vqmanual/images/tools_dicomtools_anonymheader.jpg
http://127.0.0.1:4012/vqmanual/images/tools_dicomtools_anonymheader.jpg

DICOM Tools Last updated: March 08, 2023

Getting There

DICOM files can be renamed by selecting Rename DICOM under Tools -> DICOM.

File View Tools Advanced Modules Help

eSS % View control F5 I,@ O Pes LZEE S
MIP control F6

Data Manager F7
Min/Max

Histogram Ctrl+Shift+H
Workflow Assistant
Pre-processing

Resample data

Frame Time Editor

DICOM DICOM dump  Ctrl+Shift+D
Image & Movie Anonymizer
= eCRF Rename DICOM
Update Check Ctrl+Shift+U Relabel Study
Configuration Ctrl+Shift+C
Rename DICOM
Function

Choose which files to rename by using the Add Files button. Construct new image
names by typing into the Template text box, using the key beneath the text box for
reference. Each token represents a particular field of the DICOM header. The new
names of the selected files will be displayed in the Examples window as they are
entered. Names must be unique for the renaming operation to be successful.
Renaming will also fail if illegal characters, such as backwards or forwards slashes,
are used. To execute renaming, click OK.
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|%F

& Rename DICOM Files

Template

%B=PatientsBirthDate, %D=5StudyDate, %E=AcquisitionDate,
%I=5S0PInstanceUID, %J=StudyID, %K=AcquisitionNumber,
%M=Modality, %0O=ProtocolName, %P=PatientsName,
%S=StudyDescription, %T=5StudyTime, %d=SeriesDate,
Y%e=AcquisitionTime, %i=InstanceNumber, %j=SeriesNumber,
%k=AccessionNumber, %m=ManufacturersModelName,
%o=Manufacturer, %p=PatientID, %s=SeriesDescription,

Y%t=SeriesTime
0 files loaded Add Files
Examples
OK Cancel
Rename DICOM

Relabel Study

The Relabel Study tool allows for the following fields to be edited or renamed:

Patient Name
Patient ID

Study Description
Series Description
Patients Birthday

Protocol Name
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Getting There

Go to the Tools Menu, and then to DICOM.

File View Tools Advanced Modules Help

=SS View control F5
E MIP control F&
Display
Data Manager F7
Min/Max
Histogram Ctrl+Shift+H

Workflow Assistant
Pre-processing
Resample data

Frame Time Editor

@03k EHEG B

DICOM o DICOM dump  Ctrl+Shift+D
&=« Image & Movie ’ Anonymizer
% eCRF ; Rename DICOM

Update Check Ctrl+Shift+U Relabel Study

Configuration Ctrl+Shift+C

;B E

Relabel Study

Function

Upon selecting the Relabel Study option, a dialog box appears prompting the user
to decide whether to relabel each loaded dataset individually (Yes) or relabel them
all together (No).

Enter the desired Data fields to change. Select the desired Repository and Project

to store in the Storage section and click OK, or click Open if no data are already
loaded.

VivoQuant™ 2022 User Manual Page 313


http://127.0.0.1:4012/vqmanual/images/tools_dicomtools_relabelgetthere.jpg
http://127.0.0.1:4012/vqmanual/images/tools_dicomtools_relabelgetthere.jpg

DICOM Tools Last updated: March 08, 2023

\& Relabel DICOM Series ? X

Data Options
[] Keep StudyUID [ | Keep SeriesUID

Patients Name | SPECT_CT Registration

Patient ID 1001 Load Config File

Study Description ' Topo+CT+SPECT Ini11[bed removed]

Patients Birthdate |20000101

|
|
|
Series Description [CTReco:s (bed removed) ]
|
Protocol Name  |CT Helical Scan |

o1 om | oo

Relabel Study
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Keyboard Shortcuts

General Keyboard Shortcuts

Windows / Mac Shortcut Function

Linux Shortcut | Shortcut

Ctrl+0O #+0 Open Reference (page 60)
Ctrl+N ¥ +N Open input 1 (page 62)
Ctrl +Shift+N 38 + Open input 2 (page 62)

Shift + N
Ctrl+D #+D Open DICOM Data (page 46)
Ctrl +1 38 +1 Save Image (page 217)
Ctrl+M ¥ +M Save Movie (page 220)
Ctrl+S ¥} +S Save Data (DICOM format) (page O
F1 fn+F1 Manual (page 418)
F2 fn+F2 Show Reference (page 265)
F3 fn+F3 Show input 1 (page 265)
F4 fn+F4 Show input 2 (page 265)
F5 fn+F5 Slice Control (page 265
Fé6 fn+F6 MIP Control (page 270)
F7 fn+F7 Data Manager (page 282
Ctrl ++ 3} ++ Zoom in (page 258)
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Windows / Mac Shortcut Function

Linux Shortcut | Shortcut

Ctrl +- 3 +- Zoom out (page 258)
Ctrl+0 ¥+0 Normal Size (page 258)
Ctrl+F ¥ +F Full Screen (page 258
Ctrl+U ¥+U Auto Zoom (page 258)
Ctrl+Z #¥+7Z Undo Operation (page 0)
Ctrl + Shift + Z ¥+ Redo Operation (page O
Shift +Z
Ctrl +1 3 +1 Save Image (page 217)
Ctrl+Shift+D 3+ DICOM Dump (page 304
Shift + D

Ctrl + Shift+H *+ Histogram (page 295)
Shift + H

Ctrl + Shift+ U 8+ Update Check (page 339)

Shift + U
Ctrl + Shift+ C *+, Configuration Panel (page 15
Ctrl + Shift + P 8+ Preprocessing Tool (page 298
Shift + P

Ctrl + Shift+W 3+ Worklist Tool (page 323)

Shift +

W
Ctrl+B ¥+B Base NanoSPECT Configuration (page 393)
Ctrl+Q #+Q Quit MMP Calibration Tool (page 393)
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Windows / Mac Shortcut Function

Linux Shortcut | Shortcut

Ctrl+T B+T Toggle between pre- and post-correction images
in the Near-Field Uniformity panel (page 405

- T, «,—,T,1 Scroll through slices in either the Slice View
(page 226) or Tile View (page 230).

PageUp,PageDn fn+ T, Scroll through slices in either the Slice View
fn+ ! (page 226) or Tile View (page 230).

3D ROI Tool Specific Keyboard Shortcuts

Windows / Mac Shortcut Function

Linux Shortcut
Shortcut

N N Navigate to the Navigation (page 102) tabin the 3D
ROI Operator

P P Navigate to the Manual Painting (page 125) tabin
the 3D ROI Operator

S S Navigate to the Spline Tool (page 128) tab in the 3D
ROI Operator

M M Navigate to the Magic Segmentation (page 131) tab
in the 3D ROI Operator

X X Navigate to the Expert (page 145) tab in the 3D ROI
Operator

Shift + = Shift + = Add a ROI (page 920)

- - Reset the active ROI (page 98
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Windows /

Linux
Shortcut

Right Click
of Mouse

Enter

Shift + En-
ter

Space

\Y; F-Yo
Shortcut

Right
Click of
Mouse

T

H

Returnor
Enter

Shift +
Return or
Enter

Space

VivoQuant™ 2022 User Manual
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Shortcut Function

Edit the active ROI (page 93

Toggle visibility of the active ROl (page 100

Rotate through the ROl list in the active ROl drop
down menu

Rotate through the ROl list in the active ROl drop
down menu

Display quantification table (page 122

Display 3D ROI Histogram Tool (page 119

Within the Spline tool, confirm classification of vox-
els within contour to active ROI

Within the Spline tool, confirm classification of vox-
els within contour to active ROl and move to next
slice

Within the Spline tool, scroll through Spline, Free-
hand, Bully and Thresholding tools

Within the Spline tool, clear the currently drawn
contour
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Autoradiography Calibration

You can load, view, analyze and save Autoradiography data using the same tools
VivoQuant uses for in vivo image data. Once loaded into VivoQuant, data can be
reoriented, cropped, rescaled, and quantified.

The Autoradiography Calibration tool allows you to calibrate autoradiography
data based on known calibration standards in the image.

O Note: This tool is available only with a CiQuant Module license. For more
information, contact support@invicro.com.

Getting There

To access the tool, activate to the 3D ROI Tool operator, then go to the Operator
tab in the main menu and select Autoradiography Calibration.

File View Tools Advanced Modules Help
=sSCOSMEDE BMBO T2 O @ee L [E] & wu SliceView ~[Navigation 1 B

Navigation ~
Reorientat...gistration
Cropping

Display

R-up

Projection
Distance/Annotation

File View Tools Advanced Modules Operator Help

sSEMEegoE. B8msC Autoradiography Calibration b [ ]
Quantification Table List 4

Operator - play

L3 © £ A =

DICOM Dump

Function

Once the you start the tool, it asks several questions to establish how it will be
used. The first prompt asks for the number of calibration standards being used. This
determines the number of ROIls that populate the 3D ROI Tool.
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\@ Autoradiography Calibration X
Please specify how many standard values are in the image

110 b

Calibration Standards Prompt

The second prompt asks if there will be a background ROl used. This influences the
calibration curve. In most cases, a background ROl is recommended.

& Autoradiography Calibration X

9 Would you like to specify a background ROI to eventually subtract from the
image?

Yes No

Background ROI Prompt

The ROls are populated based on the answers to these questions. You then need
manually place them in the correct locations in the image. Use the 3D Paint Mode
tools to perform this task. Regions should appear similar to the image below.
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3D Paint Mode

Image Calibration

After segmenting the calibration standards, click Read Values from Image. The
table displays the mean value of each region. Provide the true value of each
standard as well as the correct output unit. Also, choose from the available Error
Weight techniques.

After you have established the settings, click Run. The plot populates with the
values of the standards and provided values along with the calculated fit line.
Changing the settings, particularly the Error Weights, will change the output
calibration curve.

To see how the curve changes with different settings, change them and click Run.
Once the curve fits as desired, click Apply to apply the calibration to the data.
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\& Autoradiography Calibration — a x
- Intensity/Area-Blgd Std. Conc. Recale. Conc. L
Use Fiducial Mame {PSL/mm2) (nCilg) {nCilg) —— . =
M s 524.538 109 104.075 cuptunt  [ncif =
M sz 323187 63 44172 Backyrond: | M Bdomd v |
M sd3 195,131 a9 39.1954 [ ® Resd voes fomImage |
M stds 115314 2 234747 [(9 Resetroze|
M stds 68.5727 16 14.2685 |0 save Table| | B saveriot |
M sde 73.7707 15 15.2023 v
Slope = 5.1 Intercept = -3.9 R2 = 0.996
600 W Data
e W it
500
400
3 ;
a g 300
=
= E
=
BR 200
&
=
100
0
-100
e e T e D T T T T Lo e e Do K e T K 1 1
0 20 40 60 80 100 120
Concentration (nCifg)
Ready for Calbration R |+ Aoy * Run
Image Calibration
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Worklist Tool

Last updated: March 08, 2023

The Worklist provides an interface for viewing tasks created from iPACS
Workflows, completing electronic case report forms (eCRF) and opening data

associated with the tasks.

Getting There

There are three methods to open this tool. The first method is using the Worklist

thumbnail & in the Main Window (page 209).

The second method is to go to Worklist under the Tools menu.

File View Tools Advanced Modules Help
= @ ! - View control F5 3 C
] MIP control F& ]
ﬁ:f} Data Manager F7
i Min/Max

Display

Ak, Histogram Ctrl+5hift+H

W Worlflow Assistant

B Pre-processing Ctrl+5hift+P

B Resample data

% Frame Time Editor

4z DICOM

e Image & Movie b
Worklist Ib Ctrl+Shift+W

2, Configuration Ctrl+Shift+C

Worklist

Finally, the Worklist is also available by using the keyboard shortcut (page 315)

Ctrl+Shift+Ww.
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Select Project

Worklist - Select Project n
Repository
iPACS |invicro-dev -
Filters
Project | fautomatedtests/worklist_tests i
automated O
Filters | <Mo Filter> O

All Medical Reader Tasks

All Waorkflow Tasks

All Workflow Tasks[= 24 Hours)
All Workflow Tasks[Last Week]
Eligibility Lead

Image Analysis I}:}

ncel

Image QC
Initial Review

Medical Reader

Select Project

The first step in using the Worklist is to select an iPACS project. Any of the iPACS
repositories that have been added in the Data Browser are available to use for the
worklist in the iPACS dropdown. The project can be selected using the Project
dropdown, which can be filtered the same way as in the Data Browser. The Filters
dropdown allows the user to filter the worklist results by task type, using the same
options available in the Task List on the iPACS.

Once a project and task filter have been selected, the tasks assigned to the current
user will appear in the task list panel. The current user is the user whose
credentials were used to login to the iPACS in the Data Browser. The task list can
be refreshed at any time using the refresh button, and the current project and filter
can be changed using the settings button. Clicking on a task opens the Task panel,
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which displays images and files associated with the task organized in tabs based on
their type.

Worklist ®
List
To Review: 3 Total: 3 {1 O
Patients Name Patient 1D Site Timepoint Category Task Process Blocked Created Date

555-5555 555-6555 AutomatedTestSite Visit15  TracerA Review Submission InitialReview Mot Blocked 2023-02-22T721:36:47.000+0000
000-0003 000-0003 | AutomatedTestSite | Visit 21 Tracer B |View Results (QC) ImageAnalysis Mot Blocked 2022-03-08T15:26:458.000+0000

000-0002 000-0002  AutomatedTestSite  Visit 15 Tracer B |View Results (QC) ImageAnalysis Mot Blocked 2022-03-08T15:21:54.000+0000

Task
MName Type Size
* DICOM dir -
* 1.3.6.1.41.128421.1.14.3.20100526.145653.234 3400598378  dir -
* 1.2.276.0.7230010.3.1.4.1320430289.5556.1579291793.414 dir -
1.dcm application/dicom 1196548
| # Append » Open
DM | Worklist

Task Viewer

The Append and Open buttons open or append the data associated with the task in
the data list and open the task’s associated eCRF form. The user can view and
interact with the data in VQ and complete the form in the eCRF window. After the
form is submitted, a popup window indicates whether the submission was
successful and a refresh of the task list will show that the task is no longer assigned
to the user.
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Complete Task

Is there increased uptake in the frontal lobe? *

Comments

Username *

fwood

Signature *

-4 Submit

Ol 100%

eCRF Viewer

Depending on the type of task, different tabs will be enabled in the Task panel. For
submission tasks, the data appears in the Submitted tab. Once a submission task is
completed and a task has data indexed in the browser, its data appears in the
Dicom tab. For tasks that have files associated with them, which will appear in the
Files tab of the task viewer, the right-click menu provides the “Open Externally”
option for opening files using the system’s default application for that file type.
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Task
_- Files Analysis Results -
Mame Type
invicraMouseAtlas-Regions.csy text/csy
invicroMouseAtias-Regions. bt text/plain
invicroaMouseAtias-Regions xlsx applicationivnd.openxmiformats-officedocu
invicroMouseAtlas. json application/json
invicroMous eAtlas. nii applicationfoctet-stream
invicroMouseAtlas.rmha image/roi-data
k logs dir
L | ¥
Files Tab

Files that appear in the Files tab that can be opened in VivoQuant, such as images
and RMHAs, can also be opened in VivoQuant using the Open and Append buttons
and the Open and Append options in the right-click menu. Choosing this option for
an RMHA will open the 3D ROI Operator and load the RMHA file.

For tasks that are the output or result of an iPACS pipeline, the Analysis Results
tab will be available. The Analysis Results tab shows the JSON output of the
pipeline in an expandable tree format. The JSON can be downloaded as a file or
copied to the clipboard using the right-click menu.

Task

_- Files Analysis Results -

Analysis Results s
error
* input_patients

¥ 0
autput DummyPipeline posted this datapoint
* params :

category
center_name AutomatedTestCenter
context scan
context_obj_uuid dfff4b¥a-5db8-11ec-894da-3bf489a07 3202
creator fwood
executionld 18a6cc01-5dba-11ec-b839-0242ac1d00 ... =
hamAla ~rrare b |
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Analysis Results

The Reports tab contains PDF file reports which can be opened using the right-
click tab similarly to the Files tab.
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Image Magick

Use the Image Magick suite to manipulate frames and movies within VivoQuant.
These options are useful for generating appealing and informative dynamic movies.

Getting There

Select the Image and Movie option of the Tools menu.

File View Tools Advanced Modules Help

=SS 2= View control F5 O Pee K @- E
i %] MIP control F6 |
Display = ‘

'E} Data Manager F7
WM Min/Max

Histogram Ctrl+Shift+H
Woaorkflow Assistant

Pre-processing

Resample data

Frame Time Editor

DICOM

Image Magick

Function

Image & Movie
eCRF

Ctrl+Shift+U
Cirl+Shift+C

Update Check

Configuration

Split movie into frames
Join frames to movie
Change movie delay

Image to Capture

The Image Magick options available in VivoQuant provide an excellent tool for
generating informative movies for dynamic and gated data acquisitions. These
tools allow you to combine datasets in meaningful ways to reflect the dynamic

nature of the physiological processes taking place.
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The Image Magick suite provides four options:

e Split Movie into Frames
e Join Frames to Movie
e Change Movie Delay

e |mage to Capture

Split Movie Into Frames

This option takes a movie file (options include . gif, .mpg, .mng, and . mpeg) and
splits it into individual frames (options include . png, . bmp, . jpeg, . jpg, and
Ltif).

Join Frames to Movie

This tool allows you to take individual images (options include . png, . bmp, . jpeg,
.jpg, and . tif) and combine them into a movie file (options include . gif, .mng,
.mpg, and . mpeg).

Change Delay

Depending on the size and style of the movie taken, the default frame time may be
too fast or too slow. This tools allows you to select a pre-existing movie and change
the frame time (in milliseconds).

Image to Capture

The Image to Capture feature allows you to load an image or movie from a file on
the local machine, edit it, and then re-save it. The Capture Viewer also supports
importation of the image/movie into a DICOM/iPACS repository by using the Save
Capture button.

How to make dynamic movies

Dynamic and cardiac-gated images and movies are useful for illustrating the
changing distribution of radioactivity governed by a dynamic physiological process.
This guide provides step-by-step instructions on the proper generation of such
files. Use the links to visit the VivoQuant Manual for more details on any particular
feature.
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Before using this guide, it is important to understand how to process images so that
they are color-comparable across multiple frames. Matching color scales between
two images is not enough to ensure that they are directly color-comparable.
Instead, it is necessary to ensure that the colors in each loaded correspond to the
same physical voxel values. You can achieve this relationship using the Min/Max
tool to define the range of voxel values spanned across the color bar.

Load all relevant data sets. These data sets may be only SPECT images (as in this
example) or areference CT in addition to multiple SPECT images.

& Data Browser

Repository - SECURE

(O Testing -
 [anghela01 =
[Project Filter

7 |+ %\ Projects: 1746/

L IRE 200

Filter

Patients Name

patient>: | |

Description: :

Study Date: Al x
» O

Data

Show data type:

All data tvoes =
@ = "3

Apply default shift

Auto-Start reconstructit

[] Force pl [ ] Stack 3D

®» Appent  *» Open

Transfer

@ Close | | @ Ston

Study Browser

Patients Namg

bl Patient 0101 Name
Patient 0011 Name
Patient 0004 Name
Patient 0003 Name
Patient 0001 Name

vV VvV v

StudyDate

1970-01-01 12:12
1970-01-01 12:12
1970-01-01 12:12
1970-01-01 12:12
1940-06-06 12:12

StudyDescription Patient ID
Study 0101 Des... Patient 0101 ID
Patient 0011 ID

Patient 0004 ID
Patient 0003 ID
Study 01 Descri... Patient 0001 1D

Load Relevant Datasets

Adjust the Zoom (page 258) and Color Palettes (page 265) to your liking.
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File View Tools Advanced Modules Help

=COMADE SBMSOE O O &ee L [EH v sliceView - Navigation -l B louickseripts - % @ @
DM & x  Display

Data List R-update disablgd Wk
Loaded: 4 Memory: 166.38MB % * O

Available Data

Type: CT
Mame: SPECT_CT Registration [1001]
Date: 2010-05-19 18:33:33 (series 2010-05-19 20:58:45)

Dese: C (bed removed)

Dim : 1 52 (176x176:x252); Vox: 0.20x0.20 mm
T 3.5e+09
Type: NM

Mame: SPECT_CT Registration [1001]

Date: 2010-05-19 18:33:33 (series 2010-05-19 21:03:16)
Desc: NM Reco NOT-Registered

Dim : 176x176x352; Vox: 0.20x0.20 mm

—— 0072

Type: PT
Hame: Moused_IV4T1A~~~ [Moused_IV4TL]
Date: 2015-11-17 07:56:58 (series 2015-11-17 07:56:58)
Desc: 20151117_Mouse4_IVAT1_FDG_1hrost - F18_10min_static -
Mouseq_IV4T1

F— 1.01e+07

Type: PT
Hame: Mouse4_IV4T1~~~~ [Moused_IV4T1]
Date: 2015-11-17 07:56:58 (series 2015-11-17 07:56:58)
Desc: 20151117_Moused_IV4T1_FDG_1lhrPost - F18_10min_static -
Moused_V4T1

Fr— 1.01e+07]

Resampling images to reference image took 0.5 sec

Adjust Zoom and Color

Use the Cropping Tool (page 192) to select the region of interest.

File View Tools Advanced Modules Help

sgeMaoE BmS08t® 2 B L [EE up SiceView -|Cropping - B lquickseripts -] % O @
Operator & x  Display
Cropped Area
¥4 Y. z
From 31 < |80 2| [102 £
To 13 < 132 =198 o
Embed 1786 < 176 > |352 e
Information
Voxel mm
Qld size 176x176%352 35.2%35.2%70.4
New size 83x73%95 16.6%14.6x19.0
Auto crop
0 - » Set
O v

Resampling images to reference image took 0.5 sec

Cropping

If desired, use the Filtering Operator (page 199). Note that if you check Input 3 and
higher in the Select pull-down menu of the Filtering operator, then smoothing will
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be applied to loaded data sets not displayed in the Main Window (page 209), but
visible in the Data Manager (page 282).

File View Tools Advanced Modules Help
=COMAEOE B0 P O & L [ {8 i Sice View -|Filtering - B |auicksepts -1 % O @
Operator & = Display

Data

Selected: 0,1.2.3 =
Append data All
[+]0. CT: CTRecoss (b...|
[[] update within ROl D [£] 1. NM: NM Reco .
[ 2. PT: 20151117 ...
Smoothing [+ 3. PT: 20151117_..

Gauss

X FWHM (mm) [1.40000 %]

Y FWHM (mm) 1.40000 <

ZFWHM (mm) 1.40000 &
Anisotropic [_]

Resampling Images took 9.7 sec

Filtering

One of the most critical steps is the application of the Min/Max Tool (page 290).
First, use the Re-Calc button to display the current minimum and maximum values
used for color scaling. Choose common Min/Max values across all three data sets.
Use the Apply button to adjust the color scaling accordingly. The three visible data
sets are now color-consistent: the same colors represent the same voxel values
across each data set.
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File View Tools Advanced Modules Help

= @ @ m ‘:; &) e EEMDEU BTENPO P P oy ;% @ @ E Slice View -~ Navigation b B Quick Scripts - '} D @
MM & x  Display
Min/Max
Min Max Unit

Reference -1000 6193.73 HU # Re-calc
Input 1 0 0.0793037 kBg 4 Reset
Input 2 0 122544 BQML

ok, Hist 0 %0 #» From Pal

% Tool ~ min % max 4 To Pal « Apply

Resampling Images took 9.7 sec

Min/Max Tool

Save images for each data set using the Save Image (page 217) option. The All s
separately option in the Storage Type pull-down automatically saves five images
(sagittal, coronal, transverse, MIP, all-in-one) simultaneously.

=CESUEeEDE BBMEOF L © Pee LEH Wi Slice View ~|Navigation = a QuickSeripts ~ % @ @
MM &
(e Look in: C:\Users\luana\Documents\DEMO 2 O © L;]a @ @
™ My Computer Name : Size Type Date Modified
Reference 2 luana
Input 1
Input 2
ok, Hist
% Tool
File name: [ Save
Files of type: Image files (*.png *.jpg *.bmp *.gif *.tif) - Cancel
Image type: All images separately <
Colorbar options  none <
Storage Type DICOM Secondary Capture %
Magnification 1 2

Resampling Images took 9.7 sec

All Images Separately

Use the Slice Control or appropriate Keyboard Shortcuts (page 315) to toggle
between visible data sets and save the appropriate images.
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After collecting the images for the first three frames, use the Data Manager to save
these processed frames (if desired) and then unload these data sets so that the next
three frames in the queue become visible data sets. All operations (such as
Cropping, Projection, and Smoothing) applied to the original three data sets are
also been applied to the queued data sets, with the exception of the Min/Max tool.

File View Tools Advanced Modules Help

=SSl AaoE BSOB8a L O 8 2 [E & psiceView -|Navigation - R auickserpts -\ O @

DM & x  Display
Data List 5

Loaded: 2 Memory: 43.64MB % A O

Available Data

DEMO [DENO]

e |
aonad

|

Resampling images to reference image took 0.2 sec

Slice Control

Ensure again that the minimum and maximum values are consistent across
datasets, so that the newly loaded data sets are properly prepared. Save the images
and data as described above.

After saving all desired images, generate the dynamic movie using the Join Frames

to Movie (page 330) option.

VivoQuant™ 2022 User Manual Page 335


http://127.0.0.1:4012/vqmanual/images/tools_imagemagick_slicecontrol.jpg
http://127.0.0.1:4012/vqmanual/images/tools_imagemagick_slicecontrol.jpg

Image Magick Last updated: March 08, 2023

File View Tools Advanced Modules Help
- @ @ View control FS D O B e
: MIP control F&
Display
Data Manager F7
Min/Max

IRy

i

[R- update dis

& |

Histogram Ctrl+Shift+H
Workflow Assistant

Pre-processing

Resample data

Frame Time Editor

DICOM :

Image & Movie g

O B e E s

Split movie into frames

&

eCRF 4 Join frames to movie

Update Check Ctrl+Shift+U Change movie delay
Configuration Ctrl+Shift+C Image to Capture

H /&

Join Frames to Movie

Select the images you wish to include in the movie.
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& ImageMagick: Select Frames X
1 > This PC » Documents » DEMO v U 2 Search DEMO
Organize ~ New folder - M @
2 = Frame1-all.png & Frame3-sag.png
& Frame1-cor.png & Frame3-tra.png
% This PC =5 :
|& Frarmel1-mip.png
B 3D Objects /& Frame1-sag.png
I Desktop & Frame1-tra.png
‘4 Documents & Frame2-all.png
4 Downloads |&] Frame2-cor.png
D Music & Frame2-mip.png
e -
&= Pictures S TareE
|&| Frame2-tra.pn
E Videos :

i| Frame3-all.png.jpg

£3 Local Disk (C) & Frame3-cor.png

¥ Network & Frame3-mip.png

File name: i"FrameS—aII,png.jpg" “Frame1-all.png” "Frame2 ~ | Image files (*.png *.bmp *,jpeg ~

Select s

Type in a name and choose a format type for the movie file. The default file format
is.gif.

Finally, use the Change Movie Delay (page 330) option to speed up or slow down
the movie frame rate.
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File View Tools Advanced Modules Help
) @ @ £ View control F5 D O B e
MIP control F6
'E' Data Manager F7
0 Min/Max

M, Histogram Ctrl+Shift+H
W Workflow Assistant

E Pre-processing

filf Resample data

% Frame Time Editor

=
10

Display

R - update dis

& < DICOM v
Image & Movie ¥ Split movie into frames
[ eCRF : Join frames to movie
\@ Update Check Ctrl+Shift+U Change movie delay
%, Configuration Ctrl+Shift+C Image to Capture
- C —

Change Movie Delay
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Update Check

VivoQuant is frequently updated to provide more and better tools for all post-
processing needs. Therefore, periodic Update Checks are recommended to ensure

that you have the latest software available.

Getting There

There are two methods to access the Update Check function. The first method is
through the Tools menu.

File View Tools Advanced Modules Help
View control F5 2
MIP control F&

Data Manager F7

Min/Max

= OG =
Display

[} - update dis

Histogram Ctrl+Shift+H
Workflow Assistant

Pre-processing

Resample data

Frame Time Editor

DICOM r
Image & Movie k
eCRF 4

Update Check Ctrl+Shift+U
Configuration Ctrl+Shift+C

‘O rHEDSE EHBBI

5 0
-

V-

Update Check

The second method is to use the keyboard shortcut (page 315) Ctrl+Shift+u.

Function

If an update is available, the Update Check will present a window providing an
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option for downloading the new version. You may either choose to download, by
clicking on Yes; not to download, by clicking on No; or to ignore entirely, by clicking
onIgnore.

& Update Check X

e' A new version of VivoQuant is available:
' " Installed: 2.50alpha8

Update: 2020patch1hf2

Would you like to download the new version?

Please note: Your ability to upgrade this product may be subject to a valid service
contract!

Yes Ignore No
Update Options

If you download the new version, you will be prompted to follow several
straightforward installation steps. For more information on installation, see the

Installation (page 4) section of this manual.
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Advanced Modules

The Advanced Modules Menu contains a wide range of tools available for a variety
of post-processing applications.

e Plug-In Modules (page 342
o Multi-Atlas Segmentation Tool (page 343)
o 3D Brain Atlas Tool (page 350
o Pharmacokinetic Modeling (page 351
e NanoSPECT (page 378)
o QuantiCalc (page 379)
o Specific Activity Calculator (page 382
SUV Calculator (page 385

[e]

e}

Crosstalk Removal (page 387)
o Biodistribution Visualization (page 389)
o Split Projections (page 392

e Calibration (page 393

o CT Geometrical Calibration (page 394)
o MMP SPECT Calibration (page 397)
o Near-Field Uniformity QC (page 405

e Dosimetry Calc (page 410)
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Plug-In Modules

VivoQuant™ offers a variety of additional Plug-in Modules in addition to the base
license. These are accessed through the Advanced Modules Menu.

e Multi-Atlas Segmentation Tool (page 343)
e 3D Brain Atlas Tool (page 350

e Pharmacokinetic Modeling (page 351

For more information on the inviCRO’s Advanced Segmentation Tool Kit, please
contact your inviCRO representative or email support@invicro.com.

You can also access a helpful How To illustrating the main features of the 3D Brain
Atlas Tool by going to Tools -> Workflow Assistant and selecting the 3D Brain
Atlas Analysis Tool workflow.
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Multi-Atlas Segmentation Tool

Overview

The Multi-Atlas Segmentation Tool generates ROIs by registering a series of
images in a Reference Library to the image that has been loaded in the Data
Manager (page 282). The Reference Images must each have a corresponding ROI.
The tool registers the images in the Reference Library to the loaded data, and
applies the same transformation to the corresponding ROI. The tool then works on
a voxel-by-voxel basis, classifying a voxel to the new ROI if a greater percentage of
the reference sets classified that voxel as within the ROl than the threshold
percentage set by the user. Important factors that influence performance include
image contrast, animal positioning consistency, and the size of the reference
library.

Probability
1.0

- 0.5

0.0

Image ROI
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Getting There

You can access the Multi-Atlas Segmentation Tool by navigating to Advanced
Modules -> Multi-Atlas Segmentation. Here, there are three options: Multi-Atlas

Segmentation (page 346), Add to Library (page 344), and Download Sample Library
(page 348).

File View Tools Advanced Modules Help
= @ @ W (2 NM NucMed P O B e g .@- E Slice
H v

Display el

R-upd ;jte disabl
T . Bed removal

Multi-Atlas Segmentation Multi-Atlas Segmentation Tool
3D Brain Atlas Tool Add To Library

fMRI Tool Download Sample Library
Install Atlas

Split ROI to DICOM
Dosimetry Calc

Multi-Atlas Segmentation

Adding to Reference Library

The Reference Library is the basis of the efficacy of the Multi-Atlas Segmentation
Tool. The Reference Library is stored locally, and is built in one data set at a time.

The first step in adding a data set to the Reference Library is to open the data and
ROLI. In order to add to the Library, there must be an active ROl in the 3D ROI Tool.
There can be multiple ROls, but it is important, when building the Reference
Library, to keep the naming of ROls consistent; that is, if the organ of interest is the
left kidney, always call it exactly Left Kidney, otherwise, it will not be
recognized as all the same organ (however, capitalization does not have an affect).

With the data and ROl loaded simply navigate to and click Add to Library as
described above. The GUI will appear.
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Multi-Atlas Segmentation Tool

\& Submit All Images to Library?

Image to Submit:
Patient ID: 1001

cT

Protocol: 9

Reference -

Species: Mouse x
Repository: W Local -
Project:

Proj Filter:

OK

Cancel

Add Reference to Library

The GUI offers four editable fields:

Last updated: March 08, 2023

Image This option allows you to select which of the loaded images to sub-

to Sub-
mit

Patient

mit to the Reference Library.

The Patient ID can be anything that is unique and will help you iden-

ID tify this data set when selecting which scans to use from your Refer-

ence Library.

Protocol The Protocol should include information as to how the image was ac-
quired, the field of view, modality, etc. This will be used as a filter to
determine which scans from the Reference Library will be used by

the tool.

Species

The Species dropdown list contains frequently imaged species. If you

wish to have additions made to the options provided please contact
your Account Manager or support@invicro.com.
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Segmenting With The Tool

With the image on which the new ROl is to be drawn loaded in the Data Manager,
open the Multi-Atlas Segmentation Tool. You can apply the segmentation settings
and perform other tasks from the tool’s GUI.

[F8 Multi-Atlas Segmentation Tool ? >

File Library Parameters

Settings Select Images Log
Number of Subjects = 0
Using less than 3 subjects could lead to poor

General  Registration  Advanced

Repository: | Local - O performance.
Project: r Use Patient ID
Proj Filter:

Image: El = Species: #

Auto ~| Sensitivity Threshole 0.50 =

Vox Low: Vox High

Libraries:

[Roaming\inviCRO\VivoQuant/WBAtlas| ...

Include Protocol

ROIs:

To Segment ROl Name

Reload Library Refresh + RUN

Segmentation Tool

Settings

The tool relies on the settings you select. There are two levels of settings, the Basic
Settings, explained below, and the Advanced Settings, which should not need to be

modified.
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Basic Settings

The Basic Settings tab contains most of the settings that will need to be changed.
Here, you can select the appropriate Reference Images, the appropriate Test
Image, ROls to segment, and Probability Threshold to use.

Reference List Selection

Selecting the proper Reference scan is imperative to the proper functionality of the
tool. The settings you select that factor into the images used are outlined in the
table below:

Image The image in the Data Manager that will be the basis of the ROls
generated.

Species The species of the animal being segmented. This is based on the
available options in the Reference Library.

Voxel The Low and High parameters for the voxel size of the Reference

Size Images available. The default low is 0. 00mm and the default high is
the voxel size of the data loaded. Using Reference Data with a low-
er resolution than the data that has been loaded will compromise
the quality of the Reference ROI.

Protocols Alist displaying the protocols present in the Reference Library.
Changing the protocols included will narrow the Reference List.
Only include Reference Images with the same protocol as the im-
age loaded in the Data Manager.

ROls A list displaying the possible ROIls to generate based on those pre-
sent in the Reference Library. Only those selected will be generat-
ed by the Tool.

Other Basic Settings

You can also edit the Probability Threshold. Following the registration of each
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Reference Image to the image in the Data Manager, each voxel is assigned a
probability that it belongs in the ROI. Only voxels with a probability greater than
the threshold you set will be mapped to the ROI. The default for this setting is 0. 5;
and, typically, the ROl will become larger as the threshold is lowered.

Select Images

The middle pane of the GUI allows you to select which images to use for the final
Reference List. These should already have been narrowed down by your previous
selections in the Settings pane. It is up to you how many Reference Images to use.
However, the time the tool takes to runiis largely influenced by how many
Reference Images are selected.

Run Tool and View Log

Once the Settings and the Reference Images have been selected, click Runin the
lower right corner of the GUI to run the tool. The Log outlines the steps taken by
the tool. At its completion, the tool remains open, but VivoQuant navigates to the
3D RO Tool, where the new ROIs can be viewed and modified.

Downloading Sample Library

A sample Reference Library is available depending on the VivoQuant license. This
optionis used for testing and learning how to operate the tool. To download it,
navigate to Advanced Modules->Multi-Atlas Segmentation->Download Sample
Library.

File View Tools Advanced Modules Help

s OGS G M NucMed P O Poeee K (K 5} wuSlice
o CT v o

MR MR

Bed removal

Display

Multi-Atlas Segmentation Multi-Atlas Segmentation Tool
3D Brain Atlas Tool Add To Library

fMRI Tool Download Sample Library
Install Atlas

Split ROI to DICOM
Dosimetry Calc
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Download Sample Library
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3D Brain Atlas Tool

Overview

Use the 3D Brain Atlas Tool to perform brain region analysis. The tool can handle
CT or MR data as the input and MR, PET, or SPECT for the input functional data.

Instructions for the use of the tool are available through the Workflow Assistant,
which can be accessed via the Tools menu.

File View Tools Advanced Modules Help

=sQOMA®OE BBMEBOE N L © @ L [E] & i SiceView ~|Navigation - 12 |Quick Scripts ~ »
Workflow # x  Display
3D Brain Atlas Analysis Tool - O

- Introduction -

- Install Atlas ! ’

- Prepare Image Data
- Prepare MR Image Data

T

Introduction e

The 3D Brain Atlas Analysis Tool is designed for automatic
segmentation of brain image data. Automated fusion routines
register an application-specific brain atlas to pre-clinical image data
(or vice versa) and advanced statistical analysis methods are
employed to provide rapid and thorough region-specific volume
and uptake quantification. SPECT_CT Regishation

Workflow Assistant

O Warning: Please use caution when scaling data in this tool, as this can lead to
errors in quantitation. For more information, refer to the Treatment of
Quantitative Data (page 0) page.
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Pharmacokinetic Modeling

Pharmacokinetic modeling is available in VivoQuant as a plug-in for the
Modeling operator. Access to the plug-in depends on your VivoQuant
license. For information on your license, please contact your account

manager or email support@invicro.com

Getting There

The Modeling operator can be accessed via the tool pull-down menu on
VivoQuant’s front panel.

File View Tools Advanced Modules Help

=esSSM @ & WM T s » = [E & e Slice View ~|Navigation -
; Navigation A
Display Reorientat...gistration

Cropping

3D ROI Tool
Projection
Distance/Annotation

Arithmetics
Time Series
Filtering

= _irivicro Mouse |_HeadScon, 1]

Modeling Operator

Function

For more on the function of the Modeling operator, see the Modeling (page 206)
operator page.

Input/Reference Function

Every tissue model requires the input of an additional temporal curve, either as an
arterial input function or concentration of a reference tissue. These temporal data
may be derived from image data directly or from acquired samples. The operator
supports input and computation of parent fraction samples, plasma fraction
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samples, whole blood concentration, and plasma concentration. In addition, these
data can be stored and retrieved from disk and from an iPACS.

Parent/Plasma Fraction

The experimentalist may have acquired blood samples throughout the subject’s
scanning session. From these samples, the ratio of unmetabolized tracer to the sum
of unmetabolized tracer and its derivative metabolites can be measured and used
to account for the dynamic nature of available tracer. This is also known as the
parent fraction or plasma free fraction. Without it, the tissue model must assume that
metabolism of the tracer is negligible. Whether measured, simulated, or estimated,
the parent fraction can play an important role in accurate estimation of tissue
kinetics downstream. Similarly, the fraction of plasma to whole blood (including red
blood cells) has been shown to be an important factor in the estimation of an
appropriate arterial input function [1] (page 353). The fraction modeling can be
selected from the dropdown of models or from the Operator menu.

Fraction 3-Exp. e
® e ™
Time Points (table rows). [ |2
/ 14 M Data W Fit
Fit start (10): |3 20 min + Estimate t0
Param (Unit) Fit?  Value LowerBnd Upper Bnd 0.9:
A ] inf
_ 0.8
Bi(min) 0 inf
A2 0 f
- 0.7 ]
B2 (min) 0 inf
A3 0 inf % 0.6
0 [in

B3 (min) inf

0.5

@ ROIs & Savelnterp & Save Fit « Run

Use Time (min) Fraction D 04

32 0.9923...
0.3

B~

0.9572.,

&
e

0.4894.., 0.2 -
r T T T T T T 1

0.2365... 0 10 20 30 40 50 60 70
Time (min)

&
w
g

1]
B
]

02222

Al =0.2179 +/-260.9%, B1 = 454.4 (min) +/- 2488%, A2 =0 +/-inf%, B2 = 11.25 (min) +/- 2.679e-08%, A3 = 0.8947 +/- 427.6%, B3 = 6.715 (min) +/-
Operator VC DM 172.2%, MSE =0.0002418, AIC =-122, BIC=27.41

Fraction Modeling

Both plasma and parent fraction data can be input using the same tool. Towards the
bottom of the operator, space is provided for a table of fraction data. There are 3
columns. The first one can be used to exclude specific time points from the table.
The second column contains the time of each sample in units of minutes. The last
column contains free fraction values, assumed to have a value between zero and
one. Users can choose to use a linear interpolation of the points or fit a sum of
exponentials to the provided points. The Save Interp button can be used to save
the points as is, at which point the tool will prompt the user for a name to give the
saved curve. If this option is chosen, the operator will prepend a value to
time=zero, assuming that the fraction is equal to one at that time. After the last
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provided time point, the value is assumed to remain constant equal to the last
fraction value.

Users may want to smooth the fraction points with a sum of exponentials. Up to 3
exponentials can be used to fit the curve. If less exponentials are desired, users can
fix model parameters for one or more of the exponentials (i.e. fix A3=0 and B3=0)

2] (page 353). To do so, use the Run button to estimate model parameters under
the input conditions provided by the user.

A Important: Use the Estimate tg button to estimate the start point for the model.

Once you are satisfied with the model estimates, click on Save Fit while the
estimate plots are open to save the current model-estimated fraction curve to the
list.

f(f. A1, By, Ao, By, As, BB) =
Aje P 4 Ape P 4 4z P
Where:

fo—1

f(t <tp) =min(1,1+ 7
0

)

f(t = to) = full model

Model Assumptions

This model makes the following assumptions:

e The exponential decay begins at user-provided tO

e Provided fraction measurements lie between zero and one

References

[1] “Red blood cells: a neglected compartment in pharmacokinetics and
pharmacodynamics”. Hinderling. Pharmacol Rev, 1997. Link .

[2] “Optimal Metabolite Curve Fitting for Kinetic Modeling of 11C-WAY-100635".
Wu, et al. INM, 2007. Link .
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Arterial Input Function

An Arterial Input Function (AIF) is required for Logan, Patlak, 1- and
2-tissue compartment, and MA1 analysis. To add time points to an AlF, begin by
selecting Blood/Ref 3-Exp from the list of models.

| Blood/Ref 3-Exp. - Blood/Ref 3-Exp. v

Fraction 3-Exp. ol PRl Time Points (table rows): [p =
i -

Logan Reference Plot

Patlak Plot 1~ Parent Fraction: 1 «

SRTM -

SRTM2 P Plasma Fraction: |1 »

2TCM : _ " _

1TCM | Estimateq| F1st3m(t0)- |3.20 min <] Estimate t0
MAA1 v 5 s

S CUTICETrETOT U BOML Concentration Unit  gamL v

Arterial Input Function

Similar to the parent fraction, users can select to save a linear interpolation of
points or a smooth model estimate of AIF samples. Either way, samples should be
input into the table of values as a first step. This may be done with a copy/paste
from an external spreadsheet program or by incrementing the Time Points (table
rows) number and manually editing the table. The table assumes a structure with
the number of rows equal to the number of samples. Each sample has three
columns. The first column indicates whether that sample should be excluded or not.
The second column contains the time (in minutes) at which sample was measured.
Times should be consistently relative to the same reference start time as the final
modeled time activity curves. The third column contains the measured
concentration value at that time. If parent or plasma fraction data are available and
applicable to the provided samples, select them from the dropdown. If none is
selected, the fraction is assumed to be one for the entirety of the time activity
curve. If image derived samples are desired, the user may also compute the samples
directly from the average concentration values with ROls in the loaded image. To
do this, select the appropriate region from the dropdown and click on the *Compute
IF button. For more information on segmenting regions of interest from an image,
see the 3D ROl tool.

A Important: Select a unit of concentration for the samples. By default, this
dropdown will be set to the unit of the loaded image data.
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If a sum of exponentials model for the samples is desired for smoothing the data,
click on Run to estimate exponential parameters for the data. Before doing so, it
may be important to select an appropriate to value. This is best estimated from the
samples themselves with the Estimate to, which will set to to the time point where
the maximum concentration occurs in the samples. The linearly interpolated
samples or model fit may be saved for use in tissue modeling with the Save Interp
or Save Fit buttons, respectively.

Reference Tissue Compartment

The reference tissue compartment concentrations can be readily computed similar
to the Arterial Input Function (AIF). Like the AIF, you may input the concentrations
from a spreadsheet or by manual input; however, it is more likely you will want to
derive the concentration values from a reference region segmented on the loaded
images. For more information on segmentation techniques in VivoQuant, see the
3D ROI Tool (page 78) page. Begin by navigating to the Blood/Ref 3-Exp.
model in the operator. Next, select the appropriate region of interest in the Img
Derived dropdown.

TS T unmns s yuwa . [ = ‘[

Img Derived: | W background ~ Compute IF

B background A
Ante...yrus
Archicortex tion: 1
Nucl...bens
Fitstart (t0): |  Amygdala Estimate t0
Angu...yrus
Body...leus Unit pamL v

- Cerebellum

ram (Unit) Fit;  ©laustrum
Cuneus N

A4 A ™ I | linf |

tion: 4 «

terBnd Upper Bnd

Reference Tissue Compartment

The Compute IF button will compute the average concentration in the selected
region and populate the table, one row for each volume loaded. The time points are
computed from the image acquisition times and frame durations, set to the
midpoint of each frame, and relative to the start of the dynamic scan. Should the
temporal information be missing from the image data, this can be added using the
Frame Time Editor, found in the Tools menu. A sum of exponentials model can also
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be estimated from the table data. Ensure that the parent/plasma fraction inputs are
disabled by setting their respective dropdown setting to 1. To save a linear
interpolation of the concentrations, click on the Save Interp button. Should you
want to fit a sum of exponentials, begin by specifying an appropriate to parameter,
which can typically be estimated using the Estimate to button. Fitting the sum of
exponentials model can be done with the Run button, at which point you will be
able to save the fit using the Save Fit button.

Saving and Loading of Fraction, AIF, and Reference Region Data

All temporal curves can be saved with the Save Interp or Save Fit buttons. When
they are saved, their user-provided name appears in the dropdown of Saved
Curves.

Saved Curves: - & B X @

Saved Curves

Controls next to the dropdown are available for saving, loading, and viewing the

curves. The == menu provides options for storing the temporal data to/from the
iPACS or as a spreadsheet on your local hard drive. This is particularly useful to
avoid re-entry of the information should you want to re-run analysis at a later date.

The

interpolated samples or modeled data into the list of saved curves. The @ button

clears the currently selected temporal curve from the list. Lastly, the @ button
opens a new dialog window showing a plot of the temporal curve which can be
saved as a local image for quality control.

menu is an additional tool for the user to store the current linearly

Additional Resources

e “Emission Tomography: The Fundamentals of PET and SPECT”, Miles
Wernick & John Aarsvold. Elsevier, 2004. Print.

e “Fractions of unchanged tracer in plasma”, Vesa Oikonen. Turku PET Center
website. Link

e “Converting blood TAC to plasma TAC”, Vesa Oikonen. Turku PET Center
website. Link
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e “Blood sampling in PET studies”, Vesa Oikonen. Turku PET Center website.

Link
e “Arterial input function from PET image”, Vesa Oikonen. Turku PET Center
website. Link
Models

Two-Tissue Compartment Model (2TCM)

The 2TCMis a three-compartment model that includes two tissue compartments:
one tissue compartment represents free and nonspecifically bound tracer within
the tissue (referred to as nondisplaceable), and the other tissue compartment
represents specifically bound tracer within the tissue. The third compartment
represents tracer within the arterial plasma.

: _: K1 | k«?h

v P F + NS S

I N -—

N B k4
CND(t) Concentration in F + NS compartment, nodisplaceable

tracer.

Cs(t) Concentration in specifically bound (S) compartment.
Cp(t) Concentration in plasma (P) compartment.
K1(mL*cm>*min'l) Transfer of ligand from arterial plasma to tissue.
ko (min’Y) Transfer of ligand from tissue to arterial plasma.
ka(min}) Transfer of ligand into specifically bound compartment.
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ka (min’1) Transfer of ligand out of specifically bound compartment.

For those tracers for which a compartmental model is appropriate, estimation of
the rate constants provides valuable information about tracer uptake and binding
[1] (page 359). Due to the difficulty of reliably estimating all four parameters of the
2TCM, lumped or macroparameters are often employed. Macroparameters are
rate constants which are functions of individual microparameters (e.g. K1, k2, k3
and k4). One such macroparameter that is estimated by the 2TCM is the total
volume of distribution, VT.

When the 2TCM is applied to image data with a reference region, the distribution
volume ratio (DVR) can be calculated: DVR = V1/VND, where VND is the estimated
distribution volume in a region that is devoid of the target site or receptor (often
called the reference region or nondisplaceable region). Binding potential (BPND)
can then be calculated by BPND = DVR - 1.

Model Assumptions

This model makes the following assumptions:

e Thetracer binds reversibly.
¢ Nonspecifically bound ligand equilibrates rapidly with free tissue ligand.
e Compartmental model assumptions:

o The tracer kinetics or behavior can be represented by a
compartmental model.

o Tracer concentration within each compartment is well-mixed and
does not vary spatially.

o First-order kinetics can describe exchange of ligand between
compartments.

O Note: Violation of any of these assumptions may produce biased parameter
estimates. While the model will still run in VivoQuant, the estimated parameters
may not accurately reflect the true tracer kinetics.

The 2TCM is currently implemented in VivoQuant using a basis function method
approach [2] (page 359) and unweighted fitting in this basis function method,
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Required Inputs

This model requires the following inputs:

e Metabolite-corrected arterial plasma input curve.

e ROI(s) or voxels.

Outputs

Region-level analysis:

e Plot of data from each ROl with 2TCM fit.

e VT, K1, k2, k3, k4, mean-squared error (MSE) of fit, ©1, and ©2 are shown
when the cursor is hovered over the model fit plot.

e VT1,K1,k2, k3, ka4, mean-squared error (MSE), data and 2TCM fit for each
ROl can be saved out to . csv

References

[1] “A quantitative model for the in vivo assessment of drug binding sites with
positron emission tomography”. Mintun, et al. Ann Neurol, 1984. Link .

[2] “Kinetic modelling using basis functions derived from two-tissue
compartmental models with a plasma input function: general principle and
application to [18F]fluorodeoxyglucose positron emission tomography”. Hong, et al.
Neurolmage, 2010. Link .

Additional Resources

“Compartmental Models”, Vesa Oikonen. Turku PET Center website. Link .
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One-Tissue Compartment Model (1TCM)

The 1TCM is a two-compartment model that includes one compartment
representing tracer within the tissue (free and nonspecifically bound tracer which
together are referred to as nondisplaceable tracer) and one compartment
representing tracer within the arterial plasma [1] (page 362).

momsm— ¥
P ::_'IF+NS

CND(t) Concentration in F + NS compartment, nondisplaceable
tracer.

Cp(t) Concentration in plasma (P) compartment.

K1 Transfer of ligand from arterial plasma to tissue.

(mL*cm3*min'1)

ko (min™Y) Transfer of ligand from tissue to arterial plasma.

VT =K1/k2 Total volume of distribution.

For tracers for which a compartmental model is appropriate, estimation of the rate
constants provides valuable information about tracer uptake [2] (page 362). The
1TCM s generally easier and less computationally intensive to solve than the
2TCM, because it is a simpler model and has fewer parameters. Additionally, the
1TCM model parameters can generally be estimated with better identifiability than
the 2TCM model parameters.

In some cases, the exchange of tracer between the nondisplaceable and bound

tissue is sufficiently fast, so the two cannot be distinguished kinetically. In these
cases, the nondisplaceable and bound tissue compartments may be collapsed into
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one compartment that represents both the nondisplaceable and specifically bound
tracer within the tissue [3] (page 362). In these cases, apparent transfer of ligand
from tissue to arterial plasma is represented by the parameter k23 and V1 = K1/k2a.

EP. F+NS +S

When a tracer that specifically binds to a target can be represented by a 1TCM as
above, and has a reference region the distribution volume ratio (DVR) can be
calculated: DVR = VT/VND, where VND is the estimated distribution volume in the
reference region. Binding potential (BPND) can then be calculated by BPNp = DVR -
1.

Model Assumptions

This model makes the following assumptions:

e The tracer binds reversibly.
e Nonspecifically bound ligand equilibrates rapidly with free tissue ligand.
e Compartmental model assumptions:

o The tracer kinetics or behavior can be represented by a
compartmental model.

o Tracer concentration within each compartment is well-mixed and
does not vary spatially.

o First-order kinetics may be used to describe exchange of ligand
between compartments

O Note: Violation of any of these assumptions may produce biased parameter
estimates. While the model will still run in VivoQuant, the estimated parameters
may not accurately reflect the true tracer kinetics..

Required Inputs

This model requires the following inputs:
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e Metabolite-corrected arterial plasma input curve

e ROI(s) or voxels

Outputs

Region-level analysis:

e Plot of data from each ROl with 1TCM fit.

e VT, K1, k2, and mean-squared error (MSE) of fit are shown when the cursor
is hovered over the model fit plot.

e VT, K1, k2, and mean-squared error (MSE) of fit, data, and 1TCM fit for each
ROl canbe saved out to . csv.

Voxel-level analysis
e Plot of data for each voxel with 1TCM fit. Select the voxel for which you
would like to see the model fit by clicking on it with the image viewer.

e VT, K1, k2, and mean-squared error (MSE) of fit are shown when the cursor
is hovered over the model fit plot.

e Parameter maps for VT, K1, k2, and mean-squared error (MSE).

References

[1] “Kinetic modeling in positron emission tomography”. Morris, et al. In: Emission
Tomography: The Fundamentals of PET and SPECT (Eds: wermick MN, Aarsvold JN).
2004.

[2] “Comparison of methods for analysis of clinical [11C]raclopride studies”.
Lammerstsma, et al. JCBFM, 1996. Link

[3] “Kinetic modelling using basis functions derived from two-tissue
compartmental models with a plasma input function: general principle and

application to [18F]fluorodeoxyglucose positron emission tomography”. Hong, et al.
Neurolmage, 2010. Link .

Additional Resources

“Compartmental Models”, Vesa Oikonen. Turku PET Center website. Link
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Logan Graphical Method (Logan Plot)

The Logan Graphical Method [1] (page 365) was developed for reversibly bound
tracers based on the Patlak method for irreversibly bound tracers [2] (page 365).
The Logan method proposes that after some time t*, the plot of

Jy Cr(tydt [T c,(t)dt

]

(—'r]" (_‘T

VS.

where Ctis the concentration of the tracer in the tissue and Cp is the
concentration of the tracer in the metabolite-corrected arterial plasma, becomes
linear with slope equal to the total volume of distribution, VT.
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When the Logan Plot is applied to image data with a reference region, the
distribution volume ratio (DVR) can be calculated: DVR = VT/VND, where VND is the
estimated distribution volume in the reference region. BPND is related to DVR by
BPND=DVR-1

The Logan Plot is a rearrangement of tracer kinetic equations to yield a useful
linear equation. However, the mapping of transformed variables is nonlinear in
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Cr(t), and this results in an underestimation of VT which becomes more
pronounced with larger true V1 and increased noise [1.3] (page 365). Therefore,
the Logan graphical method may not be the best method to use when data are
noisy, and other methods should be considered.

Model Assumptions

This model makes the following assumptions:

e The tracer binds reversibly

T g
Jo Cr(t)dt
{("f
. T
e After some time t* the slope of the plot of VS.

I Co(t)dt
Cr

approaches linearity.

O Note: Violation of any of these assumptions may produce biased parameter
estimates. While the model will still run in VivoQuant, the estimated parameters
may not accurately reflect the true tracer kinetics.

Required Inputs

This model requires the following inputs:

e Metabolite-corrected arterial plasma input curve
e ROI(s) or voxels
e t*(inscantime)

o Selection of t*: The Logan plot as implemented in VivoQuant
requires that the user inputs the t*, which defines the time at which
the plotted data become linear. In VivoQuant the default t* value is
0. This is likely not the appropriate value for your experiment. t*
values are tracer dependent. For characterized tracers, we suggest
reviewing the literature to see which t* values have been used in
Logan method. The simplest way to select a reasonable t* value for
your data is to run the model once with the default t* value, review
the Logan plots to find the point at which they become linear (t*),
then re-run the model with the appropriate t* (in scan time) value.
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Outputs

Region-level analysis
e Logan plot with line fit for each voxel. Select the voxel for which you would
like to see the Logan plot by clicking on it within the image viewer.

e VT, fitted line intercept, and mean-squared error (MSE) of fit are shown
when the cursor is hovered over the Logan plot.

e Parameter maps for VT, fitted line intercept, and MSE.

References

[1] “Kinetic modeling in positron emission tomography”. Morris, et al. In: Emission
Tomography: The Fundamentals of PET and SPECT (Eds: wermick MN, Aarsvold JN).
2004.

[2] “Comparison of methods for analysis of clinical [11C]raclopride studies”.
Lammerstsma, et al. JCBFM, 1996. Link

[3] “Effects of Statistical Noise on Graphic Analysis of PET Neuroreceptor Studies”.
Slifstein and Laruelle. JNM, 2000. Link

Additional Resources

“Multiple Time Graphical Analysis (MTGA)”, Vesa Oikonen. Turku PET Center
website. Link

Simplified Reference Tissue Model (SRTM)

The simplified reference tissue model (SRTM) [1] (page 368) allows for
guantification of tracer kinetics without requiring an arterial input function. SRTM
is a numerically robust model which assumes that the tracer can be represented by
1-tissue compartment models in both the ROls and the reference region.

VivoQuant™ 2022 User Manual Page 365


http://www.ncbi.nlm.nih.gov/pubmed/8530554
https://pubmed.ncbi.nlm.nih.gov/11138696/
http://www.turkupetcentre.net/petanalysis/model_mtga.html

Pharmacokinetic Modeling Last updated: March 08, 2023

ROI

' P ]F+NS+S

k 2a

Reference Region

Ple
NPT

k>

F + NS

CT(t) Concentration in F + NS + S compartment.

CND(t) Concentration in F + NS compartment, nondisplaceable
tracer.

Cp(t) Concentration in plasma (P) compartment.

K1 Transfer of ligand from arterial plasma to tissue.

(mL*cm3*min'1)

koa (min™h) Apparent transfer of ligand from tissue to arterial plasma.

K1’ Transfer of ligand from arterial plasma to reference tissue.

(mL*cm3*min'1)

ko' (min t Transfer of ligand from reference tissue to arterial plasma.
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Model Assumptions

This model makes the following assumptions:

e Thetracer binds reversibly.

e Tracer concentration in all regions or voxels-of-interest as well as the
reference region (see below) can be represented by a 1-tissue
compartment model.

e Aregion/tissue exists which is devoid of the target site/receptor. We call
this region the reference region. It represents the concentration of the
tracer which is free in tissue and/or bound to off-target sites (non-specific
binding). An ideal reference region is a) devoid of the target site/receptor,
and b) has the same concentration of tracer free in tissue and
nonspecifically bound as the ROI.

O Note: Violation of any of these assumptions may produce biased parameter
estimates. While the model will still run in VivoQuant, the estimated parameters
may not accurately reflect the true tracer kinetics [2] (page 368). SRTM is currently

implement in VivoQuant using a basis function method approach and unweighted
fitting [3] (page 368).

Required Inputs

This model requires the following inputs:

e Reference tissue curve.

e ROI(s) or voxels.
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Outputs

Region-level analysis

e Plot of data from each ROl with SRTM fit.

e BPND, R1,k2,k2’, and mean-squared error (MSE) of fit are shown when the
cursor is hovered over the model fit plot.

e BPND, R1,k2,k2’, and mean-squared error (MSE), data and SRTM fit for each
ROl can be saved out to . csv.

Voxel-level analysis

¢ Plot of data for each voxel with SRTM fit. Select the voxel for which you’d
like to see the model fit by clicking on it with the image viewer.

e BPND, R1,k2,k2’, and mean-squared error (MSE) of fit are shown when the
cursor is hovered over the model fit plot.

e Parameter maps for BPND, R1,k2,k2” and MSE.

References

[1] “Simplified reference tissue model for PET receptor studies”, Lammerstma and
Hume. Neurolmage, 1996. Link

[2] “The simplified reference tissue model: model assumption violations and their
impact on binding potential”, Salinas, et al. JCBFM, 2015. Link

[3] “Parametric imaging of ligand-receptor binding in PET using a simplified
reference region model”. Gunn, et al. Neurolmage, 1997. Link

Additional Resources

“Reference region input compartmental models”, Vesa Oikonen. Turku PET Center
website. Link .

VivoQuant™ 2022 User Manual Page 368


http://www.ncbi.nlm.nih.gov/pubmed/9345505
http://www.ncbi.nlm.nih.gov/pubmed/25425078
http://www.ncbi.nlm.nih.gov/pubmed/9417971
http://www.turkupetcentre.net/petanalysis/model_compartmental_ref.html

Pharmacokinetic Modeling Last updated: March 08, 2023

Simplified Reference Tissue Model 2 (SRTM2)

SRTM2 is a two-pass version of SRTM that attempts to reduce noise in parametric
images by fitting all voxels with a fixed, global k2’ [1] (page 371). In practice, SRTM
estimates k2’ for every voxel or region, but since there is only one reference region,
in principle there is only one true k2’ value [1] (page 371). Fixing k2’ reduces the
number of parameters estimated and thus reduces noise in parametric images [1]
(page 371). However, this improvement in precision may come at the price of an

increase in bias [1] (page 371).

O Note: SRTM2 can be used on both the region- and voxel-level but generally
shows greatest advantage over SRTM when used at the voxel-level.

Model Assumptions

This model makes the following assumptions:

e The tracer binds reversibly

e Tracer concentrationin all regions or voxels-of-interest as well as the
reference region (see below) can be represented by a 1-tissue
compartment model.

e Aregion/tissue exists which is devoid of the target site/receptor. We call
this region the reference region. It represents the concentration of the
tracer which is free in tissue and/or bound to off-target sites (non-specific
binding). An ideal reference region is a) devoid of the target site/receptor,
and b) has the same concentration of tracer free in tissue and
nonspecifically bound as the ROI.

e Thereisonly one true k2’ value. k2’ is the rate of tracer efflux from the
reference region to the plasma.

O Note: Violation of any of these assumptions will invalidate the model and may
produce biased parameter estimates. While the model will still run in VivoQuant,
the estimated parameters may not accurately reflect the true tracer kinetics.
SRTM2 is currently implemented in *VivoQuant using a basis function method
approach and unweighted fitting [2] (page 371).

Required Inputs

This model requires the following inputs:
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Outputs

Reference tissue curve.
ROI(s) or voxels.
A fixed k2’

Selection of a fixed k2“: The value to which to fix k2’ should be selected based
on the tracer and the experiment. For characterized tracers, we suggest
reviewing the literature to see how the fixed k2’ has been selected in
different studies and the effect of the method to fix k2’ on SRTM2
parameter estimates. Generally, k2’ can be fixed to the median value
estimated by a first-pass of SRTM from all voxels with a BPND value > a set
minimum [3.4] (page 371) or all voxels with a BPND value within a given
range [5] (page 0). The idea behind using BPND values to select voxels for
inclusion in the median is to exclude voxels which maybe represent noise or
have poor SRTM fit. For most tracers there is a range of physiologically-
relevant BPND values. Values outside of that range may be non-
physiological. Other studies have fixed k2’ to the population average value
estimated from a 1-tissue compartment model fit to the reference region
[3] (page 371) or estimated k2’ for each subject by a simultaneous SRTM fit
including all target regions with coupled k2’ [3.6] (page 0). SRTM fit with
coupled k2’ is not currently available in VivoQuant.

Region-level analysis

Plot of data from each ROl with SRTM2 fit.

BPND, R1,k2a, and mean-squared error (MSE) of fit are shown when the
cursor is hovered over the model fit plot.

BPND, R1,k2a, and mean-squared error (MSE), data and SRTM2 fit for each
ROl canbe saved out to . csv.

Voxel-level analysis

Plot of data for each voxel with SRTM2 fit. Select the voxel for which you’d
like to see the model fit by clicking on it with the image viewer.

BPND, R1, k2a, and mean-squared error (MSE) of fit are shown when the
cursor is hovered over the model fit plot.

Parameter maps for BPND, R1, k2a, and MSE.
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References

[1] “Noise reduction in the simplified reference tissue model for neuroreceptor
functional imaging.”, Wu and Carson. JCBFM, 2002. Link

[2] “Parametric imaging of ligand-receptor binding in PET using a simplified
reference region model”. Gunn, et al. Neurolmage, 1997. Link

[3] “Tracer kinetic modeling of [(11)C]AFM, a new PET imaging agent for the
serotonin transporter”. Naganawa, et al. JCBFM, 2013. Link

[4] “Parametric Imaging and Test-Retest Variability of 11C-(+)-PHNO Binding to
D2/D3 Dopamine Receptors in Humans on the High-Resolution Research
Tomograph PET Scanner”, Gallezot, et al. JINM, 2014. Link

[5] “Kinetic modeling of the serotonin 5-HT 1B receptor radioligand [11C]P943 in
humans”. Gallezot, et al. JCBFM, 2010 Link

[6] “Assessment of striatal dopamine D2/D3 receptor availability with PET and
18F-desmethoxyfallypride: comparison of imaging protocols suited for clinical
routine”. Amtage, et al. INM, 2012. "Link

Additional Resources

“Reference region input compartmental models”, Vesa Oikonen. Turku PET Center
website. Link .

Logan Non-Invasive Graphical Method (Logan reference plot)

The Logan non-invasive graphical method [1] (page 374) was developed for
reversibly bound tracers based on the Logan graphical method and Patlak method
for irreversibly bound tracers [2.3] (page 374). The Logan reference method
proposes that after some time t* the plot of

[Ter)dt [T Crlt)dt

[ ’

O Cr

VS.

(where CTis the concentration of the tracer in the tissue and CRr is the
concentration of the tracer in the reference region) becomes linear with slope
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equal to the distribution volume ratio (DVR). Binding potential (BPND) is related to
DVR by BPND =DVR - 1.
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The Logan plot is a rearrangement of tracer kinetic equations to yield a useful
linear equation. However, the mapping of transformed variables is nonlinear in
CT(t), and this results in an underestimation of DVR which becomes more
pronounced with larger true DVR and increased noise [1.4] (page 374). Therefore,
the Logan graphical method may not be the best method to use when data are
noisy, and other methods should be considered.

Method Assumptions

This model makes the following assumptions:

e The tracer binds reversibly.

e Aregion/tissue exists which is devoid of the target site/receptor. We call
this region the reference region. It represents the concentration of the
tracer which is free in tissue and/or bound to off-target sites (non-specific
binding). An ideal reference region is a) devoid of the target site/receptor,
and b) has the same concentration of tracer free in tissue and
nonspecifically bound as the ROI.
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I Cr(t)dt
Cr

e After some time t* the slope of the plot of VS.
T -
Jo Cr(t)dt
Cr

approaches linearity.

O Note: Violation of any of these assumptions may produce biased parameter
estimates. While the model will still run in VivoQuant, the estimated parameters
may not accurately reflect the true tracer kinetics.

Required Inputs

This model requires the following inputs:

e Reference tissue curve.
e ROI(s) or voxels.
e t*(inscantime)

o Selection of t*: The Logan reference plot as implemented in
VivoQuant requires that the user inputs the t* which defines the
time at which the plotted data become linear. In VivoQuant, the
default t* value is 0. This is likely not be the appropriate value for
your experiment. t* values are tracer dependent. For characterized
tracers, we suggest reviewing the literature to see which t* values
have been used in Logan reference method. The simplest way to
select areasonable t* value for your data is to run the model once
with the default t* value, review the Logan reference plots to find
the point at which they become linear (t/), then re-run the model with
the appropriate *t/* (in scan time) value.

Outputs

Region-level analysis

e Logan plot with line fit for each ROI.

e DVR, fitted line intercept, and mean-squared error (MSE) of fit are shown
when the cursor is hovered over the Logan plot.

e DVR, fitted line intercept, and transformed Logan space data for each ROI
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can be saved outto .csv.

Voxel-level analysis
e Logan plot with line fit for each voxel. Select the voxel for which you would
like to see the Logan plot by clicking on it within the image viewer.

e DVR, fitted line intercept, and MSE of fit are shown when the cursor is
hovered over the Logan plot.

e Parameter maps for DVR, fitted line intercept, and MSE.

References

[1] “Distribution volume ratios without blood sampling from graphical analysis of
PET data”. Logan, et al. JCBFM, 1996. Link

[2] “Graphical analysis of reversible radioligand binding from time-activity
measurements applied to [N-11C-methyl]-(-)-cocaine PET studies in human
subjects”. Logan, et al. JCBFM, 1990. Link

[3] “Graphical evaluation of blood-to-brain transfer constants from multiple-time
uptake data”. Patlak, et al. JCBFM, 1983. Link

)

[4] “Effects of Statistical Noise on Graphic Analysis of PET Neuroreceptor Studies”.
Slifstein and Laruelle. JNM, 2000. Link

Additional Resources

“Multiple Time Graphical Analysis (MTGA)”, Vesa Oikonen. Turku PET Center website.
Link

Patlak Analysis (Patlak Plot)

Patlak analysis is rearrangement of tracer kinetic equations to yield a useful linear
equation [1] (page 376). Patlak analysis proposes that after some time t* the plot of

Cr(t) [ Cp(t)dt
Cp(t) Cp(T)

VS.

where Ctis the concentration of the tracer in the tissue and Cpis the
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concentration of the tracer in the metabolite-corrected arterial plasma, becomes
linear with slope equal to the net influx rate constant, Kj. The rate constant K;

represents influx and trapping of the tracer into the tissue [1.2] (page 377).
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In terms of a two-tissue compartment model where k4 = 0 because the tracer is

;,ﬁ- Flj
irreversibly trapped, Ki= )

Model Assumptions

This model makes the following assumptions:

e Thetracer bindsirreversibly

Cr(t) [T Cp(t)dt
Cp(t) Cp(T)

e After some time t*, the slope of the plot of VS.
approaches linearity.

O Note: Violation of any of these assumptions may produce biased parameter
estimates. While the model will still run in VivoQuant, the estimated parameters
may not accurately reflect the true tracer kinetics.

Required Inputs

This model requires the following inputs:
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e Metabolite-corrected arterial plasma input curve.
e ROI(s) or voxels
e t*(inscantime)

o Selection of t*: The Patlak plot as implemented in VivoQuant
requires that the user inputs the t* which defines the time at which
the plotted data become linear. In VivoQuant the default t* value is
0. This is likely not be the appropriate value for your experiment. t*
values are tracer dependent. For characterized tracers, we suggest
reviewing the literature to see which t* values have been used in
Patlak analysis. The simplest way to select a reasonable t* value for
your datais to run the model once with the default t* value, review
the Patlak plots to find the point at which they become linear (t*),
then re-run the model with the appropriate t* (in scan time) value.

Outputs

Region-level analysis

e Patlak plot with line fit for each ROI.

e K;j, fitted line intercept (V), and mean-squared error (MSE) of fit are shown
when the cursor is hovered over the Patlak plot.

¢ Kjand transformed Patlak space data for each ROl can be saved out to
. CSV.

Voxel-level analysis

e Patlak plot with line fit for each voxel. Select the voxel for which you would
like to see the Patlak plot by clicking on it within the image viewer.

e K;j, fitted line intercept (V), and mean-squared error (MSE) of fit are shown
when the cursor is hovered over the Patlak plot.

e Parameter maps for Kj, fitted line intercept (V), and MSE.

References

[1] “Graphical evaluation of blood-to-brain transfer constants from multiple-time
uptake data”. Patlak, et al. JCBFM, 1983. Link .
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[2] “Net Influx Rate, (Ki)”, Vesa Oikonen. Turku PET Center website. Link .

Additional Resources

“Multiple Time Graphical Analysis (MTGA)”, Vesa Oikonen. Turku PET Center website.
Link .
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NanoSPECT Tools

The NanoSPECT Tools sub-menu contains features primarily associated with
improving SPECT quantification.

e QuantiCalc (page 379)
e Specific Activity Calculator (page 382

SUV Calculator (page 385

Crosstalk Removal (page 387

Biodist. Visualization (page 389)
Split Projections (page 392

File View Tools Advanced Modules Help

=SSMeE NucMed i’ NanoSPECT > &\ Multi-Pinhole SPECT
Display H ) £ Spec. Act. Calculator b NFF Uniformity QC
MR SUV Caleulator QuantiCalc

ki Bed removal BioDist Visualization Crosstalk removal
Multi-Atlas Segmentation Split Projections
3D Brain Atlas Tool EKG split
fMRI Tool
Install Atlas

Save Calibration.txt

Show user data

Split ROl to DICOM Sum projections

Dosimetry Calc Append projections
Semi-Stationary Data Processing

NanoSPECT Tools
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QuantiCalc

The Quantification Calculator enables a feature unique to the NanoSPECT/CT
imaging system: the ability to perform absolute quantification in small-animal
SPECT imaging.

Getting There

The QuantiCalc tool is available going to Advanced Modules > NucMed >
NanoSPECT.

Eile View Tools Advanced Modules Help

=sSSMme NucMed > NanoSPECT > A Multi-Pinhole SPECT 3
o cT > Spec. Act. Calculator g\ NFF Uniformity QC |
MR SUV Calculator QuantiCalc

Display

Bed removal BioDist Visualization Crosstalk removal

Multi-Atlas Segmentation Split Projections
3D Brain Atlas Tool EKG split

fMRI Tool Save Calibration.txt
Install Atlas Show user data
Split ROI to DICOM Sum projections
Dosimetry Calc Append projections

Semi-Stationary Data Processing

QuantiCalc Tool

Function

The Quantification Calculator is used to calculate a Quantification Factor. To
perform absolute quantification, Quantification Factors must be calculated for
each isotope and aperture combination used in the NanoSPECT/CT. The

Quantification Factors are stored in the Quantification Database (page 381). For

information on collecting the data necessary to calculate Quantification Factors,

see the NanoSPECT/CT (page 394) documentation.
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CQuuantiCalc

Dose meter
NanoSPECT
Isotope

Decay factor

Quantification factor |

+

QuantiCalc Data
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10.000 ¢ MBq ~ [1/1/2000 12:00 AM ¥
0.000 < kCounts |1/1/2000 12:00 AM 5|
Tc-99m * Half-life | 6.01| h
1.00| Aperture |APTO =
nan| EWin ' |

Close

The procedure for collecting Quantification Factor data involves performing a
highly-specified SPECT measurement on a syringe filled with isotope. The fields of
the QuantiCalc window may then be filled according to:

Dose Meter

NanoSPECT

Isotope

Decay Factor

Quantification
Factor

Record the amount of activity in the syringe in MBg,kBq, mCi
or uCi as measured by a dose calibrator. Include the time of
the measurement.

Record the activity value measured by the NanoSPECT from
reconstructed data. Include the time of data collection.

Select the isotope present in the syringe. Isotopes offered in-
cludeGa-67,1-123,1-125,Lu-177,Tc-99,TL-201,
In-111, and Xe-133. The half-life of the selected isotope will
be automatically populated in units of hours.

The information from the Dose Meter, NanoSPECT, and Iso-
tope fields will be used to calculate a decay factor between
the time of Dose Meter measurement and data collection.

The information from the above fields is all combined to de-
termine a Quantification Factor for that particular isotope
and aperture. This Quantification Factor can then be entered
in the Quantification Database.
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Quantification Database

The Quantification Database stores all of the Quantification Factors calculated
for any isotope and aperture combination measured with the NanoSPECT/CT.
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Specific Activity Calculator

The Specific Activity Calculator accepts an input volume, activity, specific activity
for a given isotope and calculates the amount of isotope present in the sample both
in moles and moles/volume.

Getting There

Access the Specific Activity Calculator by going to NucMed > Apect. Act.
Calculator.

File View Tools Advanced Modules Help

=SSMa NucMed : NanoSPECT & ;
o1 CT g Spec. Act. Calculator
MR MR SUV Calculator

Bed removal BioDist Visualization

Display

R - updaote disabled

Multi-Atlas Segmentation
3D Brain Atlas Tool

fMRI Tool

Install Atlas

Split ROI to DICOM

Dosimetry Calc

Specific Activity Calculator

Function

The Specific Activity Calculator requires several values to make its calculations.
An activity, volume, isotope, and specific activity are used to calculate the number
of excited molecules and molarity of a given sample.
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Specific Activity Calculator

Specific Activity Calculator

1.000 <] IMBq

Activity

Volume :i.ﬂﬂﬂ
Isotope Tc-99m
Specific Adtivity

Calculated values:

1.000 =] | MBa/pmol

Last updated: March 08, 2023

19/21/2021 12:00 AM ~|

4

4

2] mi
- Half-life | 6.01/h
19/21/2021 12:00 AM |

i

Amount _ 1| pmol -
Molarity | 1] [EEEUTR AmouTs of substance
Close
QuantiCalc Tool

Activity

Volume

Isotope

Specific
Activity

Amount

MBq, kBq,
mCi,or uCi
and measure-
ment time.

cm3,mm3, ml,
pl

Hours

MBq/pmol,
kBg/pmol
and measure-
ment time.

pmol, nmol,
or#

VivoQuant™ 2022 User Manual

Amount of isotope as measured in a dosimeter or
with the NanoSPECT.

The volume containing the activity.

The isotope of interest and its associated half-life.
Several pre-defined options are available.

The specific activity of the isotope being used as
measured by a specific activity calibration. Specific
activity describes the number of excited atoms out
of the total atoms present in a given sample, i.e., the
amount of the activity that has not yet decayed to a
ground state.

The calculated amount, or number, of excited mole-
culesin the sample.
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Molarity pmol/ml, The calculated molarity, or concentration, of excited
nmol/ml molecules in a sample of activity.
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SUV Calculator

Use the SUV Calculator to calculate a specific uptake value (SUV), given the
appropriate entries of injected dose, subject weight, and activity concentration.

Getting There

Access the SUV Calculator by going to Advanced Modules > NucMed > SUV
Calculator.

File View Tools Advanced Modules Help
=SSM e NucMed i’ NanoSPECT r B
T CT ” Spec. Act. Calculator
MR SUV Caleulator

Bed removal BioDist Visualization

Display

R - update disabled

Multi-Atlas Segmentation
3D Brain Atlas Tool

fMRI Tool

Install Atlas

Split ROl to DICOM

Dosirmetry Calc

SUV Calculator

Function

The SUV Calculator requires several values to make its calculations. An activity
and volume are used to calculate an activity concentration. The subject weight and
injected dose are used in conjunction with the activity concentration to calculate
the SUV. Units for these entries are user-selectable.
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SUV Calculator H
Activity 0.0000 | mMBq ~ Patient Weight [0.0000 %] g -
Volume 0.0000 s ml * Injected dose |0.0000 + MBq -
Concentration |0.000000 :'. MBqg/ml - Suv mg/ml *

Close

SUV Calculator - Values

Activity

Volume

Concentration

Patient
Weight

Injected Dose

SUvV

MBg, kBg, mCi,
or uCi

cm3,mm3, ml,
ul

kBg/ml,MBq/
ml,mCi/ml,
kBg/mm3,
MBqg/mm3

g, kg

MBq, kBg, mCi,
or uCi

mg/ml,g/ml,
kg/ml,9/1,9/
mm3, kg/mm3

VivoQuant™ 2022 User Manual

Amount of isotope as measured in a
dosimeter or with the NanoSPECT.

The volume containing the activity.

The ratio of activity to volume.

The weight of the animal or object of inter-
est.

The amount of isotope successfully injected
into the subject.

The specific uptake value (SUV) given the
patient weight, activity concentration, and
injected dose specified in the other fields.
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Crosstalk Removal

Use the Crosstalk Removal tool to remove crosstalk photons in dual-isotope
SPECT images. The limits in energy resolution inherent to SPECT imaging result in
some overlap between the energy spectra of isotopes with relatively similar peak
energies. For example, in dual-isotope I-123 and Tc-99mimaging, some I-123
photons will spill over into the Tc-99m window and vice versa. The Crosstalk
Removal tool is applied to projection data to remove these “spill over” photons or
crosstalk.

Getting There

Access the Crosstalk Removal tool by going to Advanced
Modules>NucMed>NanoSPECT.

Eile View Tools Advanced Modules Help

sSSMme NucMed 2 NanoSPECT * & Multi-Pinhole SPECT =
o cr g Spec. Act. Calculator & NFF Uniformity QC
MR MR g SUV Calculator QuantiCalc

Display
R i

Bed removal % BioDist Visualization Crosstalk removal

Multi-Atlas Segmentation Split Projections
3D Brain Atlas Tool
fMRI Tool

Install Atlas

EKG split
Save Calibration.txt

Show user data

Split ROI to DICOM
Dosimetry Calc

Sum projections

Append projections
Semi-Stationary Data Processing

Crosstalk Removal

Function

The Crosstalk Removal tool requires you to enter the scaling factor of both the
Input and Reference images, as well as the Full-Width Half-Maximum (FWHM) of
the smoothing kernel in order to remove crosstalk photons.
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& Crosstalk removal ? X \&! Crosstalk removal ra X
Please insert scaling factor for Ref image: Please insert FWHM [mm] of smoothing kernel
0.04 = 1200} =
ok | cancel oK Cancel

Crosstalk Removal
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Biodistribution Visualization

The Biodistribution Visualization tool creates an atlas representation of measured
mouse biodistribution values.

Getting There

Biodistribution Visualization is accessible by going to Advanced
Modules>NucMed>BioDist Visualization .

File View Tools Advanced Modules Help

=SSMma NucMed : NanoSPECT » b
1 CT ” Spec. Act. Calculator |
ME MR SUV Calculator

Bed removal BioDist Visualization

R - update disabled

|"I !" ’ ¢ Multi-Atlas Segmentation

:f 3D Brain Atlas Tool
! fMRI Tool
Install Atlas

Split ROI to DICOM
Dosimetry Calc

Biodistribution Visualization

Function

To use the Biodistribution Visualization function, enter the total measured activity
for each region-of-interest available in the atlas list.
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Biodistribution Visualization
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\& VivoQuant: Biodistrubution Visualization ? X
Organ Volume [mm3]  Activity Concentration [1/mm3] £
1 ébackground 1.48268e+14 0 0
2 Skin 2.84164e+13 0 0
3 Skeleton 2.52135e+12 0 0
4 Eye 1.16594e+10 0 0
5 Medulla 7.8441e+10 0 0
6 Cerebellum 5.15778e+10 0 0
7 Olfactory bulbs 3.13244e+10 0 0
8 External Cerebrum  2.28152e+11 0 0
9 Striatum 3.95763e+10 0 0
10 Heart 3.95968e+11 0 0
11 Rest of brain 3.25916e+11 0 0
12 Masseter muscles 2.08255e+11 0 0
13 Lachrymal glands 6.05277e+10 0 0
14 Bladder 3.45129%e+11 0 0
15 Testis 2.79278e+11 0 0
16 Stomach 3.90166e+11 0 0
17 Spleen 2.61228e+11 0 0
v
Clear Load Save Cancel
ROI Measured Activity List

After entering the appropriate values, select one of the buttons at the end of the

list.

VivoQuant™ 2022 User Manual
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Clear Clears all fields

Load Loads a previously saved biodistribution text file.
Save Saves the current biodistribution data into a text file.
Cancel Closes the Biodistribution Visualization window.

OK Prepares the atlas with the entered biodistribution information.
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Split Projections

Use the Split Projections tool to split a single SPECT projection data DICOM file
into multiple projection data files along one of several DICOM fields.

Getting There

Access the Split Projections tool by going to Advanced Modules > NucMed >
NanoSPECT>Split Projections.

File View Tools Advanced Modules Help

=sCSM G | NuMed »  NanoSPECT > A Multi-Pinhole SPECT l
» . ) |
Display or Spec. Act. Calculator & NFF Uniformity QC
R - update i Ll ’ SUV Calculator QuantiCalc
Bed removal ¢ BioDist Visualization Crosstalk removal

Multi-Atlas Segmentation Split Projections
3D Brain Atlas Tool
fMRI Tool

Install Atlas

EKG split
Save Calibration.tet

Show user data

Split ROl to DICOM
Dosimetry Calc

Sum projections

Append projections
Semi-Stationary Data Processing

Split Projections

Function

Upon selecting the Split Projections tool, the Data Browser opens. Select an
appropriate SPECT projection data set. A pulldown menu of split options is
presented. After splitting, a confirmation message is presented to verify successful
saving of the new data sets.
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Calibration

Use this tool to evaluate data from several different NanoSPECT calibration
measurements, including CT Geometrical (page 394), Multi-Pinhole SPECT (page
397), and Near Field Flood (page 405).

Getting There

The Calibration menu is available in the Advanced Modules menu.

File View Tools Advanced Modules Help
= @@ﬂm L‘Té— M NucMed e
 a »

MR

Bed removal

Display

R - update disabled

Multi-Atlas Segmentation
3D Brain Atlas Tool

fMRI Tool

Install Atlas

Split ROl to DICOM

Dosimetry Calc

Advanced Modules Calibration

Function

To calibrate and maintain the NanoSPECT/CT imaging system, several calibration
measurements are required. The Calibration menu provides options for analyzing:

e CT Geometrical Calibrations (page 394
e Multi-Pinhole SPECT Calibrations (page 397)

e Near Field Flood QC Measurements (page 405
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CT Geometrical Calibration

Use this tool to evaluate CT Geometrical Calibration data.

Getting There

Access the CT Geometrical Calibration tool by going to Adanced Modules>CT>GT
Geometrical.

File View Tools Advanced Modules Help
S OGSM G M Nuked ' | 2P EEE WS
CF : CT Geometrical
ME MR CT Reconstruction Ctrl+L
Bed removal CT Window Presets L

Display

R - update disabled

A ’ " Multi-Atlas Segmentation
(/S 3D Brain Atlas Tool

[
?/ fMRI Tool
Install Atlas

Split ROl to DICOM
Dosimetry Calc

CT Geometrical Calibration

Function

The gantry of the NanoSPECT has a reproducible wobble as it rotates around its
axis. The CT Geometrical calibration measures this wobble and generates a file
that is used to correct for the wobble in the reconstruction.

The calibration datais also used to assess the severity of the wobble and to insure
that it does not exceed +/-0 . 5mm.

A CT Geometrical measurement consists of a set of projection data collected in a
circular CT measurement of the Geometrical CT phantom. The orbits of the three
metal balls embedded in the Plexiglas of the phantom are used to assess the wobble
in the gantry. Example settings for this measurement include 55kVp, 360
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projections, 1000ms. The protocol needed to run this measurement is called
CT Geometrical and can be found in the Service Protocols section of the Nucline.
After collecting the measurement data, it may be loaded into the CT Geometrical
calibration panel using the Open button described below.

\& NanoSPECT/CT Geometrical Calibration = a X
File

Projections Orbits

=,
b
o 2504
= 1
% 200
|
-
100
50
0 50 100 150 200 250
axial [pxl]
2nd order correction
0.2
0.1 . f
E A ( I :
= n o f Y I
:‘i 0 _J"fm' ,r! ¥ LUTL y Jh
o \/ ay lll g "'. -‘\A \ | |
? -01 e | A |
& N o7
=] 2% PN
0.2 Ut | Il,"\"‘1|_ o (3, P,
0 50 100 150 200 250 300 350
angle [°]
Results Control
MSE: N/A Rs Sy Dy Rot Save Cali Open
Quality: N/A Rd Sz Dz how Calit Close

CT Geometrical Calibration Panel

The CT Geometrical Calibration panel is divided into five sections: Projections,
Orbits, 2nd Order Corrections, Results, and Control.

The Projections panel displays the projections collected in the calibration
measurement as they are being analyzed. Each of the three metal fiducials is

marked by a red, green, or blue circle. The progress of the measurement is also
noted in this panel.

The Orbits panel displays the trajectory of the three metal fiducials as the
projections are analyzed. The trajectories appear flat in the primary view; however,
by drawing a box around a given trajectory it may be expanded to fill the entire
panel, providing a more illustrative view.
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To zoom in on a particular orbit, draw a box by holding down the left mouse button
and dragging.

Upon release of the button, the display will show only the selected orbit. To return
to the full view, just right-click.

The 2nd Order Corrections panel displays an important result of the calibration.
This panel plots the axial and transaxial wobble of the gantry as it rotates. It is
critical that these values be less than +/-0 . 5mm to enable successful correction of
the gantry motion in the CT reconstruction.

The Results panel provides further calibration results, including a mean-square
error (MSE) value that represents the deviation of the fiducials from their ideal
trajectories. A one-word Quality assessment is provided as well as numerical
values for other parameters including the radius of the source (Rs), radius of the
detector (Rd), offsets of the source axially (Sz) and transaxially (Sy), and offsets of
the detector axially (Dz) and transaxially (Dy).

The Control panel houses four buttons, including:

Open Opens the Data Browser where a CT Geometrical dataset may be
selected for analysis.

Close Closes the CT Geometrical panel.

Save Saves the existing calibration in the format used by the NanoSPECT/
Calib CT.

Show Shows the existing calibration in the format used by the

Calib NanoSPECT/CT.
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MMP SPECT Calibration

Use this tool to evaluate SPECT geometrical calibration data.

Getting There

The MMP SPECT Calibration tool is available in the Advanced Modules Menu.

File View Tools Advanced Modules Help

esSSWME NucMed ’ NanoSPECT » Multi-Pinhole SPECT
[ 3 = g
Display er cr Spec. Act. Calculator g NFF Uniformity QC
MR MR % SUV Calculator QuantiCalc
[ 4

Bed removal

BioDist Visualization Crosstalk remaoval

Split Projections

Multi-Atlas Segmentation
3D Brain Atlas Tool
fMRI Tool
Install Atlas

EKG split
Save Calibration.txt

Show user data

Split ROI to DICOM
Dosimetry Calc

Sum projections

Append projections

Semi-Stationary Data Processing

MMP SPECT Calibration

Function

To successfully implement multiplexed multiple-pinhole methods in small-animal
SPECT, several calibrations are necessary. You can use the MMP SPECT panel to
analyze four different small-animal SPECT calibrations, including linearity,
collimator depth, pinhole offset, and geometrical. The panel is split into eight
sections: Templates (page 399), Control (page 399), Preview (page 402), Output
(page 403), and a section for each of the four calibrations. There are also several
helpful tools in the MMP Menus (page 403).

To run the tool, hit the Open button and select all of the relevant data (should be
titled Service”SPECT_0* CalibName and consist of 64 Intrinsic Resolution
data sets, 4 Collimated Beam data sets, and 1 4-point data set) from the Data
Browser. The MMP Tool reads in the calibration data and recognizes which data
corresponds to which calibration. The panels for the individual calibrations display
the completeness of the data. Once all necessary data is present, use the Run
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buttons in succession from the top calibration (Aluminum Grid) to the bottom
calibration (Four-Point). Results for each calibration are presented in their
respective panels; a description of possible errorsis listed in Calibration Failures

(page 401).

& Multiplexing-MultiPinhole Calibration — a X
File Tools Help
Templates Control
Input template Empty template Show Calib
Output file fsﬂuana!Docume_nts{MMP_CaIibeaIibratioerala—20210923.b(ti Use input file Clear Close
Alu grid measurement / Linearity check Preview

Head 1 N/A Head 3 N/A | Preview

Head2  N/A Head4 N/A Details
Resolution N/A Linearity NfA Run

Collimator depth

Head 1 NJA Head 3 N/A Preview

Head 2 N/JA  Head 4 NJA Details
Quality N/A Run

Please load data
Pinhole offset (Collimated beam)

Head 1 N/JA Head 3 N/A Preview
Head 2 N/A  Head 4 N/A Details
Quality N/A Run

Geometrical calibration (4-Point)
Head 1 NfA Head 3 N/A Preview

Head 2 N/A  Head 4 N/A Details
Quality N/A Orbits Run
Output

Open Data

After successfully completing the analysis, the result

CalibrationData YYYYMMDD. txt file can be copied into C:\Nucline\
Calibrations\CalibrationData.txt to update the calibration information used by the
NanoSPECT.

VivoQuant™ 2022 User Manual Page 398


http://127.0.0.1:4012/vqmanual/images/advanced_nanospect_calibration_mppspect_opendata.jpg
http://127.0.0.1:4012/vqmanual/images/advanced_nanospect_calibration_mppspect_opendata.jpg

MMP SPECT Calibration

\& Multiplexing-MultiPinhole Calibration

File Tools Helg
Templates

Input template

Output file C:/Usersfluana/Documents/MMP_Calib/CalibrationData-20210923.bdt:

Alu grid measurement / Linearity check

Head 1 N/A Head 3
Head 2 N/A Head 4
Resolution  N/A Linearity
Collimator depth

Pinhole offset (Collimated beam)
Head 1 N/A Head 3
Head 2 N/A Head 4
Quality N/A

Geometrical calibration (4-Point)
Head 1 o

Head 2 N/A
Quality N/A
Output

Found 4-Point for heads 0b3.

MMP SPECT Calibration Panel

Templates

Preview
N/A
N/A
N/A

N/A
N/A

Head 3 N/A | Preview

Head 4 N/A

Last updated: March 08, 2023

Control
Show Calib Open..

Clear Close

The Templates section controls the input and output files used/generated by the
calibration analysis.

Input
Template

Empty
Template

Output
File

Control

You can use a previously-generated CalibrationData. txt file
as an input template for the data. This feature is particularly useful
if partial calibrations (i.e., only a 4-point measurement) have been

performed.

As a default, an empty template, designed for use with the Nucline
software, is used to generate the CalibrationData. txt file.

You may specifiy any name for the Output file of the calibration
analysis. The default name is CalibrationData YYYYM-

MDD. txt.

The Control panel has four buttons for manipulating the MMP Calibration window.
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Show Opens the current CalibrationData YYYYMMDD. txt file for
Calib viewing.

Open...  Opens abrowser that is to be used for loading MMP Calibration data
(DICOM format).

Clear Clears the Output panel of the MMP Calibration window.

Close Closes the MMP Calibration window.

The Calibrations

Four different MMP calibrations may be analyzed with this tool. For each
calibration, Preview, Details, and Run buttons are provided.

Preview allows the user to view the images for that particular calibration in
the Preview panel.

Details  provides information about each calibration.

Run performs the analysis of that measurement. Additionally, the orbits
from the 4-point calibration may be displayed using the Orbits but-
ton.

Aluminum Grid Measurement / Linearity Check

Data for the Aluminum Grid Measurement is collected with a device containing 16
carefully-positioned holes. The collimated beam source holder is placed in each
hole. The resulting 16 point images are used to analyze the linearity of the detector.

Collimator Depth

The collimator depth phantom is used to collect data for the collimator depth
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calibration. This calibration was once used to determine the distance from the
detector plane to the pinhole plane, however, it is now out-of-date and is turned off
by default. It may be turned back on using the “Enable ColDepth” option found in
the MMP Menus.

Pinhole Offset (Collimated Beam)

The Pinhole Offset calibration evaluates the deviation between the center of the
pinhole plane and the center of the detector plane.

Geometrical Calibration (4-point)

The 4-point calibration provides a wealth of geometrical information for the
NanoSPECT/CT. This geometrical information is then used by special algorithms to
determine the forward model necessary for successful SPECT reconstruction.

Calibration Failures

In each calibration panel, there are also fields relaying information about the
completeness of the data for each head and some quality measure (either
Resolution, Linearity, or Quality). The table below includes information about the
limits for passing a particular calibration and how to interpret error messages. In
each case, X designates a head number. For example, in the 4-point calibration, aR1
(as shown in the screen shot) would indicate that the Radius of Rotation for Head 1
was outside the acceptable limits.

Calibration | Error | Message Interpretation
Limits

Intrinsic Rx Intrinsic detector resolution >2.4 mm

Resolution

Intrinsic Px Pixel Size <0.97mmor

Resolution >1.03mm

Intrinsic Lx Quality of linearity >30 (A.U.)

Resolution

Collimator  Hx Detector plane to aperture plane dis- >130.1mmor
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Calibration Message Interpretation
Limits
Depth tance <134.1mm
Collimated  Hx Absolute distance between aperture >1.5mm
Beam center and detector center (y or z)
4-Point Ax Absolute aperture offset (transaxial or >1.0mm
axial)
4-Point Dx Absolute detector offset (transaxial or >1.5mm
axial)
4-Point Rx Radius of rotation >45.9mm or
<43.9mm
4-Point Q Overall quality of the calibration >3.0 (A.U.)
4-Point B Horizontal bed offset >3.0mm
Preview

The Preview panel displays calibration data for a particular calibration (selected
using that calibration’s Preview button). This panel is useful for checking head
order in the 4-point calibration or determining a missing point in the Linearity
Check calibration. The slider bar at the bottom allows movement between heads.
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Preview Types

Output
The Output panel provides a log of the steps being performed. For example, the

Output section will inform the user that files have been found, provide the
numerical results from the analysis, and help identify potential errors.

MMP Menus

Several useful fixes and features may be found in the MMP Menus of File, Tools,
and Help.

Item Function Keyboard

Shortcut

File Open Data...  ldentical to the Open button in the Con- Ctrl-0

trol (page 399) panel, this opens a brows-
er to allow the loading of calibration data

files.

File Basic Config- The ID of the NanoSPECT and # of heads  Ctrl-B
uration (typically 2 or 4) are set in this panel, pic-
tured below.

File Enable ColD- By default, the collimator depth phantom

epth is not used in the MMP Calibration analy-
sis. However, it may be enabled with this
checkbox.
File Exit Used to exit the MMP Calibration tool. Ctr1+Q

File Enable ColD- By default, the collimator depth phantom

epth is not used in the MMP Calibration analy-
sis. However, it may be enabled with this
checkbox.
Tools Merge In the presence of only one single-pinhole
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Function Keyboard

Shortcut

4-point files

Tools  Convert Calib
File

VivoQuant™ 2022 User Manual

aperture, 4-point data are collected one
head at a time. This tool merges those da-
tainto asingle file.

On some Nucline versions, a slightly mod-
ified version of the calibration data is
needed. This tool converts the calibration
file accordingly.
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Near-Field Uniformity

The Near-Field Flood Uniformity (NFF QC) is a quality control procedure for
monitoring the stability of the PMT gains for each head in the NanoSPECT/CT. To
collect NFF QC data, please run the QC SPECT Near-Field Flood (NFF) protocol in
the Configuration/QC Protocols panel of the Nucline software.

Getting There

To gget to the Near-Field Uniformity analysis panel, go to Advanced Modules >
NucMed > NanoSPECT.

File View Tools Advanced Modules Help

=SSWME NucMed ¢ NanoSPECT P 4\ Multi-Pinhole SPECT
Display e T 7 Spec. Act. Calculator NFF Uniformity QC
MR MR » SUV Calculator QuantiCalc
Bed remowal 4

BioDist Visualization Crosstalk removal
Multi-Atlas Segmentation Split Projections

3D Brain Atlas Tool EKG split

fMRI Tool Save Calibration.txt

Show user data
Split ROI to DICOM Sum projections

Install Atlas

Dosimetry Calc Append projections

Semi-Stationary Data Processing

NF Uniformity Calibration

Function

The Near-Field Uniformity tool analyzes NFF QC data for monitoring detector
uniformity. To begin the procedure, use the QC SPECT Near-Field Flood (NFF)
protocol to collect NFF QC data. Place ~0 . 5MBq of Tc-99min as small a volume as
possible in a PCR (Eppendorf) tube. Place this tube in the NFF phantom, a specially-
designed holder for the Minerve bed. Center the point source in the object space as
well as possible (using the images and countrates as a guide). Run the NFF Protocol,
rotate 90-degrees, and run the NFF Protocol a 2nd time. Now that data are
collected, they may be analyzed using the Near-Field Uniformity tool.

The initial NFF panel shows gray areas for each head and an array of buttons. To
load the data, press the Open button.
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| \@ Near Field Uniformity = 0O %
File
Settings Near Field Uniformity: Quality Control

Open

Calculate

(®) All Pre

Head1 Head?2
All Post

Results
Head 1 N/A
Head 2 N/A
Head 3 N/A
Head 4 N/A
Repaort
Head3 Head4

NFF Panel

The data for each head will appear in the appropriate box. To run the analysis, press
Calculate.
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@

Settings Near Field Uniformity: Quality Control
Open Near-Field Flood (NFF), PINH

(@ All Pre
O Al Post

PECT Near-Field Flood (NFF), PINH

Results

Head 1 N/A
Head 2 N/A
Head 3 N/A
Head 4 N/A

Report

Calculate

As the data are analyzed, the screen is grayed out. Progress can be monitored in
the Results panel shown on the left.

Once the data are analyzed, the (x,y,z) calculated source position will be displayed
in the lower-left corner of each Raw image. These images are indicated by the
appearance of the word Raw in the upper-right corner. Also, the raw images are
displayed when the All Pre push-button is selected. The red plus sign on each image
indicates the source position with respect to the detector.
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Settings Near Field Uniformity: Quality Control
Open
Calculate
(@ All Pre
O Al post

Results

Head1 of
tead2 o
Head 3 v
Headd o

Report

Results

Viewed the corrected images by clicking the All-Post button. Use Ctr1+T to toggle
between the two sets of images. The FOM for each data set is displayed in the
lower left corner. A green checkmark in the Results section indicates that the head
passed the calibration. A red FOM in the Results section means that the data are
guestionable and should be sent to a service engineer for further analysis. Finally,
to create a PDF containing the pre- and post-correction images, press Report.
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"]

Settings Near Field Uniformity: Quality Control
Open S C SPEC’ Fiekd Flood (NFF), PINH
Calculate

O Al pre
@ Al Post

Results

Head1 of
Head2  of
Head 3 0’
Heads o

Near-Field Flood (NFF), PINH ar-Field Flood (NFF), PINH

FOM Data
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Dosimetry Calc

Use the using VivoQuant’s Dosimetry Calc tool, in conjunction with the third party
application OLINDA (Organ Level INternal Dose Assessment), to estimate whole
body dosimetry data. The Dosimetry Calc tool calculates the cumulative activity
per unit activity administered (units in uCi-hr/uCi)whichis the required input to
the OLINDA application for dosimetry calculations.

The cumulative activity per unit activity administered is estimated using the
following area under the curve (AUC) method. The tool uses a curve fitting
algorithm which fits the experimental isotope’s exponential decay curve to the
percent injected dose per gram (% 1D/g) vs time curve of the experimental data.
The AUC is calculated using trapezoidal approximations for experimental
measurements, and the remaining AUC is calculated using the analytical solution to
the definite integral.

The datais thenstoredina . CSV file that can be copied into the OLINDA
application.

O Note: Before continuing ensure that a Remainder Body ROl has been created.
This is a required data point for the OLINDA application.

Getting There

To access the Dosimetry Calc tool, the 3D ROI Tool must be active. Go to the
Advanced Modules tab, then move down to Dosimetry Calc.
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File View Tools Advanced Modules Help
=SS M G M NucMed PO B L E 5
T CT 4

Display R R

R - update disablad

4 ’ a Bed removal

[
f/ Multi-Atlas Segmentation
f' ’ 3D Brain Atlas Tool

fMRI Tool
Install Atlas

, Split ROI to DICOM
Dosimetry Calc AUC Calculation

Export Quantification

Dosimetry Calculation Tools

Function

Getting Started

Start the tool by selecting Export Quantification.
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File View Tools Advanced Modules Operator Help

t— @ @ m l% MM NucMed L "E] 9 .
T CT v
Operator & x
MR MR L
L3 & @ Bed removal »
& v & O Multi-Atlas Segmentation  *
m . 3D Brain Atlas Tool
fMRI Tool
ROI
Install Atlas 2
W back d |
[ oackaround. 1 spiit ROI to DICOM
® Heart [ Dosimetry Calc k AUC Calculation
W Liver O 0O Export Quantification

— saa s —/ |

Export Quantification

Once the tool starts, a spreadsheet appears and requests you to fill in missing
information from the study. You can do this either in VivoQuant or in another
spreadsheet software.

™ Tip: It is likely easier to make changes in batch in a spreadsheet software.

\& Form ? X

Please fill in Patient ID, Group, and Time Point fields

Patient ID Group Time Point Injected Dose Organ Uptake Unit
1 STUDY1A283C Heart 188724 MBq
2 STUDY1A2B3C Liver 2.74427 MBq
3 STUDY1A2B3C Left Kidney 134748 MBq
4 STUDY1A2B3C Right Kidney 1.7184 MBq
5 STUDY1A2B3C Brain 1.09018 MEq
6 STUDY1A2B3C Remainder Body 21.8757 MBq
< >
;I'ime unit: h - .

Append to CSV| Start New CSV

Data Spreadsheet
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Column | Info

Group Group number. This allows for multiple groups to be used at once.

Time Time point of the study for each frame. The time units can be manipu-
Point lated using the drop down menu on the bottom left of the window or
manually in another spreadsheet software.

Injected Initial injected dose.
Dose

Once the spreadsheet is complete, save the information as an easily accessible
. CSVfile. In VivoQuant you may append an existing . CSV file or start a new one.

Using the AUC Calculation

Go to Advanced Modules, then select Dosimetry Calc > AUC Calculation.

Click Load Spreadsheet in the top left corner of the dialog box, and call the
spreadsheet you created in the last section. In the Dosimetry Isotope drop down
menu, select the isotope that was used in the experiment. If the isotope used is not
listed, open the file isotopes. txt located in the VivoQuant install directory
(default is C:\Program Files\inviCRO\VivoQuant) and add the isotope information.

Ensure that you select the correct isotope, because the Dosimetry Calc tool uses a

curve fit algorithm and extrapolates using only isotope-specific radioactive decay
information.
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\& Dialog ? X
Click OK to Compute and Save Area Under Curve for Each ROI
Save Spreadsheet Update Plot | 1:000 ]
Patient ID Group Time Point Unit Injected Dose ROl Up 800 1
600
400
200
( 2 0 E T T T T T T T T T T 1
Dosimetry Isotope: C-11 ~  Group To Plot: ¥ 0 200 400 600 800 1,000
G

Load Spreadsheet

Next, click Update Plot and enter the initial percent injected doses assumed for

each of the ROls.

\& Initial Percent ID

? X

What is the initial percent injected dose assumed to be for Heart?

f0.00000

g

OK

Update Plot

Cancel

The Plot should now appear next to the table in the window.
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m Heart ® Liver Left Kidney = Right Kidney = Brain

)
o
el
a
[
t
Q
o
(]
o
4
:
0 10 20 30 40 50
Time (h)
Decay Percent ID

Click OK and save as another . CSV file. This data is now ready to be used in the
OLINDA software.
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Debugging

At the time of installation, you may select the Debugging option. This option allows
the maintenance of a logfile that may be used to help troubleshoot problems that
occur while using VivoQuant.

Getting There

To enable debugging, go to the Enable Logfile option under the Help menu.

File View Tools Advanced Modules Help

=SS WME S 38m 3 = Request Help D
: ¥ Logout Ctrl+Shift+X
Display
\& Registration

B Enable Logfile
Debug View

Hints
Manual
el About

Debugging

Function

After selecting Enable Logfile, a dialog box appears, prompting you to restart
VivoQuant, and providing the location of anew vivoquant. log file
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\& Disabled Logfile X

o Thanks for disabling the logfile:
¥ (. /Users/luana/AppData/Local/Temp
\VivoQuant.log

Debug output is send to Windows debugger or
Console again.

OK

Enable Logfile

Upon the next restart of VivoQuant, this logfile will record all of the operations

performed. This record is useful to troubleshoot or debug problems that arise in
the software.
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Manual

A VivoQuant manual has been created to guide the user through all the post-
processing functions in a clear and step-by-step manner.

Getting There

To open the manual go to Manual under the Help menu.

File View Tools Advanced Modules Help

eSS M E O B8NS ([ *~' Request Help &
. X Logout Ctrl+Shift+X
Display
\&l Registration

F

Enable Logfile
Debug View

Hints
Manual
} About

VivoQuant User Manual

The keyboard shortcut F1 can also be used to open the manual.

Function

Users can browse through the different chapters of the Manual to read an in depth
explanation of all of the post-processing functions and instructions on their use.

The different sections covered in the manual are as follows:

¢ Installation
¢ File Management

e View
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e Post-Processing

e Tools

e Help

e Keyboard Shortcuts

8 vivoQuant Manual

— [m] X
File Edit View Go  Bookmarks Help
R ™ a i 7
¢ oAU VS A Qe
: Contents Index Bookmarks Search = f. - 2
= s x VivoQuant Configuration
~  VivoQuant Manual o The VivoQuant Configuration window has several panels, providing access to customizable features as
v Installation well as important registration and set-up information.
Installation Quick Guide
Installation Details Configuration Panels
> Configuration
v File Management The Configuration window consists of six panels, including:
Open DICOM data
Open/Replace Data » Display
Append Data * Data )
Open raw data : Q—ﬁgﬁ:fksmm 5
Save Dol + Reqistration
Session * VivoScript
» Operators
~ Viewing and Layout -
e Tinaga Getting There
Save Movie
Do The Configuration window is available in the Tools Menu on the PC. On the Mac, it is available in the
VivoQuant menu under Preferences.
> View Modes
> View Menu File View Tools Advanced Modules Operator He
> Tools
Vievanced Modues = £ £ View control F5 a
~ Plug-In Modules : E D
Whole Body Atlas Tool MIP control F6&
NM/CT Brain Atlas Segmentation Tool Operator
fMRI Brain Atlas Segmentation Tool pE @ Data Manager F7 v
Tumor Seamentation Tool ] |13 >
Manual Sections

The sections on the left can be viewed in detail by left-clicking on them. This will
open up sub sections which can be viewed on the right.
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About

Getting There

To open the About section go to About under the Help menu.

File View Tools Advanced Modules Help

=SS M G e 383M o8 (C = Request Help &)
: X Llogout Ctrl+Shift+X
Display g
Registration

Enable Logfile
Debug View

Hints

Manual
About

About VivoQuant

Function

The About feature provides information about VivoQuant. It informs the user
what version of VivoQuant is installed, and provides the contact information for
the creator of VivoQuant. It also displays who the VivoQuant program is
registered to.

It also supplies the web links to the DICOM toolkit and the Qwt project used to
help make this program.
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& About VivoQuant 2021 *

©Iinvicro

VivoQuant® 2021 [64bit] (Build vg-2021-0-9706450283)
Web page: httpy/f/www VivoQuant.com/

© 2002-2008 Christian Lackas, <lackas@spect-ct.com>

@ 2008-2021 Invicro, LLC <info@invicro.coms

This copy is registered to:

Demo Licenses

Imaging

"Luana Dos Santas” - "SW" <ldossantos@invicro.com:

1 license® can B¢ found 1
i usea the CFFE

DCMTE, © 15%4-2017, OFFIS e.V.
k of the wt preject.
15 : @ Insight Softwares Consortium.
! Schroedez, BiLll Lozenasn
sMagick Studis LLC
ompany Lod.
mOLRNTS

ins.
3-2010 Turku PET Centre

OK

About Info
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Help Reporter

VivoQuant’s Reporter Tool assists users in submitting service and applications
reports for review by the inviCRO service team. The tool offers a variety of pre-
defined report sequences as well as an option for a manual report. Reports are
bundled into . zip files and automatically submitted.

O Note: Only information visible in the Reporter window is uploaded when a
report is submitted. No personal, confidential, or otherwise hidden information is
collected.

How to use the VQ Reporter Tool

To get to the Help Reporter tool, go to Help > Request Help.

File View Tools Advanced Modules Help

sSaSMEoE BmEC Request Help &)
Log out Ctrl+Shift+X |
Registration

X

Display

Enable Logfile
Debug View

Hints

Manual
¢ About

Reporter Tool

Initializing the Help Reporter will save a copy of the session currently in-progress.

Most reports will first request a written description of the problem to be included
in a text file attached to the report.
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Components System Info
Add Files 0S Version |Windows 8 (AMD64, 8 proc, 64 bit) | Hostname ~ |DESKTOP-9MF7DV4 _
QT Version [5.6.3 | Paddr.  $7ee:12b1%18, 169.254.18.177, ::1
Add DICOM \ . .
App Version_lild2 {va-2020natch1-9-n1h3alcR1b) User  lluana
Add Comment Sation. | \& Text Input Dialog ? X
Add Screenshot Please describe your issue.
Content
01-Sy4
> 02-Ses
03-Reg
Concel | |
Controls
3 ! 2 :
O!Dﬂﬁlg[& Your name | Your mail address | Save Send
Reporter Input Dialog

For all reports, it is possible to add additional files and images using the four Add
buttons arrayed across the left-hand side of the tool.

The Add Files button opens a window that can be used to manually select files.
Multiple files may be selected simultaneously for inclusion in the report.

The Add DICOM button opens the Data browser where files may be selected. To
load into the Reporter, either press the Open button or right-click and choose Load
into Reporter.

The Add Comment button opens the Text Dialog Input window, which may be used
to add additional written comments to the report.

The Add Screenshot button opens a screenshot acquisition dialogue. The dialogue

has a capture delay to allow files to be opened or procedures begun prior to
acquisition of the screenshot.
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Components System Info
Add Files 0S Version |Windows 8 (AMD64, 8 proc, 64 bit) | Hostname ~|[DESKTOP-OMF7DV4
QT Version '5.6.3 | 1P addr. 37ee:12b1%18, 169.254.18.177, ::1
Add DICOM : 5

App Ve \@ Screenshot
Add Comment 2
Station

Preview
A h -
dd Screenshot Conter] -

01

0z

0z
Options Description
Delay [ss =
[] Hide this window Capture

Control
@!Dm\ﬂ&r& Your name Your mail address | Save Send
Add Screenshot

In addition to the manual Add button options, the pre-defined report options will
automatically gather certain files and add them to the report. Users can review
some low-level items in the Content section by double-clicking on them.

VivoQuant™ 2022 User Manual Page 424


http://127.0.0.1:4012/vqmanual/images/help_reporter_addscreenshot.jpg
http://127.0.0.1:4012/vqmanual/images/help_reporter_addscreenshot.jpg

Help Reporter Last updated: March 08, 2023

File Help
Components System Info
Add Files 0S Version |Windows 8 (AMD64, 8 proc, 64 bit) | Hostname ~ [DESKTOP-9MF7DV4

— QT Version [5.6.3 IPaddr.  }7ee:12b1%18, 169.254.18.177, ::1/
i App Version l.l_ile (vq-2020patch1-9-g1b3a8c81b)| User [Iuan_a

BOCOTNSNY | | cption [ukn | Report Type :

Add Screenshot et
¥ (2-Session ~

C:/Users/luana/AppData/Local/Temp\session-RequestdHelp.zipacs
v 03-Registry Dump
C:/Users/luana/AppData/Local/Temp\rt-20210928-111053.345.reg
C:/Users/luana/AppData/Local/Temp\rt-20210928-111053.346.reg
C:/Users/luana/AppData/Local/Temp'\rt-20210928-111053.347 reg
C:/Users/luana/AppData/Local/Temp\rt-20210928-111053.362.reg
C:/Users/luana/AppData/Local/Temp\rt-20210928-111053.363.reg
C:/Users/luana/AppData/Local/Temp\rt-20210928-111053.364.reg
C:/Users/luana/AppData/Local/Temp\rt-20210928-111053.365.reg

Controls

O I : :
O!DNY._!SJ_Q Your name Your mail address Save Send

Content Panel

Itis also possible to rename entries in the Content section by double-clicking on
the top-level element.
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File Help
Compaonents System Info

Add Files OS Version |Windows 8 (AMD64, 8 proc, 64 bit) | Hostname | DESKTOP-OMF7DV4

QT Version |5.6.3 1P addr. 37ee:12b1%18, 169.254.18.177, ::1|

App Version ild2 (vq-2020patch1-9-91b3a8cB1b)| User \luana

Add Comment |  comon  [UkN | Report Type

A
dd Screenshot Contait

v (02-Session )
C:/Users/luana/AppData/Local/Temp\session-RequestdHelp.zipacs

v
C:/Users/luana/AppData/Local/Temp\rt-20210928-111053.345.reg
C:/Users/luana/AppData/Local/Temp\rt-20210928-111053.346.reg
C:/Users/luanafAppData/Local/Temp\rt-20210928-111053.347.reg
C:/Users/luana/AppData/Local/Temp\rt-20210928-111053.362.reg
C:/Users/luanafAppData/Local/Temp\rt-20210928-111053.363.reg
C:/Users/luana/AppData/Local/Temp\rt-20210928-111053.364.reg
C:/Users/luana/AppData/Local/Temp\rt-20210928-111053.365.reg

Controls
@ln\flcro Your name f Your mail address ] Save Send

& Ko hca Minedta Company

Rename Content

Once all of the necessary files, screenshots, comments, and images have been
loaded into the report, click on Send to zip the file and submit it for review by
inviCRO. Click on Save to save a copy of the report for internal use.

In the event of any difficulties in sending the file from within the Reporter, please
save the zip file to a local machine and then email support@invicro.com with a link
to your report.

A Important: A contact email must be included to Save or Send the report.

Contraols

Your name |Test User Your mail address [l_estuser@companv,com Save Send

Add Name and Email
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Overview

The iPACS Sync application is designed for batch, two-way data transfers between
the WebDisk of a specific iPACS project and a local storage location. Directories
and files are synchronized between the source and destination locations, and data
transfers are authorized by an iPACS user’s account permissions.

Batch Transfer Data to and from the iPACS

Browse the following links to learn more about using iPACS Sync to batch transfer
data.

e Download latest iPACS Sync Application

e Configure a Sync Job (page 428)

e RunaSyncJob (page 440)

e Sync Specific Files from an iPACS (page 441)
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Configure a Sync Job

Create a Sync Job using the Wizard

To create a new job, click Create New Job at the top of the iPACS Sync application
window. This will launch the iPACS Sync Job Wizard, which will guide you through
the process of setting up a Sync job.

Job: [test v|| BRun ||X Create New Job

Open Sync Job Wizard

1. Specify the iPACS URL or IP address in the iPACS Address field. Previously
used addresses are available by clicking the arrow at the right of the text
field.

2. Enter the username and password to use for the Sync. Data transfers
adhere to the roles associated with an iPACS user’s account.

3. After entering the required information, click Next.

VivoQuant™ 2022 User Manual Page 428


http://127.0.0.1:4012/vqmanual/images/ipacssync_configscreen_openwizard.jpg
http://127.0.0.1:4012/vqmanual/images/ipacssync_configscreen_openwizard.jpg

Configure a Sync Job Last updated: March 08, 2023

{3 iPACS Sync Job Wizard ]M

Configuration
This wizard will help you configure an iPacsSync job to a selected iPACS Server.
iPACS Address:  training.ipacs.invico.com ¥
User: testiser
Password: senns
Next > :l Cancel | Helo
L 4

4. The wizard will attempt to download and install the sync key file for the
specified iPACS. Alternatively, you can access the wizard via a web browser
on the home admin page. The admin page is only available to users with the
adminrole.

Once the Sync Key is installed, click Next.
Specify the direction of the Sync.

Provide the complete path to the local directory to use in the Sync.

© N o u

Select the project on the iPACS to use for the Sync.
e The @ button will retrieve a list of projects on the iPACS, which can
be selected by clicking the arrow to the right of the text field.

e The path of the iPACS project can also be manually entered in the
iPACS Project field.

9. The WebDisk folder for the selected project will automatically populate
into the WebDisk Folder field. You can select subfolders via the drop-down
menu to the right of the text field.

10. After entering the required information, click Next.
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rOEDAcssEJubmzarE =

=)

Sync Folders
Select the source and destination folders to keep in sync.

Sync Direction: | To PACS

Local Folder: C: Users User 1/Desktop /Mew folder
PACS Project: - petstudy 1

WebDisk Folder:  fwebdisk /projectsfinviaro_lab/petstudy 1]

| <Back || Next> || canced || Hep |
=4
11. Asummary page shows all the selected settings for the new Sync job.
12. Enter aname for the Sync job, then click Finish.
Page 430

VivoQuant™ 2022 User Manual


http://127.0.0.1:4012/vqmanual/images/ipacssync_configscreen_folders.jpg
http://127.0.0.1:4012/vqmanual/images/ipacssync_configscreen_folders.jpg

Configure a Sync Job Last updated: March 08, 2023

5|
O iPACS Sync Job Wizard |7 )

New Sync Job

Host: https: /[training.ipacs.invicro.com:443
User: testUser

Direction: To IPACS

I Local: C:Users/User 1/ Desktop/New folder |

| Remote: jwebdisk/projects finvicro_lab/petstudy1
: SSH Port: 22

| [# save job (name): New folder

L <da [ _Fnsh ][ coel |[ heb |

The Sync job is now created, and will be run immediately. Further settings can be
configured, as described in the following sections.

Configuring Additional Settings

The iPACS Sync Config window allows you to manually create new Sync jobs and
edit the configuration settings of existing jobs. To access the iPACS Sync Config

window, click on the wrench icon on the left side of the main window.
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$ iPACS Sync
File Jobs Help

l Logfile

O e —

2014-08-04 17:44:27 ipac
b 4 2014-08-04 17:44:34 Nur
2014-08-04 17:44: 34 Totz
2, 2014-08-04 17:44:34 ipac
2014-08-04 17:59:27 ipac
2 2014-08-04 17:59:33 Nur,

2014-08-04 17:59:33 Totz
1 2014-08-04 17:59:33 ipac

Configuring Additional Settings

Select the job to configure from the Open drop-down, or enter a name and click
Create to create a new Sync job.

Load/Create Jobs

Open: [ttsth 'j New: + Create

Create New Sync Job

iPACS Setup

Make a job active or inactive. Specify the iPACS URL or IP address in the Hostname
field. Data transfers adhere to the roles associated with an iPACS user’s account. If
the Username and Password information are not provided here, the application
will prompt for it before every data transfer iteration. Click the Configuration
button to automatically obtain the sync key file from the iPACS if necessary.
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Watdch Job
[¥] Active  Job name | New foldes

| PACS | Folders | Schedue | Messagng | Advanced |

T
Hostname https ¥ | training.ipacs.invicro.com

Username testiser Password seens

l %\ Configuration Loaded. Click to reload.

iPACS Setup

Directory Setup

Specify the direction of the Sync. Provide the complete path to the local directory

to use in the Sync. Select the project on the iPACS to use for the Sync; the Iﬁl
button will retrieve a list of projects on the iPACS, which can be selected by clicking
the arrow to the right of the text field. The WebDisk folder for the selected project
will automatically be entered into the WebDisk field. Subfolders can be selected by
clicking the arrow to the right of the text field.
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Watch Job
[V] Active  Job name New folder
s | v | s | s | A
Sync Direction |To PACS v
Local
Folder: C:/Users/User 1/Desktop/New folder -
PACS
Project G O<
WebDisk: fwebdisk fprojects finvicro_lab fpetstudy 1 -
[7] Delete local files after transfer Delete after 14 days $
Rename Delete ] [ e Save
Directory Setup
Setting Description
Delete lo- Files that were successfully transferred to the server are deleted

cal filesaf-  locally. This feature is potentially dangerous and could lead to loss
ter transfer of dataif not used properly.

Delete af- Schedule when files are removed from source location.
ter

Scheduler

Create a schedule for when a Sync job will run.
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Watch Job

(S ] -1 | -

[V] Active  Job name | new foldes
| PACS | Folders | Schedue
[7] Autosync changes (takes precedence over schedule)
ElsMon [ Tue [ wed |
Running every 1 '+ week(s)staringon 6/26/2012 <
[¥] Only during scheduled scan interval

*

| Messagng | Advanced

mu ElAi [ sat [ sun

Scheduler

Setting

Scan interval

Autosync changes

Only during sched-
uled scaninterval

VivoQuant™ 2022 User Manual

Description

Specify how often a Sync job runs while the application
is open.

A Sync job will automatically start whenever a new
folder is added to the top level folder.

A Sync job will automatically start at the time specified
on the days selected.
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Notifications

Watch Job
| Active  Job name |

ey

| PACS | Folders | schedule | Messagng | Advanced |

Off () Alljobs © Faded jobs only | Test
SMTP Server Port 465 o 550
Username testilser Password esses
From
Redpients (comma separated)

suppor t@inviaro. com

Notifications
Setting Description
Message Turn on Message Notifications and specify what type of mes-

Notifications sages are sent.

SMTP Serv-  Contact your IT department for the server address. Normally
er can be found in the settings tab of your Email Client.

Port Contact your IT department for the server address. Normally
can be found in the settings tab of your Email Client.

Username Username used associate with your email account.
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Password Authorization to access your email account.

From Email account from which the notification will be sent.

Recipients Notifications will be sent to the provided email addresses.
Advanced

Include or exclude files by specifying their extension. (e.g. * .dcm *.img * . hdr

* . txt *.pnq).Filter is applied recursively through the subfolders of the top-level
folder. The user can also provide files containing which file names, file extensions,
and/or folders to include or exclude. Example text files would include the following:

Include:

+ 2009*/+ *.csv

Exclude:

E'S

In this example, all folders beginning with 2009 and all . csvV files within those
folders would be included in the transfer. All other files would be excluded.
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Filters:

| Verbose (V] Compression Charset S
Sync deleted files | Keep newer files [ cvs Exdude
¥ Always Prompt for download destination (global setting)
55H Port 22 + HTTP(S) Port 443 v

(1ncde_v) (=-dm =g =t ~o1

Indude Fie: -
Excude Fie: -
Renome | [ Delete | | &b save |
Exclude
Setting Description
Verbose Print more detailed log messages.

Compression

Filename charset

Sync deleted files

Keep newer files

CVS Exclude

VivoQuant™ 2022 User Manual

Data is compressed before sending.

Specify as US-ASCII, ISO-8859-1, UTF-8 or disable this
feature.

Remove remote files that are no longer available locally.
This feature is potential dangerous and could lead to
loss of data if not used properly.

Modified files at destination end will not be overwrit-
ten.

Ignore all version control hidden files (. svn folder)
when restoring files via iPACS sync.
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Always Prompt for Prompt user to specify download destination for each
download destina- file downloaded via iPACS sync from the iPACS.
tion (global setting)

Store Job

Click Save at the bottom of the window to save any changes to the Sync
configuration. Click Cancel to discard all changes since the last time the
configuration was saved.

Delsts & save

Store Job

VivoQuant™ 2022 User Manual Page 439


http://127.0.0.1:4012/vqmanual/images/ipacssync_configscreen_storejob.jpg
http://127.0.0.1:4012/vqmanual/images/ipacssync_configscreen_storejob.jpg

Syncing data to iPACS Last updated: March 08, 2023

Syncing data to iPACS

The following sections describe how to run an iPACS Sync job:

Run a Sync Job

Sync jobs are created/modified in the configuration window. To run a job, select the
appropriate job and click Run.

(O ipacs sync e (2 E
File Jobs Help
4 Logfile

Job: [test *][ BRun | [-X createNewob

2014-08-04 17:44: 34 ipacssync(p-264): Done -
x 2014-08-13 12:07:38 Reloading.. .
2014-08-13 12:07:38 Reading configuration from registry
.\ 2014-08-13 12:07:38 Found 9 job entries. Starting normal operation now. 3
2014-08-13 12:07:44 ipacssync(test2:to iPACS): Start -
? Sync Status:
Starting...

sending incremental file kst
Sample_Data_Set.zip

Fle: | s
Tota: | ) ss%

| —

RunaJob

Icon Descriptions

Icon Description

m Pause a Sync Job
Run all active Sync Jobs

's:

@ Stop aSync Job
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Open the configuration page
p g pag

@ Open the help guide

Quick Sync

This feature is a simple way to quickly download all files from a WebDisk folder, or
it can facilitate the transfer of large amounts of data from the iPACS to a local
location.

To download all files and folders in a WebDisk folder, follow these steps:

Navigate to the desired WebDisk folder on the iPACS.

Click iPACS Sync URL under Other Links on the right side of the page.
Copy the URL to the clipboard.

In the iPACS Sync client, go to Jobs -> Quick Sync, then paste the URL.
Select a folder where the iPACS files will be saved.

S A R

The iPACS Sync client will run a job to transfer all files and folders from that
WebDisk folder to the specified location.

Other links

dit header/f

L
il

Public links

JPACS Sync URL

—

rigger Indexing

Quick Sync

To download selected files from iPACS, follow these steps:
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1. Select the desired files from the Browser or WebDisk, then right-click one
of them and select iPACS Sync.

2. Abrowser.irsync file will be downloaded.

3. IntheiPACS Sync client, openthe browser.irsync file by going to Jobs
-> Quick Sync File, then selecting the file.

4. Select afolder where the iPACS files will be saved.

5. TheiPACS Sync client will run a job to transfer the selected files to the
specified lo cation.

Project » iPACS » Testing_ WC »ipacssync (/testing_wc/ipacssync)
[Reload] [WebDisk] mode [non recursive]

Study Date Study Desg
demoDatal 2010-03-24 0850 DemoStudy
2010-03-24 12:50 DemoStudy |

2010-03-26 09.40 DemaoStudy

e .S'IDOwﬁload selected

none
Topo+CT+5PE
Topo+CT+5SPE
Topo+CT+5SP

Download from iPACS
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Hardware Requirements

The following table outlines the minimum and recommended hardware
requirements needed to install VivoQuant in your computer:

I [

Operating System  64-bit Windows
10.9 Mac OS

Linux Redhat, CentOS 6/7

RAM 8to12GB 12+ GB
Processor Any modern processor

GPU OpenGL 2.0+ OpenGL 3.0
CPU Dual core

VivoQuant™ 2022 User Manual
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Corrupted Data

Data files used in VivoQuant, such as VQ sessions, images and movies, might
become corrupted after being processed. For example, a VQ session zipacs file
might get corrupted during the unzipping process. On these occasions, we
recommend clearing the cache before attempting to open the corrupted file again.

VivoQuant Cache Files

VivoQuant cache stores data files such as images or VQ sessions that are
frequently accessed or were used recently in a local repository to improve load
time.

If you are using Windows OS, you can find the VivoQuant cache at the following
location:

C:\Users\<username>\AppData\Roaming\inviCRO\VivoQuant\cache

e Cache files can also be quickly accessed by typing the following path in
Windows navigation bar:

%sappdata%s/inviCR0O/VivoQuant/cache
In MAC, the caches files are located here:
~/Library/VivoQuant
If you are using Linux, you can find the VivoQuant cache here:

~/.VivoQuant

Clear VivoQuant Cache

To clear the cache, you can navigate to the above location and manually delete the
stored data.

Alternatively, you can clear the cache directly on VivoQuant by navigating to Tools

- Configuration —» DICOM, and hitting the Clear button in the DICOM Cache
section.
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Corrupted Data
@ Configuration ? 4
Display ~ Data  DICOM  Network  VivoScript  Registration
DICOM Settings
DB path: [D:H.Dioomuﬂnimm'l.lmageﬁleﬁ ] [ o '
Repositories: Testing x|
—; s
| | 1 |
CURE IRt RN
Dictignary =
Rev Port 23104 {4 [] load palette % [_] DICOMDIR
Folder Filter [ | overrideFOR? Mo </
DICOM Cache Captures
Enable Viewer
Current size | 0.0 MB | 0%
Default Repository
Maxsize 1000 MB 2| [free 972188 M8 | | -
== Default Format
Life Time |14 d i Clear -
z
oK || Cancel |

Clear VivoQuant Cache
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Memory Allocation Error

While loading, coregistering, or cropping images, you might receive a Memory
Allocation error message followed by a VivoQuant crash. This error may occur
when manipulating large datasets.

-ee03

Tvne: NM -
wme: kim*brasckma

ie: 2019-11-26 15:3

: 001 [ MLEM
Memory allocation error. ViveQuant will be :c mm':mmuga {

0 closed.
|

oK

Memory Allocation Error

Troubleshooting the Memory Allocation Error

Follow these steps to avoid memory allocation errors:

1. Disable the MIP viewer to lower resource consumption.

2. Downsample your data via the Preprocessing (page 298) tool

3. Crop your data to remove unnecessary empty space around the subject and
decrease the data size.

4. Loadinthe NM image prior to the CT, so that the CT downsamples to the
same voxel size as the NM.

5. Work on a computer that meets or exceeds the hardware

recommendations (page 443).
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Disabled MIP

Disabled MIP

Last updated: March 08, 2023

If you can’t see the MIP view or 3D rendering of your data, make sure that MIP
Viewer is enabled the in your VivoQuant instance. To do this, navigate to Tools —
Configuration — Data, and uncheck the Disable MIP viewer check box.

| \& Configuration

Display Data  DICOM
Data Loading
[ ] Disable MIP viewer

Ask Disable MIP

s )

Quantification Options
Unit of Activity MBq

Data Manager
Confirm moving
Apply default shift

Grow reference to input volume no r
Max voxsize ratio for vol

MinVoxSize [ﬂ;ﬂﬂ'mﬁ-u : Anchor input data at center v

v SV Separator Comma (,) et

[] show seconds in Browser
[] collapse Dynamic Data

? X

VivoScript  Registration

2.50 ;

Config DataList Info
Processing
[] K Max Threads & s [] vIK Max Threads & =
[] 17K Priority 1
OK Cancel
Enable MIP Viewer

Further Troubleshooting

If, after enabling the MIP Viewer via VivoQuant’s configuration, it still doesn’t
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appear, or if the Disable MIP viewer checkbox is greyed out, try the following
possible solutions:

Install OpenGL

OpenGL 2.0 is the minimum requirement for MIP to work, but 3.0+ is preferred.
Make sure one of these versions is installed on your computer. For more
information on minimum hardware requirements for VivoQuant, see Hardware
Recommendations (page 443).

Check for Planar Data

A MIP cannot be generated with planar data. Note that, even if your data is not
planar, VivoQuant might interpret it as such if the Max Voxsize Ratio is less than
that of your image. You can increase the ratio by navigating to Tools =
Configuration — Data, and increasing the number for the field Max voxsize ratio
for vol.
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& Configuration ? X

Display Data DICOM Metwork VivoScript Reqgistration
Data Loading

[ ] pisable MIP viewer Grow reference to input volume |no hd

Ask Disable MIP Max voxsize ratio for vol 12.00 =

MinWoxSize Anchor input data at center -

Quantification Options

Unit of Activity MBq - | CSV Separator Comma (,) w

Data Manager

Confirm moving [ ] show seconds in Browser

Apply default shift [ ] collapse Dynamic Data
Config DataList Info

Processing

[ ] ITK Max Threads 8 + [] vTK Max Threads 8

(] 1 Priority

1k

oK Cancel

Change Max Voxsize Ratio

Check Internal Settings

If a previous run of VQ failed to set up the MIP, a setting might be preventing
further attempts to create it. To reset this setting, follow the below steps:

e On Windows: Open the Registry Editor and navigate to: Computer\
HKEY CURRENT USER\Software\inviCRO\VivoQuant\MIP.Check
that the QVTKWidgetCreationFailissetto false.
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Disabled MIP

| B Registry Editor
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= m} X
| File Edit View Favorites Help
Computer\HKEY_CURRENT_USER\SOFTWARE\inviCRO\VivoQuant\MIP
Bioscan || Name Type Data
> Il Chromium a8 REG SZ (value not set)
> (I_asses i elTolerance REG_DWORD 0x00000398 (920)
> i Clients #4) convertDelay REG_DWORD 0x00000050 (30)
2B COrEl ablcr-0 REG_SZ Palette
4 o ‘b:iﬁ-‘l REG_SZ Palette
> Elantech o =
N —— et-2 REG_SZ Palette
5> 1 Intel ab|HeadBodyTolerance REG_SZ 175
w inviCRO Eﬁ"'HeadModelTolerance REG_DWORD 000000078 (120)
> DICOMRepositories vo NrANG REG_DWORD 0x0000003¢ (60)
v | VivoQuant 33|playWaitTime REG_DWORD 0x00000028 (40)
21CFRpart11 35 QVTKWidgetCreationFail REG_SZ false
AnnotationTable ablsyncMode REG_SZ false
Cache ab)ytkAutoUpdateRendering REG_SZ true
Capture aB)vtkGradientEnabled REG_SZ true
] gfct:m #tRenderMode REG_DWORD 0x00000002 (2)
hasAcceptedLicense ablyvtkRenderSpeed REG_SZ Fine
MIP
Network N
( > £ )_

Windows Registry Editor

If you need to set the correct key value, right-click the key, select Modify
and type Talse in the Value data field. You will need to restart VivoQuant
for the change to take effect.

Set Key Value

Registry Editor - m} x
gistry
File Edit View Favorites Help
Computer\HKEY_CURRENT_USER\SOFTWARE\inviCRO\VivoQuantyMIP
Bioscan || Name Type Data
> Chromium ¥)(Default) REG_SZ (value not set)
? ':‘_“‘9’ 4| BodyModelTolerance REG_DWORD 0x00000398 (920)
; Ehenlts 34 convertDelay REG_DWORD 0x00000050 (80)
: c:;u'n aW)et-0 REG_SZ Palette
b ct-
3 B Eisniech ab)er-1 REG_SZ Palette
> 1 Google ab)et-2 REG_SZ Palette
s B Intel ¥ HeadBodyTolerance REG_SZ 175
v | iniCRO | HeadModelTolerance REG_DWORD 0x00000078 (120)
> DICOMRepositories Ang REG_DWORD 0%0000003c (60)
~ VivoQuant layWaitTime REG_DWORD 0x00000028 (40)
21CFRpart11 REG_SZ false
AnnotationTable ab|syncMo Mmﬂfy_ G_S7 false
Eafhe abjytkAuto  Modify Binary Data... G_S] Edit String %
apture 9
Data \:,:!\fthrad 50 2 Value name:
> 1 DIcoM HAVURENd  Rename S0 raviwiager ail |
hasAcceptedLicense 2E|viRenderspeed REG.S4
MiP Value data:
Network .t lhlse l
< > <

¢ On Mac: open the Terminal and run the following command: defaults
write com.invicro.VivoQuant
"MIP.QVTKWidgetCreationFail" 0
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For further support, please contact support@invicro.com.
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Image Distortion and Mirroring

When loading data into VivoQuant, you might notice that the images appear
upside-down or squished in the Display.

Mirroring

Left/Right Mirroring

VivoQuant allows you to choose between two Left/Right orientation options:
Neurologist (LR) and Radiologist (RL).

Radiologist Mode (RL) Neurologist Mode (LR)

To select an orientation mode, navigate to Tools = Configuration — Display, and
use the Orientation drop-down menu to choose the desire orientation option.
Head/Feet Mirroring

If you notice that your images appear upside down, you can change the Head/Feet
orientation by following these steps:

1. Navigate to the Reorientation/Registration operator.
2. Select all the images in your dataset.

3. Check the Head/Feet checkbox.

4. Click the checkmark ™= button to apply your changes.
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Change Head/Feet Orientation

Distortion

If you notice that your images appear distorted, they might be loading as planar
images. If the voxel size ratio for a non-planar image is greater than your configured
maximum ratio, VivoQuant forces the image to load as a planar image. Increasing
this maximum value will prevent this distortion.

To do this, navigate to Tools - Configuration — Data, and increase the number for
the Max voxsize ratio for vol field.
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